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Welcome to the
Apple Support Training Library

The Apple Support Training Library is an example of Apple's commitment to
helping you provide better support to users of Apple® products. The
Library's modules allow for both quick reference and customized training.
The modules contained in this binder are part of three series: Macintosh,
Apple 11, and Peripherals.

Training. Because the library's modules are self-paced, individuals can
learn and practice by themselves. Or the modules can be combined with other
modules as a course. If given as a course, the self-paced modules allow
students to progress at their own pace, freeing the instructor to answer
questions and help students with problems. Each module lists any
prerequisites and equipment required.

Reference Catalog. To facilitate your search for information on Apple
products, we developed the Support Training Reference Catalog, available on
AppleLink™. The catalog references manuals, publications, courses, and
training modules that provide information and instruction on a wide range of
computer skills. For each skill listed, the catalog identifies training resources
and tells how to sign up for the training, how to acquire the materials, and
what the prerequisites are.

Update Subscription. This binder contains the modules which have been
released to date for this series. Along with this binder you receive a
subscription to all additional modules produced for the series this year.
(Modules are released quarterly.) At the end of the year, you will receive a
renewal letter that you can use to order a subscription for the modules to be
released the following year.

Change of Address. If you change your address, please notify your local
Apple Support Center.



Recommendations when using this Library:

* Read the modules thoroughly.

Contact your Apple support representative if you have any questions or need additional
information not covered in the modules.

*  Back up your files as you follow the practice exercises to avoid losing important data.

Copyright

©1986 Apple Computer, Inc. All rights reserved.
Apple -Computer, Inc.

20525 Mariani Avenue

Cupertino, CA 95014

~ Apple grants to its authorized dealers and other authorized customers the right to reproduce and

distribute this material for use in training classes provided that there is no additional fee charged for
the material distributed in such classes, and that it is distributed only to bona fide participants of
such classes.

Apple does not endorse any of the third-party products mentioned in this module. They are
included only to make you aware of their availability.

Apple, the Apple logo, and the Macintosh logo are registered trademarks of Apple Computer, Inc.
AppleLink is a trademark of Apple Computer, Inc. Macintosh is a trademark of McIntosh
Laboratory, Inc. and is being used with express permission of its owner.

These modules were produced using the Apple LaserWriter printer.
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B Table of Contents

Section 1 Macintosh Product Overview

Learn to identify the hardware components of the Macintosh, how to set
up the system, and what accessory products are available.

2 Learning to Use Macintosh

Learn to use Macintosh, including basic Macintosh techniques

such as using the mouse and menus, and how to work with documents,
folders, and disks.

3 Supporting the Macintosh Finder

Learn to use and support the features of the Finder. Use the Finder
utilities in different versions of the Finder to support Macintosh users.

4 Supporting the Font/DA Mover

The Font/DA Mover is a utility that helps you move fonts and desk
accessories. You use it to add room to a crowded disk, or to add fonts
or desk accessories that allow you to be more productive. A section on
the original Font Mover is included.

5 Managing Macintosh Files

Macintosh uses a flat file structure with 400K disk drives and the
Macintosh XL. Learn how to support this structure using folders and
disks to organize your files, documents, and applications. Learn how

to support the Document Directory dialog box (also called the "Standard
File") by using it and the Save As command.

6 Fundamentals of the Macintosh Operating System

Learn how to explain some of the features and functions of the
operating system and user interface. Learn how to respond to
Macintosh users who have trouble starting up Macintosh, or who
have lost a file or a document.

7 Using MacDraw

Learn to use MacDraw by completing the Guided Tour of
MacDraw and specially designed practice exercises.
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Supporting MacDraw
Information that will help you support MacDraw users, including
technical specifications and answers to commonly asked questions
about using MacDraw.

Supporting MacProject
Information that will help you support MacProject users, including
hints on how to create, display, and work with project schedules,
answers to commonly asked questions, and troubleshooting techniques.

Supporting MacWrite
Information that will help you support MacWrite users, including
integration with other applications such as graphics programs, useful
techniques, answers to commonly asked questions, and technical
specifications.

Using MacTerminal
Learn to use MacTerminal, including configuring it to
communicate with other computers, transferring files, integration with
other applications, and practice exercises for connecting to another
Macintosh, an Apple II, and a public information service.

Using MacTerminal with IBM Computers
How to use MacTerminal to communicate with IBM computers,
including a description of the products involved, and the appropriate
MacTerminal settings for each, practice using the AppleLine, and
answers to commonly asked questions.

Supporting MacTerminal
Information that will help you support MacTerminal users, including
answers to commonly asked questions, technical specifications, and
pinouts.
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Apple Support Training Library

There are three binder series in the Apple Support Training Library: Macintosh,
Apple 11, and Peripherals. Here is a listing of the modules currently available for

each series.

Macintosh, Vol. I & 11
(Part No. 072-0186)

Macintosh Product Overview
Learn to identify the hardware components of the
Macintosh, how to set up the system, and what
accessory products are available.

Learning to Use Macintosh
Learn how to use Macintosh, including basic
Macintosh techniques such as using the mouse and
menus, and how to work with documents, folders,
and disks.

Supporting the Macintosh Finder
Learn to use and support the features of the Finder.
Use the Finder utilities in different versions of the
Finder to support Macintosh users.

Supporting the Font/DA Mover
The Font/IDA Mover is a utility that helps you move
fonts and desk accessories. You use it to add room
to a crowded disk, or to add fonts or desk
accessories that allow you to be more productive.
A section on the original Font Mover is included.

Managing Macintosh Files
Macintosh uses a flat file structure with 400K disk
drives and the Macintosh XL. Learn how to support
this structure using folders and disks to organize
your files, documents, and applications. Learn how
to support the Document Directory dialog box (also
called the "Standard File") by using it and the Save
As command.

Fundamentals of the Macintosh
Operating System
Learn how to explain some of the features and
Sunctions of the operating system and user interface.
Learn how to respond to Macintosh users who have
trouble starting up Macintosh, or who have lost a
file or a document.

Using MacDraw
Learn to use MacDraw by completing the Guided
Tour of MacDraw and specially designed practice
exercises.

Supporting MacDraw
Information that will help you support MacDraw
users, including technical specifications and answers
to commonly asked questions about using MacDraw.

Supporting MacProject
Information that will help you support MacProject
users including hints on how to create, display, and
work with project schedules, answers to commonly
asked questions, and troubleshooting techniques.

Supporting MacWrite
Information that will help you support MacWrite
users, including integration with other applications
such as graphics programs, useful techniques,
answers to commonly asked questions, and technical
specifications.

Using MacTerminal

Learn how to use MacTerminal, including
configuring it to communicate with other
computers, transferring files, integration with other
applications, and practice exercises for connecting
to another Macintosh, an Apple 1I, and a public
information service.

Using MacTerminal with IBM
Computers
How to use MacTerminal to communicate with IBM
computers, including a description of the products
involved, and the appropriate MacTerminal settings
for each, practice using the AppleLine, and answers
to commonly asked questions.

Supporting MacTerminal
Information that will help you support MacTerminal
users, including answers to commonly asked
questions, technical specifications, and pinouts.

Supporting the Macintosh Switcher
Information that will help you support Switcher
users, including installing and configuring several
applications in a Switcher set to establish a desired
set of integrated software.

The Inside Story

Learn the basic computer components and the flow
of information through a computer.

Using the Macintosh XL Migration Kit

Follow the step-by-step procedures to convert all of
your Lisa 7/7 documents into Macintosh documents.
Learn how to prepare your Lisa 717 documents,
install the migration software, and perform the Lisa
and Macintosh portions of the migration.
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Macintosh, Vol. I & 1I
(continued)

Using the Finder 5.3 Menus

Learn to use the various features of the latest
versions of the Finder and System. This module is
an update to Supporting t intosh Finder
located in Macintosh Volume I of the Apple Support
Training Library. This module explains the new
features and changes in the existing ones.

Using the Installers

Learn how to update your Startup disk using the
latest version of the System Installer disk. The
module discusses the System Installer and the
dragging method of updating, and explains how and
when to use both. You will also learn to use the
Printer Installation disk to update your printer
drivers.

Apple II, Vol. I
(Part No. 072-0187)

Apple II Product Overview, Rev 1
Learn about the capabilities of the Apple 1IGS,
Apple lle, and Apple Ilc, including information on
enhancements and upgrades. Also learn about the
various Apple Memory Expansion Cards.

The Inside Story

Learn the basic computer components and the flow
of information through a computer.

Apple II System Ultilities
Learn to use the Apple Il System Utilities disk to
perform basic operations, including its use with the
Apple Il Memory Expansion Card.

Supporting ProDOS and DOS

Compare ProDOS with DOS, and learn the basics
needed to support programmers, including where to
go for more information.

Using Subdirectories with AppleWorks

Learn about setting up subdirectories and using
pathnames to identify and manage files.

Color Printing with AppleWorks

Learn how to print color documents on the
ImageWriter 11 using all three AppleWorks
applications.

Access II Basics

Learn why you'd use Access II, how to set up a
system—both hardware and software—for Access II,
and how to log on to an information service.
Practice solving typical problems with Access II.

Access II: Recording and Receiving
Files
Learn how to save to disk information that you
receive from an electronic service. Learn the
difference between recording and receiving, and
how to solve related customer problems.

Access II: Overview of Transmitting
Files
Learn the general principles for transmitting files
by using an Apple Il (with Access II) to send a file
to another Apple Il user (who has Access II).

Access II: Preparing Files for
Transmission

Before transmitting a file, you must know
which type of file to send. Here, using quick
reference guides, you learn how to determine
this. You'll also learn to answer questions
regarding different file types such as DIF,
ASCII, and formatted text files.

Using the Apple IIGS Control Panel

Learn how to use the Control Panel when setting up
your Apple IIGS system to provide peripherals
information and set personal preferences.

October 1986
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Peripherals, Vol. 1
(Part No. 072-0188)

ImageWriter II Basics

Learn how to set up the ImageWriter Il and the
SheetFeeder, including how to set dip switches, how
to run the printer self-test, and how to test the
connection. Also learn the basic software settings
for Macintosh applications and AppleWorks.

Using the LaserWriter, Rev 1

Learn how to set up an AppleTalk network and use
it to print a document on the LaserWriter; how to
install LaserWriter software; and how to
troubleshoot an AppleTalk network and the
LaserWriter. Also learn about the added benefits of
the LaserWriter Plus.

Data Communications Terms

A brief introduction to terms that will help you
support Apple data communications products. A
glossary of terms is provided.

Interfaces and Cabling

Introduces you to RS-232 communications. This
module includes pin information, and brief exercises
that help you speak knowledgeably with data
communications professionals.

Introduction to Supporting Desktop
Communications

Learn the process of qualifying desktop
communications customers and configuring
solutions for them. Learn concepts and terms that
are common to most desktop communications
solutions.

Supporting Desktop Communications

Learn how to qualify a customer for a specific
desktop communications solution. Learn concepts
and terms that are unique to information systems
and electronic mail, local area networks, and large
system communications.

Apple II Peripherals Overview

Learn about the various Apple Il monitors, disk
drives, printers, modems, and accessories.
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Macintosh Product Overview

B Contents
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Overview

Objectives, Materials

Hardware Overview and Setup

A look at the hardware components of Macintosh and how to set
up the system.

Accessory Products

Details all of the Apple Macintosh accessories, as vell as various
products available from third-party vendors for the Macintosh.
Review

Resources



2 Overview

Il Overview

This module identifies all the hardware features of the
Macintosh™ computer and explains how to set up the system.
Then there is a brief description of the accessory products
available from Apple for the Macintosh and the key third-party
accessory products.

This is only an overview of the products available for the
Macintosh, not an in-depth analysis or description of each. If
you want to know more about specific products that are
mentioned, particularly Apple™ products, read additional
modules from the Apple Support Training Library or ask your
Apple support representative for the manual for you to review.

If you aren't familiar with some of the terms used in this
module ("byte,” "baud," "128K," "modem," and so forth), or
if you want to know more about how a computer works, read
The Inside Story module.

This module is designed for first-time Macintosh users.

Prerequisites

There are no prerequisites for this module.

APPLE SUPPORT TRAINING LIBRARY



Obijectives 3

( Il Objectives

 Identify the following Macintosh hardware components:
accessory connectors, brightness control, clock battery
compartment, On/Off switch, security kit connector, and
sound jack.

« Set up the Macintosh, including connecting the mouse,
keyboard, and power cord.

* Identify the accessory products currently available from
Apple for the Macintosh, as well as certain key third-party
products.

B Materials

To complete this module, you will need:

S * A Macintosh, keyboard, mouse, and power cord
(All components should be disconnected, as if they were
just taken out of the box.)

» Apple Presents the Personal Computer: The Macintosh

videotape (available as part of the ASC Training Kit:
Macintosh Products—p/n 076-8114-A)

MACINTOSH PRODUCT OVERVIEW



4 Hardware Overview and Setup

B Hardware Overview and Setup

Overview

Watch the Videotape

Examine the Front
of the Macintosh

This section identifies all of the Macintosh
hardware components.

You'll begin this section by watching a videotape that
introduces the Macintosh. Then you'll learn about all of the
system's hardware features.

It's called Apple Presents the Personal
Computer: The Macintosh.

The video will introduce the Macintosh, some of the accessory
products you can use with it, and some basic concepts for its
use. Continue with this module when you have finished
viewing the video.

Here are the components you can see on the
front of the Macintosh.

As you read about each feature, be sure you can find it on your
Macintosh. The features are the same for the Macintosh 128K
and Macintosh 512K. The only difference between the two
systems is the amount of memory.

APPLE SUPPORT TRAINING LIBRARY
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screen
LQ il disk drive
J
brightness__|
control A CH
I
serial keyboard
number connector

* Screen. The screen is a 9-inch video display, similar to a
television set. This is where you will see everything you
are working on.

» Disk Drive. The disk drive is just below the screen, on the
right side. It handles disks that can store as much as 400K
(a"K" is equivalent to 1,024 characters) of information.

The tiny, round hole to the right of the disk-drive slot
enables you to eject a disk that can't be ejected in any other
way. You simply insert a straightened paper clip into the
hole and push.

Warning: This method should only be used as a last resort.
If used inappropriately, it may cause the loss of information.

» Keyboard connector. The keyboard attaches to the
connector below the disk drive. Notice that it uses the same
type of connector as your phone.

Warning: While the keyboard plug and a phone plug may
look the same, they are quite different. If you insert a phone
cord into the keyboard connector of your Macintosh, you could
cause serious damage.

¢ Serial Number. The serial number is under the screen, on
the left side. (You'll have to tip the Macintosh back to see
it.) It's important for warranty repairs and theft control.

+ Brightness Control. The brightness control is under the
screen, on the left side—next to the serial number.

MACINTOSH PRODUCT OVERVIEW



6 Hardware Overview and Setup

Examine the Back
of the Macintosh

These are the components that are on the
back of the Macintosh.

» On/Off Switch. Face the front of the Macintosh, and run
your left hand along its left side. Toward the back, you'll
find a smooth spot in the texture of the plastic. Just around
the corner, on the back of the Macintosh, is the On/Off
switch.

Now turn the Macintosh around so its back faces you, and find
each of the components as they are described.

Vents — — handle
Product
Neme ~ | clock baltery
FCClabel door
abDel ~—J
B+ OnlOff switch
securitykit_|
connector 'I B—Ppowerplug
mouse Bom oo on _
connector =222 @ _® *—j—soundjack

S N
extemal disk printer modem
drive connector  pott port

e Power Plug. The power cord connects to the socket just
below the On/Off switch.

¢ Clock Battery Door. The Macintosh clock runs on
battery power when the Macintosh is turned off. The
battery will last about two years. As the battery is wearing
out, the clock will lose time. When this happens, remove
the clock battery door and replace the battery. Use a
4.5-volt battery (Eveready No. 523, or equivalent, which is
available on the Apple price list, p/n 742-0003).

» Accessory Connectors. The connectors along the
bottom of the back of the Macintosh are labeled with an
"icon," or symbolic representation, of the device that can be
attached to each. From left to right, there is the mouse
connector, external disk drive connector, the Printer port,
and the Modem port.

The Printer and Modem ports are RS-422 serial ports to

which you can connect a variety of Apple and third-party
products.

APPLE SUPPORT TRAINING LIBRARY
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Hardware Overview and Setup 7

* Sound Jack. If you want to work (or play) without
disturbing others around you, connect an earphone to this
jack. You can also use it to connect to an amplifier.

* Security Kit Connectors. A Macintosh security kit
attaches to the back of the Macintosh case (just above the
mouse connector) and to the keyboard (on the edge that
faces the Macintosh). Once installed, the two security kit
connectors are locked in place. A cable wrapped around an
immovable object and through the eyelets in the connectors
will lock the Macintosh into place.

+ Programmer's Switch. A programmer's switch {or
interrupt/reset switch) is included for people who want to
write their own applications programs. You'll find the
switch in the plastic accessory kit that was in the top of
your Macintosh box. To install the switch, snap it into place
at the bottom of the left side, toward the back of the
Macintosh.

Interrupt Switch .
Reset Switch

The back part is an interrupt switch, which is useful to
developers. The front part is a reset switch. If you want to
start up from a different disk, pressing the reset button is like
turning your Macintosh off and then on again. But care should
be taken with the Programmer’s Switch because using it in the
wrong way could cause you to lose information.

Avoid blocking the vents, or the Macintosh may
overheat.

Macintosh doesn't have an internal fan. The vents around its
sides and on its top allow air to flow through the cabinet,
keeping the components cool. If you block the vents, the
Macintosh may overheat.

MACINTOSH PRODUCT OVERVIEW



8 Hardware Overview and Setup

Set Up the Macintosh

What to Do Next

Attach the mouse, keyboard, and power cord.

You don't need any tools to set up your Macintosh.

To begin, connect the mouse to the mouse connector on the
back of the Macintosh. The icons above the ports tell you what
to connect where. The icon above the mouse connector is
shown at the left. The connector only fits on one way so it's
impossible to attach it wrong. Use the thumbscrews to hold
the connector in place.

Connect the keyboard to the Macintosh, just below the disk
drive. The connector only fits in one way.

Make sure the system is turned off, and then connect the
power cord to the Macintosh and plug it into a 110-volt,
three-hole plug. Don't use an adapter, or your Macintosh will
not be properly grounded.

Continue when you have connected the mouse, keyboard, and
power cord to your Macintosh.

After completing this module, learn how to use
the Macintosh and available software.

- After you read the remainder of this module to learn about the

accessory products available for Macintosh, you'll probably
want to learn how to use the system.

Complete the Learning to Use Macintosh module to learn basic
Macintosh techniques, such as how to use the mouse and
menus, and how to work with text. Then you'll be ready to
begin one of the various applications training modules.

APPLE SUPPORT TRAINING LIBRARY



(

Accessory Products 9

B Accessory Products

Overview

Find Technical Detail
Eisewhere

Printers

ImageWriter Il Printer

This section describes the accessory products
available from Apple for the Macintosh.

Key third-party accessory products are also mentioned. In
addition, new products are constantly being introduced, both
by Apple and by third-party developers. Check Macintosh
publications such as Macworld, the Macintosh Buyer’s Guide,
Macintosh Connection, or A+, and AppleLink™ for ongoing
information about new products.

(Note: AppleLink is a product developed by Apple to provide
information and electronic mail capabilities to its Sales
organization and dealers. If you don't have access to
AppleLink, ask your Apple support representative for
information referenced in this module that can be found there.)

Check AppleLink or other references for
technical information.

This section doesn't go into technical detail on the products
mentioned. If you want more information, check AppleLink or
one of the references listed at the end of this module.

There are several printers you can use with
Macintosh.

This section includes a basic description of the various printers
available for the Macintosh. If you want more information
about the different printer technologies described and the
trade-offs involved, read The Inside Story module from the
Apple Support Training Library.

The ImageWriter Il is the printer most often
purchased with a Macintosh.

The ImageWriter™ II is a serial, dot matrix printer that can
print high-resolution graphics and text. It was introduced in
September 1985 to replace the original ImageWriter, which had
been the most popular printer for use with Macintosh. The
ImageWriter II is faster than the original ImageWriter, and can
also print in color—with the right software. It's good for
correspondence text and graphics, but the resolution is not high

MACINTOSH PRODUCT OVERVIEW



10 Accessory Products

LaserWriter Printer

Letter-Quality Printers

enough for business correspondence that requires typewriter
quality.

Check the ImageWriter Il switches.

Every printer has switches that must be set correctly in order
for it to function properly. The ImageWriter II switches are
inside the printer, on the left side, toward the front. On the
original ImageWriter, the switches are located inside the
printer, on the right, under the track that the print head moves
on. Refer to the printer's user's manual for the appropriate
switch settings for use with Macintosh and other computers.

Connect the ImageWriter cable.

To connect the ImageWriter or the ImageWriter II to your
Macintosh, plug the cable (which is included in the accessory
kit) into the printer and into the Macintosh connector marked
with a picture of a printer, like the one shown at the left. The
cables can only be connected one way. Secure the connection
with the thumbscrews.

The LaserWriter printer produces
near-typeset-quality output.

The LaserWriter™ printer is at the top of Apple's printer line.
It's a high-speed, high-resolution laser printer that can produce
graphics and text output of such high quality that it looks
typeset. For increased cost-effectiveness, the LaserWriter can
be shared by as many as 31 Macintosh users over the
AppleTalk™ Personal Network—Apple's networking solution
for small workgroups. (More information about AppleTalk
appears later in this module. You can also refer to the Using
the LaserWriter module from the Apple Support Training
Library for more information on AppleTalk and the
LaserWriter.)

Software is available that enables you to use a
letter-quality printer with Macintosh.

Use a letter-quality printer (also known as a daisy wheel printer
or impact printer) if you need typewriter-quality documents.
However, such printers aren't good for printing graphics.

The Mac Daisywheel Connection is a program that provides

letter-quality printer support for MacWrite™. It's not a driver,
(special code needed to use a printer with any application), but

APPLE SUPPORT TRAINING LIBRARY



External Disk Drive

Apple Hard Disk

Modems

Accessory Products 11

an application that prints MacWrite documents. The program
supports character sizes of 10, 12, and 15 point, as well as
proportional print wheels and various font styles. It also
supports many different printers, including the Apple Daisy
Wheel Printer. The Mac Daisywheel Connection is available
from Assimilation, Inc. (AppleLink has additional
information.)

An external disk drive is available.

Apple manufactures an external disk drive that's identical to the
buiii-in drive. This drive can handie disks that store 400K of
information.

Connect the disk drive to the external disk-drive port on the
back of the Macintosh. This port is identified by a picture of a
disk drive, as shown at the left. Secure the connection with the
thumbscrews.

Warning: Place the external disk drive on the right side of the
Macintosh to avoid potential ventilation and shielding
problems.

Hard disks provide greater storage capacity
and faster access time.

The Hard Disk 20 is Apple's 20-megabyte hard disk for the
Macintosh. It attaches to the external disk-drive port and is
designed to sit under the Macintosh, so it's out of the way and
aesthetically pleasing. The Hard Disk 20 also allows you to
daisy chain another hard disk, a floppy-disk drive, or a backup
device such as a tape drive. (See the Third-Party Accessories
section of this module for a list of hard disks available from
third-party developers.)

Apple makes two modems.

A modem is a hardware device that enables you to
communicate with another computer through a telephone line.
The Apple Personal Modem (shown at left) and the Apple
Modem 300 both work with the Macintosh. The Modem 300
operates at 300 baud (which is a measure of how fast
information is transmitted), and the Personal Modem operates
at 300 or 1200 baud. (Note: The Apple Personal Modem is
functionally identical to the Hayes Smart Modem 1200.)

.MACINTOSH PRODUCT OVERVIEW



12

Accessory Products

A higher baud rate means information can be sent more quickly
between computers. (See the Data Communications Terms
module from the Apple Support Training Library for additional
information about the data communications vocabulary used in
the previous paragraph. See the Using MacTerminal module
for more information about modems and their use with
Macintosh.)

Connect the modem to Macintosh and to a
phone line.

The modem accessory kit contains the cables, user's manual,
and other documentation.

Both Apple modems have two connectors for phone cables (as
shown below on the Apple Modem 300). Connect the phone
line to one port and your telephone to the other. When the
modem is not in use, you can use the phone normally.

Power Cable\
Connector
\\

7 1

Telephone Cable _l : On-Off

Jacks Connector ~ Switches Switch
Apple Modem 300

Connect one end of the serial cable that's provided in the
accessory kit to the modem's cable connector and the other end
to the modem socket on the back panel of the Macintosh, which
is identified by the icon shown at the left. There is only one
way to attach the cable. Secure the connection with the
thumbscrews.

Check the owner's manual for the correct switch settings (the
switch settings shown above are correct for use with
Macintosh). Then connect the power cord, and you're ready to

go.

There are no switches on the Personal Modem, and you plug it
right into a power socket, so there isn't a power cord either.
Just connect it to the phone line and to your Macintosh and its
ready for use.

APPLE SUPPORT TRAINING LIBRARY
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Other Macintosh
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Accessory Products 13

There are several accessories available to
everyone connected to the AppleTalk network.

] - . mp

OF— &

AppleTalk is Apple's local interconnect system. It was
designed to be easy to install, easy to use, and very
inexpensive compared to other networking solutions.

Macintoshes, LaserWriter printers, and third-party file servers
can all be part of an AppleTalk network. Via AppleTalk, you
can store and retrieve information using a file server, print your
documents on the LaserWriter or other shared printers, and
transfer documents to other workstations.

Read the Using the LaserWriter module from the Apple
Support Training Library, the LaserWriter owner's manual, or
the AppleTalk Personal Network Installation Guide for more
information about AppleTalk and the LaserWriter printer.

Use the numeric keypad if you enter a lot of
numbers.

The numeric keypad is an optional addition to your Macintosh
that enables you to enter numbers more quickly than using the
numbers across the top of the standard keyboard. It also

MACINTOSH PRODUCT OVERVIEW



14 Accessory Products

Third-Party Accessories

Disks

includes several keys for special functions. (You can enter
numbers and invoke all of the special functions using the
standard Macintosh keyboard, but the numeric keypad lets you
do both faster.)

To connect the keypad:

Unplug the keyboard cable from the keyboard.
Insert it into the socket on the keypad marked with a
picture representing the Macintosh.

Plug the cable that comes with the keypad into the
remaining socket on the keypad.

Plug the other end of that cable into the socket on the
keyboard.

> »w b=

When you finish, the numeric keypad and keyboard should be
connected to your Macintosh as shown below.

— 00N00NNO00000c]
HE85 0000000000000
HBE o [ [ [ ] [ [ o o o [ [
ESH[] ] [ ] o [
] s | e— [ [ ]
The Security Kit.

If your Macintosh is used in a public place, you can secure the
main unit and the keyboard using the security kit. See the
Macintosh owner's manual for instructions on its use.

The following is a partial list of accessory
products available from third-party developers.

Check AppleLink and Macintosh publications for other
products available for the Macintosh.
HyperDrive by General Computer Company.

HyperDrive is a 10-megabyte hard disk that fits inside the
Macintosh cabinet. It's convenient because it doesn't occupy
any additional desktop space.

APPLE SUPPORT TRAINING LIBRARY
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Bernoulii Box by IOMEGA.

The Bernoulli Box is a 5-megabyte removable hard-disk
cartridge.

OmniDrive by Corvus.

OmniDrive is a line of hard disks that can be shared among
several Macintosh computers connected via AppleTalk. Each
user can have private storage space on disks which range in
size from 5 to 126 megabytes.

QC10 and QC20 by Quark.

The QC10 and QC20 are 10- and 20-megabyte hard disks,
respectively, that connect to the Macintosh external disk drive
port. They can also be used with an Apple IL.

Digitizers and Graphic ThunderScan by Thunderware.
Enhancers

This is an optical reader that attaches to the ImageWriter.
ThunderScan will create a MacPaint™ document from any
drawing or photograph you feed through your ImageWriter.
It's very accurate, but not very fast.

MacVision by Koala.

MacVision enables you to connect a video camera to Macintosh
and create MacPaint documents from drawings, photographs,
or live video images. It's quite fast but not as accurate as
ThunderScan.

MacTablet by Summagraphics.

MacTablet is a drawing tablet that replaces the mouse as a
graphics input device. It's very good for detailed drawing or
tracing.

Other Products Hayes has a 2400-baud modem available.

MacCharlie will make your Macintosh
compatible with an IBM PC.

MacCharlie consists of a disk drive and a keyboard extender
that enable you to run MS-DOS software on your Macintosh.

MACINTOSH PRODUCT OVERVIEW
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B Review

Hardware Overview

Hardware Setup

Accessory Products

The hardware components of a Macintosh are:

Screen

Brightness control
Keyboard connector
Disk drive

Security kit connector
Mouse connector
External disk drive, printer, and modem ports
Sound jack

Power plug

On/Off switch

Clock battery

® & o o © ¢ o o o o o

If you're not sure where each of these components are, refer to
the diagrams earlier in this module.

To set up your Macintosh, connect the mouse,
keyboard, and power cord.

A large variety of accessory products are
available for the Macintosh.

Apple manufactures the following products that can be used
with the Macintosh:

ImageWriter II printer
LaserWriter printer

Daisy Wheel Printer

External disk drive

20-megabyte hard disk

Modem 300 and Personal Modem
Numeric Keypad

Security Kit

There are also many accessory products available from

third-party developers including other disk drives, digitizers,
modems, and optical scanners.
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Bl Resources

* Macintosh, the owner's manual

» AppleLink (If you have access to AppleLink, use it to find
information about all of Apple's products.)

« Accessory product owner's manual (For more information
about any of the Apple accessory products mentioned in this
module, refer to that product's owner's manual.)

» Macintosh periodicals (For more information about
third-party accessory products, check Macintosh
publications such as Macworld, The Macintosh Buyer's
Guide, MACazine, and A+. They will have articles,
reviews, or ads that will tell you who to contact for more
information.)

» Using the LaserWriter module from the Apple Support
Training Library (Read this module for more information
about the AppleTalk Personal Network and the LaserWriter
printer, and for a comprehensive list of additional
materials.)

Apple does not endorse any of the third-party products mentioned in this module. They are included only to make you
aware of their availability.

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. AppleLink, AppleTalk, ImageWriter,
LaserWriter, MacPaint, and MacWrite are trademarks of Apple Computer, Inc. Macintosh is a trademark of Mclntosh
Laboratory, Inc. and is being used with express permission of its owner. Bernoulli Box is a trademark of lomega
Corporation. HyperDrive is a trademark of General Computer Company. IBM is a registered trademark of International
Business Machines Corporation. MacCharlie is a trademark of Dayna Communications. Mac Daisywheel Connection is a
trademark of Assimilation, Inc. MacTablet is a trademark of Summagraphics Corporation. MacVision is a trademark of
Koala Technologies Corporation. OmniDrive is a trademark of Corvus Systems, Inc. QC10 and QC20 are trademarks of
Quark Peripherals, Inc. Smart Modem 1200 is a trademark of Hayes Microcomputer Products, Inc. ThunderScan is a
trademark of Thunderware, Inc.
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2 Overview

B Overview

The Macintosh™ computer is designed to be easy to learn and
easy to use. The mouse and graphics-based interface enable
even the most inexperienced person to do useful work in just a
few hours. Macintosh even comes with its own self-paced
training program called the Guided Tour of Macintosh.

In this module, you will go through the Guided Tour, which

“teaches you the basic techniques for using Macintosh. After

each session of the Guided Tour, you are given an opportunity
to practice what you have learned.

Even with a computer as easy to use as a Macintosh, there are
specific techniques you should learn. After going through the
Guided Tour, you will learn how to work with disks,
documents, and folders on the Macintosh, including how to
copy and move documents and folders, and how to back up
disks.

These are basic techniques that everyone needs to know before
learning how to use specific applications software. Investing a
few hours now will save you many frustrating hours later.

This module is designed for anyone who is using a Macintosh
for the first time.

Prerequisites

You should already be familiar with the Macintosh hardware
and how to set it up. If you can't identify the key hardware
components of the Macintosh (disk drive, mouse, keyboard,
On/Off switch, and accessory ports), complete the Macintosh
Product Overview module from the Apple Support Training
Library.

APPLE SUPPORT TRAINING LIBRARY
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Il Objectives

* Learn the basic techniques for using Macintosh, which

* Move and copy documents and folders.

» Save your work on disks.

» Use the Trash to throw away documents and folders.

* Properly care for disks.

* Initialize, back up, repair, and erase disks.

» State the contents of, and create, a startup disk.

include how to use the mouse, windows, menus, and icons.

B Materials

To complete this module, you will need:

[ 2

Macintosh 128K or Macintosh 512K
Guided Tour of Macintosh disk and cassette
Audiocassette player

Macintosh system disk

MacWrite™ disk

Blank disk

Macintosh, the owner's manual

If available, the following is recommended:

L ]

External disk drive

LEARNING TO USE MACINTOSH
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Il How to Use This Module

Follow the Instructions

Complete the Guided Tour, read the review,
then practice the techniques.

The first part of this module has you complete the Guided Tour
of Macintosh and then practice what you have learned. During
a Guided Tour session, you'll listen to a tape describing what's
happening on your screen. But you won't actually do
anything. After each session of the Guided Tour, there's a
review of the techniques that were introduced (so don't feel
you have to take notes on what you see during the Guided
Tour). Read the review, but don't try to practice the techniques
yet. Following each review, there is a practice exercise that
will help you practice the skills you saw in the Guided Tour
and read about in the review.

In this module, it's very important to read everything and to
follow instructions. You'll have plenty of time to practice, so
don't jump the gun and practice during the reviews.

If you want to complete this section more quickly, you can
complete the entire Guided Tour without stopping. However,
you will learn—and retain more—about using Macintosh by
reading each of the reviews in this module and practicing each
of the techniques taught.

The other two main sections of the module are Documents and

- Folders, and Disks. In these two sections there is a description

of the various techniques you will use when working with
these items, followed by clearly identified practice exercises.
Read the descriptions, and then complete the practice exercises.

Refer back to the reviews or descriptions
during the practice exercises.

If, as you are going through a practice exercise, you forget
how to do something, refer back to the description or review
given earlier in the module.

After you complete this module, you can always refer back to
its descriptions and reviews for quick reminders about specific
techniques.

If, at any time, you would like a reminder of the definitions of

basic Macintosh terms, check the glossary in Appendix B of
Macintosh, the owner's manual.

APPLE SUPPORT TRAINING LIBRARY
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B Guided Tour of Macintosh

Overview

Use materials included with your Macintosh to
learn the basic techniques.

The Guided Tour of Macintosh disk and cassette, and the
Macintosh owner's manual, which are packaged with your
Macintosh, provide an excellent starting point for learning how
to use the system. In completing this module, you will use the
Guided Tour disk and cassette, and then read key parts of the
manual.

After each Guided Tour session, there's a review of the
techniques covered in that session. Read the review but don't
try the techniques yet. After each review, there's an exercise
that will enable you to practice what you saw in the Guided
Tour.

There are five Guided Tour sessions. To complete this section,
do the following:

1. Read the module section titled Mousing Around (up to Athc
Guided Tour heading).

2. Complete the mouse exercises (which are called Mousing
Around).

3. Complete the Guided Tour of Macintosh. Follow
the instructions in this module (under the Guided Tour
heading) to complete the first Guided Tour session, "Show
me my Electronic Desk!"

4. Read the review of the Guided Tour in this
module. Read the review of the session starting with the
Review of the Guided Tour heading.

5. Practice what you saw in the Guided Tour.
Do each step as it's described, beginning at the Practice
heading that follows the review.

6. Repeat Steps 3, 4, and 5 for the other four Guided Tour
sessions.

LEARNING TO USE MACINTOSH
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Mousing Around

Complete the mouse exercises on the Guided
Tour disk to learn how to use the mouse.

The first part of the Guided Tour is an exercise called Mousing
Around. It's a series of exercises designed to teach you how to
use the mouse.

To start the mouse exercises, do the following:

1. Insert the Guided Tour disk, metal end first with the label
facing up, into the built-in disk drive. Push the disk all the
way in, until it clicks into place.

2. Turn on the Macintosh. The On/Off switch is on the back,
above where the power cord connects.

The first time a Guided Tour of Macintosh disk is used, it will
automatically start with Mousing Around. Subsequently, when
you start up the Guided Tour disk, it will present the Guided
Tour screen, which is shown below.

~Guided Tour of Macintosh

Listen, Experiment, and Enjoy Learning

Show me my Electronic Desk! MOUSING AROUND
What's the Finder?

Why Do I Have Windows? Let Me Use my Macintosh!
What Else is in the Menus? |
Time to Play the Maze! | I'm Ready to Stop!

If you see this screen before you complete Mousing Around,

roll the mouse on the table top to position the arrow on the
screen on top of the words Mousing Around. Then press
and release the mouse button to begin the mouse exercises.

Do the mouse exercises now. Continue when you have
finished.

APPLE SUPPORT TRAINING LIBRARY
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Guided Tour

Review of the Guided Tour

The Macintosh Desktop

Guided Tour of Macintosh 7

Complete the first Guided Tour session, "Show
Me My Electronic Desk!"

When you start the Guided Tour cassette, there will be a review
of some of the material you just read. If you have not yet
completed the mouse exercises (Mousing Around), follow the
instructions on the tape to do so.

As soon as you see the Guided Tour screen (shown on the
facing page) after completing the first session, stop the cassette
and read the Review of the Guided Tour below.

Start the Guided Tour of Macintosh cassette now. It will teil
you exactly what to do from here on. Continue with this
module when you have finished the first session of the Guided
Tour of Macintosh.

Read this review of the first Guided Tour
session, "Show Me My Electronic Desk!"

Stop the cassette, if you have not already done so.

Read the following review of what was covered in the Guided
Tour before trying any of the techniques taught. Following the
review, you will have an opportunity to practice what you have
learned.

The gray area on your screen is called the
desktop.

Your Macintosh desktop is like your own desk—it's the area
where you do your work, and it holds the objects and
information that you work with. On the desktop are various
icons, each of which can be opened so you can view the
information it contains.

Some of the icons, such as disks and file folders, contain other

icons. You can move icons anywhere on the desktop without
affecting the information they contain.

LEARNING TO USE MACINTOSH
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lcons

Menus

Each icon has a different function.

These are the most common icons you will see on your
Macintosh. You may not see all of these icons your screen at
one time, but at some point you will notice each of them.

gJ Disk — To store information.

[[[[ Trash — To throw documents away.

Application — To create new documents.

Document — Information you have already

entered.
Folder — To group several documents
together.
System Files — Information Macintosh
needs to function.

Menus contain all of the capabilities available
to you on the Macintosh.

Name of the
menu that's

currently open ' Menu titles ’
|

& QI Edit View Special

{ New Folder &N

Open

Print

{losa

T —

T

Menu command J

Menu command that's
not currently available

Page Setup
Print Latatoy
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Each word in the menu bar across the top of the screen
represents a different menu. Each menu contains several
options, or commands, that are available to you.

Some menu commands are black; others are
gray.

Menu comands that are in black type are currently available to
you. If a particular command or menu title is gray, it's
mappropnate for your current selection or for the environment
you're in.

For example, if a window is not open, all of the View menu
commands will be gray. They are inappropriate, because they
only affect how information is displayed in an open window.

There are four steps to choosing a menu
command.

To choose a command from a menu;

Point to the menu you want to open.
Hold down the mouse button. The menu name will
become highlighted and the menu will open.
While holding down the mouse button, point to the
command you want. It will become highlighted.

- Release the mouse button. The command you chose
will be implemented and the menu will disappear.

> Wb

"Select, then operate” is the normal pattern of
operation.

Use these two steps to perform most operations when using
Macintosh.

1. Select what you want to work with (for example, some text
or an icon).

2. Follow the four steps above to choose the appropriate
command from a menu.

For example, to open an icon, you would first select the icon,
and then, choose Open from the File menu.

If a menu command seems to have no effect, or is gray, you

probably didn't remember to begin by selecting what you
wanted to work with.

LEARNING TO USE MACINTOSH
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Selecting Information

Opening and Closing

Icons

h

This indicates what you want to work with.

To select an object means to indicate that you want to work
with it. (For example, if you want to open an icon, first select
it to indicate which icon you want to open.)

There are several ways to select what you want to work with.
To select an icon, point to it and click the mouse button once.
To select some text, hold down the mouse button and drag the
pointer through it.

Everything you select will become highlighted in some way (so
you can check to see that you selected it correctly, and as a
reminder of what's selected. Most objects will become inverse
images of themselves when selected (white dots turn black and
black dots, white).

Iconthat's not selected Selected Icon

Regular Text

Selected Text

Selecting an object doesn't actually change anything. It only
indicates what will be affected by the change you're about to
choose. So, if you make an incorrect selection, no harm is
done. Just start again, and select what you meant to select in
the first place. The most important thing to remember about
selecting is a point made earlier: Before you can work with
something, you must select it.

Open an icon to view its contents.

Open an icon any time you want to see the information it
represents. If the icon is a file folder, for example, the
documents stored in the file folder will be displayed. If the
icon is the Trash, the objects you recently threw away will be
displayed.

To open an icon, do the following:

1. Select the icon. It will become highlighted.
2. Choose Open from the File menu.

APPLE SUPPORT TRAINING LIBRARY
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The icon will open and its contents will be displayed in a
window. A window is a rectangle on your screen that has a
title at the top and displays some information. There are many
things you can do with windows, such as alter their size and
move them around on the screen, which will be discussed in
later Guided Tour sessions.

You can also open an icon by pointing to the icon and clicking
the mouse button twice in rapid succession (double-clicking).
If nothing seems to happen when you double-click on an icon,
try doing it faster.

Close a window when you're finished working with the
information in contains. You can have several windows open
at once, but your desktop will get cluttered if you don't close
unneeded windows.

To close a window, choose Close from the File menu. The
window will disappear as it returns to its icon form.

You can organize your work better by grouping
related icons.

If you have several icons that are related—perhaps a report, the
cover graphics, and the overhead transparencies you'll use
when presenting the report—you may want to have those icons
close to each other in the disk window, to remind you that they
go together. Or you may want to organize your work still
further, by moving the document icons into a file folder.

Here's how to move an icon on the screen:

Point to the icon you want to move.

Hold down the mouse button.

While holding down the mouse button, move the mouse.
The icon will move to the location of the pointer.

Release the mouse button when you get the icon where you
want it.

> b=

You can move several icons at the same time.

To move several icons, you must first select all of them. You
do this with a selection box. To draw a selection box:

1. Imagine a rectangle completely enclosing the icons you
want to select.

2. Point to one corner of that imaginary rectangle, but not to
any icon in particular.

LEARNING TO USE MACINTOSH
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T
L]

Guidec
8 items 319K in

Mousing Around  Notes

]

Example

K] —

3. Hold down the mouse button and move to the corner
diagonally opposite. The rectangle you imagined will be
drawn.

4. When the rectangle completely encloses all of the icons you
want to select, release the mouse button. Anything that's
either completely or partially in the rectangle will be
selected.

To move the group of icons, move any one of the selected
icons the same way you move a single icon. All of the other
icons that are selected will follow.

Another way to select several icons is to use the Shift-click
technique.

Select the first icon.

Hold down the Shift key.

Point to the next icon you want to select and click the
mouse button. Both icons will now be selected.

Continue Shift-clicking on icons until you have selected all
of the icons you want to move.

el S

This is a particularly useful technique if the icons you want to
select are interspersed with other icons.

Practice

Practice Guided Tour
Techniques

| Fite W

Open
Duplicate %D
Get Info %61
Put Back

Close
Close Al
Print

Eject %E

Practice what you saw in the first Guided Tour
session, "Show me my Electronic Desk."”

Do each step as it's described.

From the Guided tour screen, click Let Me Use my
Macintosh!

Open menus.

1. Point to the word File at the top of the screen. This is the
title of the File menu.
Press the mouse button and hold it down to open the
menu.

Don't choose anything from the menu.

Release the mouse button to close the File menu.

Open the other menus (point to the title and hold down the
mouse button) to see what's in each and to see which
commands are gray and which are black.

kWD
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Open and close icons.

1. Select the Guided Tour disk icon by pointing to it and
clicking the mouse button.

Choose Open from the File menu to open it.

Choose Close from the File menu to close it.

Select the Trash icon.
Choose Open from the File menu to open it.
. Choose Close from the File menu to close it.

oups WM

Move individual icons.

.

Open the Guided Tour disk icon.

Point to one of the icons in the Guided Tour window.
Hold down the mouse button.

Move the mouse to move the icon to a different part of the
window.

. Release the mouse button to deposit the icon in its new
location.

. Practice moving other individual icons.

.

.

Move a group of icons.

—
.

Imagine a rectangle completely surrounding all of the icons
in the Guided Tour window.

Point to one corner of the rectangle with the mouse, but
don't point to any icon in particular.

Hold the mouse button down.

Move the mouse to the diagonally opposite corner of the
rectangle. Be sure all of the icons are at least partially in
the rectangle.

Release the mouse button. All of the icons either partially
or completely within the rectangle will be selected.

Move one of the selected icons onto the gray part of your
screen, and all of the icons will follow (as shown below).

o » Rl ol

% File Edit Ujew Special Training
E==———— ouidédTour =———~
8 items 319K in disk 80K availabl

¢
3

— .
Mousing Around Il Notes

m System Folder
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Practice (cont'd)

7. While the icons are still selected, move all of them back
inside the Guided Tour window.

8. Click anywhere within the window, but not on an icon, to

deselect the icons. None of the icons will remain selected.

Return to the Guided Tour screen.

- Choose Quit from the Training menu.

Feedback

Practice Guided Tour
Techniques

If you had trouble, do one of the following:

. Replay the first session of the Guided Tour, "Show me my
Electronic Desk!"

» Read the appropriate section of Macintosh, the owner's
manual, which contains complete explanations of all of the
techniques taught in this module.

» Ask a colleague, your course manager, or your Apple
support representative for help.

Guided Tour of Macintosh (cont'd)

Guided Tour

Complete the second Guided Tour session,

"What's the Finder?"

You are now ready to learn the techniques taught in the second
session of the Guided Tour of Macintosh. Do the following:

1. Start the cassette again, and follow the instructions to
listen to the second Guided Tour session.

2. As soon as you see the Guided Tour screen, stop the
cassette.

3. Read the Review of the Guided Tour (on the next page).
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The Finder

Duplicate
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4. Use the Practice exercise in this module practice the
techniques you saw in the Guided Tour.

Continue with this module when you have finished the second
session of the Guided Tour.

Read this review of the second Guided Tour
session, "What's the Finder?"

Stop the cassette, if you haven't already done so.

Read the following review of what was covered in the Guided
Tour. Following the review you'll have an opportunity to
practice what you've learned.

The Finder is a program that helps you
organize other applications and documents.

The Finder and the desktop are functionally identical. The
Finder is the application that controls the desktop. Think of the
Finder as a home base. It helps you keep track of what you
have done and it's a starting point for running applications.

Three versions of the Finder have been released. The Guided
Tour of Macintosh uses Version 1.0. Version 1.1 is the
version that was released with the Macintosh applications. And
in May 1985, Version 4.1 of the Finder was released. The
differences between Version 1.1 and Version 4.1 are
mentioned throughout this module. (See the Supporting the
Macintosh Finder module from the Apple Support Training
Library for more information.)

You can find out which version you have by choosing About
the Finder from the Apple menu.

Create a duplicate if you want to keep more
than one version of a document.

If you want to keep the original version of a document, and the
revised version, first make a duplicate of the document. Make
your revisions to one copy, and keep the other unchanged.

You might also make duplicates of documents if you create
templates of documents or forms that you use often. Creating a
duplicate of a template is like tearing a sheet off of the top of a
stack of forms.
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Rename

File a Document
In a Folder

%
Executive Summar

................

...............

Opus Project

To duplicate a document (or any icon), do the
following:

1. Select the icon.
2. Choose Duplicate from the File menu. A new icon will
appear titled "Copy of <icon name>."

Rename your revised version so you won't
confuse it with the original.

If you're working with templates, rename the duplicate to
reflect the true contents of that particular document.

To rename a document (or any icon), do the
following:

1. Select the icon. The icon and its name will become
highlighted.

2. Typeanew name. Whatever you type will replace the
existing name.

Put several related documents into the same
file folder.

Just as you store related documents in the same file folder in
your filing cabinet, you can store related Macintosh documents
in the same file folder. This reduces the clutter in your
windows, making it easier to find the document you're looking
for.

To put a document into a folder, do the
following:

1. Point to the document to be moved.

2. Hold down the mouse button.

3. Move the mouse to move the icon so that it's on top of the
folder into which you want to put the documents. The
folder should become highlighted (as the Opus Project
folder is at the left).

4. Release the mouse button.

If the folder icon is not highlighted, the documents will not be

deposited into the folder. Be sure the folder icon is highlighted
before you release the mouse button.

APPLE SUPPORT TRAINING LIBRARY



Throw away a Document

E

Executive Summary

Retrieve a Document
From the Trash

0] Trash ===
1 item 4K in Trash

Document

<] [

D)

@[<@

Empty Trash

Special

Clean Up

Empty Trash

Erase Disk
Set Startup
Use MiniFinder...

Shut Down

Open the Information
Window

Guided Tour of Macintosh 17

To throw a document away, move it onto the
Trash icon.

To throw away a document, you use the technique you just
learned for putting a document into a folder—except that this
time you put the document icon onto the Trash icon. Again, be
sure the Trash icon is highlighted before you release the mouse
button. Highlighting is how Macintosh tells you that you're in
the correct place. Use this same technique to throw away
folders, or any other icon.

If you accidentally throw something away, you
can reach into the Trash and pul! it out.

How many times have you thrown something in the
wastebasket in your office, only to have to reach in and pull it
out again. You can do the exact same thing on Macintosh, at
least until the trash is emptied (just like in your office).

Open the Trash and move the document to
another location.

1. Open the Trash the same way you would open any icon
(select it and choose Open).

2. You'll get a window displaying its contents.

3. Move the document or folder you want to retrieve from the
Trash to the desired location—a disk, file folder, or the
desktop.

There are three ways to empty the trash.

» Choose Empty Trash from the Special menu.

¢ Start up an application.

 Eject the disk either by choosing Eject or by choosing
Shut Down (Version 4.1 only).

If the Empty Trash command is gray and will not highlight

when you try to choose it, it means the Trash is already empty
(in which case, the command is irrelevant).

Use the Information window to determine the
latest revision of a document.

If you have several versions of the same document, and you
aren't sure which is the latest, open the Information window
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Working with Text

for each document. Check the Modified date to see which one
is the most recently modified, and therefore the latest revision.

Information about any icon on the desktop.

To display the Information window for any icon on the
desktop, do the following:

1. Select the icon.
2. Choose Get Info from the File menu. You'll get a
screen similar to the one shown below.

[}

[[J====—== Information about System Disk =——

System Disk g]

Kind: disk
Size: 393216 bytes used for 11 files
Where: internal drive

Created: [Wednesday, May 2, 1984 at 8:04 AM
Modified: Wednesday, March 7, 1985 at 3:20 PM

[ Locked

The flashing vertical line is the insertion point.

It indicates where anything you type will be added. To move
the insertion point, do the following:

1. Use the mouse to position the pointer where you want the

insertion point to be.
2. Click the mouse button.

Click the mouse button to
move the insertion point here

JiNotice the current location of the insertion
point and where it's about to be moved .|

Current location
of insertion point

Most of the time you can't make the insertion point go away.
You can only move it.
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Select text before you work with it.
To select text:

1. Position the pointer at one end of the word, phrase, or
passage you want to select.

2. Hold the mouse button down.

3. Move the pointer to the other end of what you want to
select.

4. Release the mouse button.

Everything between where you pressed the mouse button and
where you released it will be selected. It doesn't matter if vou
start at the beginning or the end of the text you want to select.

Moving Text Use Cut and Paste to move text.

To move text using the cut-and-paste technique:

Select the text you want to move.

Choose Cut from the Edit menu.

Use the mouse to place the text insertion point where you
want to add the text.

Choose Paste to insert the text you previously cut.

> b=

The technique for cutting, or copying, and then pasting
information is the same in all Macintosh applications,
regardless of what is being moved.

Close Box Click in the close box to close a window.

pamN . .

(ED=S=—==opus Pr The close box is the small box in the top left corner of an open
~loms 12K in fo window (as shown at the left).

Click in the close box to close an open window. This is
exactly the same as choosing Close from the File menu.
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Practice

Practice Guided Tour
Techniques

Copy of example

Practice what you saw in the second Guided

“Tour session, "What's the Finder?"

Do each step as it's described.

Click Let Me Use my Macintosh! from the Guided Tour
screen.

Duplicate a document.

1. Select the Example document.

2. Choose Duplicate from the File menu.

3. Move the duplicate to an open area in the window. The
duplicate will be called "Copy of Example."

Rename the document.

1. Select the "Copy of Example" document. The document
and its name will become highlighted.

2. Type a new name, such as New Example. Whatever
you type will replace the existing name.

File the document in a folder.

1. If you're using Finder 1.1, make a duplicate of the empty
folder. If you're using Finder 4.1, choose New Folder
from the File menu. ‘
Rename it (perhaps, New Folder).
Point to the New Example document you made earlier.
Hold down the mouse button.
Move the document so that it's on top of the New Folder
you just created. The New Folder will become highlighted
 when you are in the right place.
6. Release the mouse button.

bl ol

Throw the file folder away.

1. Point to the New Folder file folder.

2. Hold down the mouse button.

3. Move the folder so that it's on top of the Trash icon. Be
sure the pointer is on top of the Trash icon and the Trash
icon is highlighted.

4. Release the mouse button.
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Trash |
1 item 4K in Trash
&
Neger
N
| B[

Special
Empty Trash |
Erase Disk
Set Startup
Use MiniFinder...

Shut Down
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Retrieve the file folder from the Trash.

1. Open the Trash.
2. Move the New Folder back into the disk window.
3. Close the Trash window.

Empty the Trash.

(Note: In order to practice emptying the Trash, there must be
something in the Trash. Hence the first step, even though it
seems repetitive.)

1. Throw away the New Folder.

2. Open the Trash (so you'll be able to see what happens;
this is not necessary to empty the Trash).

3. Choose Empty Trash from the Special menu.

4. Close the Trash window.

Open the Information window.

1. Select the Example document icon.
2. Choose Get Info from the File menu. Leave the
Information window open on your screen.

E Information about erample |

example D
Kind: document

Size: 2048 bytes, accounts for 2K on disk
Where: Guided Tour, external drive

Created: Saturday, February 4, 1984 at 4:22 AM
Modified: Saturday, February 4, 1984 at 5:21 AM

[ Locked

(lnsertion pointfor adding text]

Enter some text, then move it.

Notice the insertion point in the box in the bottom of the
Information window. Anything you type will appear there.

1. Type something that you might enter into the Information
window, such as the revision date, a deadline, or a
reminder. Type at least several words.

2. Select the first half of the text you just entered. (Notice that

the pointer on the screen has changed into a text pointer
or I-beam pointer.)
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3. Choose Cut from the Edit menu.

4. Move the insertion point to the end of the remaining text
(position the pointer after the text, and click the mouse
button).

5. Choose Paste from the Edit menu. The text you cut will
be pasted into its new location within the box.

Close the Information window and return to the
Guided Tour screen.

1. Click in the close box to close the Information window.
2. Choose Quit from the Training menu.

Feedback

Practice Guided Tour If you had trouble, do one of the following:
Techniques
» Replay the second session of the Guided Tour.

» Read the appropriate section of Macintosh, the owner's
manual, which contains complete explanations of all of the
techniques taught in this module.

» Ask a colleague, your course manager, or your Apple
support representative for help.

Guided Tour of Macintosh (cont'd)

Take a Break You've been working hard. Relax for 10 to 15
minutes before continuing.

Guided Tour Complete the third Guided Tour session, "Why
Do | Have Windows?"

Start the cassette and follow the instructions to complete the
next Guided Tour session. As soon as you return to the
Guided Tour screen, stop the cassette and read the review
below. After the review, practice the techniques you saw in the
Guided Tour.
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Review of the Guided Tour

Active Window
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Continue with this module when you have finished the third
session of the Guided Tour.

Review of the third Guided Tour session, "Why
Do | Have Windows?"

Read the following review of what was covered in the third
session of the Guided Tour. Following the review you will
have an opportunity to practice what you have learned.

You can work in only one window at a
time—the active window.

You can have several windows open on your desktop at the
same time, but you can only work in the active window. If
you want to work in a different window, you must first select
that window.

-To select a window, point to any visible part of it and click the

mouse button. If the window was partially obscured by
another window, it will now be "on top of the stack” and fully
visible.

There are several ways to tell which window is the active
window.

MacWrite Disk

3items 355K in disk 45K available . "
Title bar is
hi te

System Folder MacWrite

N=—— Empty Folder

0 s OK in folder 45K available

Close box
is visible Size box

is visible

Active window
{ overlaps other
. windows

+ The title bar (at the top of the window) is gray on both sides
of the title. On other windows it will be white.

+ The close box is visible.

« If the windows are overlapping, the active window will
always be on top.
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Resizing Windows

Moving Windows

Scroll Bars

» The size box (the lower right corner of the window, which
enables you to enlarge and shrink the window) is visible.

Resize windows to view the contents of more
than one window at a time.

Most windows are initially only slightly smaller than the
screen. If you want to view the contents of more than one
window at a time, you must make the windows smaller. Then
later, if you want to view more information in one particular
window, enlarge it again.

Use the size box to enlarge or shrink a
window.

[y
.

Point to the size box in the extreme lower right corner of
the window (as shown at the left).

Hold the mouse button down.

Move the mouse to resize the window.

Release the mouse button when the window is the size you
want.

Rl i

Move a window to view the contents of more
than one window.

If you want to view the contents of more than one window,
you'll have to resize and move at least one of the windows.

To move a window, grab the title bar.

1. Point anywhere within the title bar (at the top of every
window).

Hold the mouse button down.

Move the mouse to move the window.

Release the mouse button when the window is where you
want it.

Eal i

Use the scroll bars to view other parts of your
document.

Most of the documents you'll create will be too large to fit
entirely on the Macintosh screen. Spreadsheets,
word-processing documents, and even graphics will usually be
much wider and/or longer than the screen. Use the horizontal
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and vertical scroll bars to view the portions of your documents
that aren't initially visible.

There are three components of the scroll bars:

[T

O=————— imptyFolder =——1
2 items 12K in folder 388K available

/—{Scroll AITOWS

Scroll Boxes Scroll Bars

» Scroli arrows. These enable you to slowly scroll up,
down, left, or right. Point to the appropriate arrow and
click the mouse button to scroll once in that direction. Or
hold the mouse button down to scroll continuously.

» The scroll box. This indicates your relative position in
the window. To quickly jump to any part of the window,
use the mouse to drag the scroll box (point to it, hold the
mouse button down, and move it) to the desired location,
and release the mouse button.

» The gray area around the scroll box. Click here to
scroll through your document window by window. For
example, what if you want to quickly scroll through a text
document? Click in the gray area below the scroll box in the
vertical scroll bar. The last line of text will become the first
line of text and you will be able to see the next window of
information below that line.
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Practice

Practice Guided Tour
Techniques

Practice what you saw in the Guided Tour and
what you read about in the review.

Do each step as it's described.

1. Click Let Me Use my Macintosh! from the Guided
Tour screen.

2. Open the Guided Tour disk.

3. Open the System Folder.

Move a window on your screen.

Notice that you can't see the bottom of the System Folder
window. To move the window up the screen, do the
following:

Point to the title of the System Folder window.

Hold the mouse button down.

Move the mouse to move the System Folder window up
the screen.

Release the mouse button when you get the window where
you want it. (It's okay to overlap the Guided Tour
window.)

el

Identify the active window.

File Edit Uiew Special

Guided Tour
319K in dizk

80K available

e g
Mousing Around Notes Amazing

System Folder =
176K in folder

= —= = .
Firder MNote Fad File Cliphoard File Scrapbook File RealFinder

B

80K available
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Mousing Around Notes

== Guided Tour ==
8 items 319K in disk 80K avai

E[(J= Guided Tour ===

8 items 319K in disk 80K avai

Mousing Around Notes
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The System Folder window is now the active window. Notice
that it differs from the Guided Tour window in the following
ways:

Its title bar is highlighted.

It has a close box.

It has a size box.

If they originally overlapped, the active window now
covers part of the other window.

e o o o

Select the Guided Tour disk window to make it the active
window. Notice how the window changes when it
becomes the active window.

Select the System Folder window.

Close the System Folder window.

Use the size box.

Nk W

Point to the size box in the Guided Tour window.
Hold the mouse button down.

Move the mouse to shrink the Guided Tour window.
Release the mouse button.

Enlarge the Guided Tour window to its original size.

Scroll through a window.

-—

Shrink the Guided Tour window.

Click on the arrow that's pointing down, to scroll down
through the window.

Continue scrolling down until you can't scroll anymore;
you're at the bottom of the window.

Point to the up arrow.
Hold the mouse button down to scroll continuously back
to the top of the window. Watch the scroll box.

Grab the scroll box in the horizontal scroll bar (across the
bottom of the window).
Move it to the right edge of the window.
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Practice (cont'd)

E00= Guided Tour ==

8 items 319K in disk BOK avai

8.
9.
10.
11.

Point in the gray area to the left of the scroll box.
Click the mouse button to scroll in window-size
increments.

Continue clicking in the gray area until you are back at
the left side of the window.

Enlarge the Guided Tour window to its original size.

Return to the Guided Tour screen.

1.
2.

Choose Close from the File menu or click in the close
box to close the Guided Tour window.
Choose Quit from the Training menu.

Feedback

Practice Guided Tour
Techniques

If you had trouble, do one of the following:

Replay the Guided Tour session.

Read the appropriate section of Macintosh, the owner's
manual, which contains complete explanations of all of the
techniques taught in this module.

Ask a colleague, your course manager, or your Apple
support representative for help.
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Guided Tour of Macintosh (cont'd)

Guided Tour

Review of the Guided Tour

Guided Tour

Review of the Guided Tour

Complete the fourth Guided Tour session,
"What Else Is In The Menus?"

Continue with this module when you have finished the fourth
session of the Guided Tour.

Read this review of the fourth Guided Tour
session, "What Else Is in The Menus?"

This session talked about the Finder menus. The Apple
menu, the File menu, and the Edit menu are always available,
even when you are running an application. The other two
Finder menus, the View menu and the Special menu, are
available only when you are using the Finder (when you're in
the desktop environment and not running an application). The
Training menu is available only on the Guided Tour disk.

There is no practice exercise for this Guided
Tour session.

When you finish the entire Guided Tour of Macintosh, you'll
read about the capabilities of each Finder menu in the
Macintosh manual. So they won't be reviewed here, and there
isn't a practice exercise.

Continue with the fifth, and final, session of the Guided Tour.

Complete the final Guided Tour session, "Time
To Play The Maze."”

Continue with this module when you have finished the final
session of the Guided Tour of Macintosh.

Read this review of the fifth Guided Tour
session, "Time To Play The Maze."

Following the review you'll have an opportunity to practice
what you have learned. ‘ ‘
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Dialog Boxes

Running Applications

& e

Mousing Around Amazing

A dialog box is Macintosh's way of asking for
information or telling you what's going on.

Dialog boxes are windows that open on your screen to present
or ask for additional information, or to inform you of the
current situation. Sometimes they are the result of something
you have done, such as choosing a menu option that ends with
an ellipsis (...). Sometimes they are unsolicited, informative
comments from the Macintosh, for example, that you are
running low on space on the disk and should remove some
documents to make more room.

If Macintosh is not responding, check for a dialog box and
make the appropriate response—make a selection, click OK,
press Return, or whatever is called for. The dialog box will
not go away—nor will the Macintosh proceed—until you take
some action.

To run an application, open an icon.

There are two types of icons you can open to run an
application.

The icon that looks like a hand writing on paper is the
application itself. Open it to create a new document using that
application. There are two applications on the Guided Tour
ditgk: Mousing Around and Amazing (which are shown at the
left).

If you save what you have already entered using an application,
the information will be represented as a document on your
screen (like the MacWrite document shown at the left). When
you open the document, the application will be started
automatically and the information you previously entered will
be displayed on the screen. You're now ready to revise your
document.

When you quit an application, you're returned to the Finder
and your Macintosh desktop.
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Practice

Practice Guided Tour
Techniques

(s

Amazing

Practice what you saw in the Guided Tour and
what you read about in the review.

Do each step as it's described.

Click Let Me Use my Macintosh! from the Guided Tour
screen.

Run an application.

If you haven't already tried to solve a maze for yourself, go
ahead and try it now.

1. Click on Let Me Use my Macintosh!.
2. Open the Amazing icon.
3. Choose Skill from the Maze menu.

Select the desired maze difficulty...

En  gE

< O

[ New Game J [ Cancel ]

When you choose Skill from the Maze menu, you're
presented with a dialog box of the different skill levels
available. The first level isn't very difficult. Each level is
harder than the previous one, and the fourth level is almost
impossible.

4. Select the level you want from the Skill dialog box.

If you'd like to, take some time now to try to solve one or two
of the mazes. Continue when you have finished running
Amazing. ‘

5. Choose Quit from the Maze menu.

Don't choose Quit from the Training menu, because there's

one more practice exercise for which you'll need the Guided
Tour disk.
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Feedback

Practice Guided Tour If you had trouble, do one of the following:
Techniques
» Replay the Guided Tour session.

» Read the appropriate section of Macintosh, the owner's
manual, which contains complete explanations of all of the
techniques taught in this module.

» Ask a colleague, your course manager, or your Apple
support representative for -help.

Guided Tour of Macintosh (cont'd)

Finder Menus Read the manual to learn about all of the
Finder menu commands.

Read the Finder Menus section of Chapter 4 in Macintosh, the
owner's manual to learn about each of the Finder menu
commands.

Continue with this module when you have finished reading
about the Finder menus.
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Bl Basic Macintosh Techniques

Overview

Mouse Techniques

This section explains skills that will make it
easier to use the Macintosh.

The Guided Tour of Macintosh taught you most of the skilis
needed to use Macintosh. There are a couple other subtle
points, though, that are worth making because they will make it
easier for you to use your Macintosh.

There are practice exercises interspersed throughout the

remainder of the module that will give you a chance to try out
these techniques.

There are only four ways to use the mouse.

A Tl

N

» Click. Press and immediately release the mouse button.
Click to select an icon, close a window, or make a selection
in a dialog box.

N

~

» Press. Press and hold down the mouse button. Press to
use the scroll arrows or to view the contents of a menu.
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Sy e

L

* Drag. Press and hold down the mouse button, move the
mouse, and then release the mouse button. Drag to choose
a menu command, move an icon, select some text, or draw
a selection rectangle (to select several icons).

I

~

* Double-click. Click the mouse button twice in rapid
succession. Double-click to open an icon or select a word.

Variations on the theme.

There are a couple of variations on these basic techniques, but
you will recognize that they are indeed variations, and not new
techniques.

37 2

S Y

* Double-click, drag. Double-click, and hold down the
mouse button on the second click. In other words, click the
mouse button, and then immediately hold the mouse button
down to start to drag. Use this technique to select multiple
words of text. (If you just drag through text you will select
individual letters. Double-click, drag will select only
complete words.)
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Finding Lost Windows
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A Ve

L

» Shift-click. Hold down the Shift key and click.
Shift-click to select several icons or to deselect specific
icons from a group of already-selected icons.

These same techniques are used by all
application programs.

No matter which application you are using or what type of
information you are working with, you'll always use the same
mouse techniques. But each application uses the techniques to
achieve results appropriate to that particular application. For
example, in MacPaint™, double-clicking the eraser will erase
the contents of the entire window.

Because you can have several icons open at
once, you might lose windows on the desktop.

Think of a stack of papers on your desk. It's very easy to
temporarily lose a particular piece of paper when things get
cluttered. The same thing can happen on Macintosh when you
have several windows open at once.

There are three easy ways to find the window you are looking
for:

Double-click on the window's icon shadow.

If you can see the window's icon shadow (see the next page
for information about icon shadows), double-click on it, and
that window will become the active window.

Change the size of the top window, or move
windows out of the way.

It's possible that the top window is completely covering the
one you are looking for. Use the size box to shrink the top
window, revealing the window(s) under it. Or, move the top
window to one side.
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lcon Shadows

Close everything, then open the one you want.

A final alternative is to close all of the windows (choose Close
All from the File menu) and then open the one that was "lost."

An icon shadow is a placeholder for a window.

When you open an icon, an icon shadow is left behind to mark
where the window will be filed when it is closed. If you see an
icon shadow, it means that the icon has been moved onto the
desktop, or that it's open.

& File Edit Uiew Special

Yy shadow f
4 items 288K in disk 111K available ystem Disk

Font Mover  Disk Copy

lcon shadow for
System Folder

System Folder E=——————
209K in folder 111K available

System Finder Imagewriter Clipboard File Note Pad File Scrapbook File

Select an icon shadow to change the name of the icon without
closing the window. Double-click on an icon shadow to make
an open window become the active window.

Practice

Mouse Techniques and
lcon Shadows

Practice the mouse techniques and using icon
shadows to find lost windows.

You've already had a chance to practice most of the mouse
techniques many times. This exercise provides the opportunity
to practice two of the techniques, double-clicking and
Shift-clicking, which can save you time, and be very useful.
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You'll also practice using icon shadows to locate a lost
window.

Practice mouse techniques.

The Guided Tour disk window should be open on your screen.
If not, open it now.

What if you want to select only the Notes, Example, and
System Folder icons? There are two ways to do it: (1) select
each icon individually, and (2) select all the icons and then
deselect the ones you don't want. Perform each step below, as
it's described, to practice both of these techniques.

Select each icon individually.

1. Select the Notes icon.

2. Hold down the Shift key and click on the Example icon.
Both icons should now be selected.

3. Hold down the Shift key and click on the System Folder
icon. All three icons should now be selected.

E==—— Guided Tour BVF———=
8 items 320K in disk TOK available
Mousing Around Rl Amazing
. -

Example System Folder

& B

Select all of the icons and then deselect the
ones you don't want.

1. Position the pointer away from all of the icons and click the
mouse button to cancel the current selection.

2. Draw a selection box around all of the icons in the Guided
Tour window to select them.

LEARNING TO USE MACINTOSH



38 Basic Macintosh Techniques

Practice (cont'd)

3. Press the Shift key and click on the Amazing icon. It
should become deselected while the other icons remain
selected.

4. Hold down the Shift key and click on the Mousing
Around icon. It should become deselected while the other
icons remain selected.

Use the icon shadow to find a lost window.

1. Position the pointer away from all of the icons and click the
mouse button to deselect everything.

2. Move the System Folder icon onto the desktop, just below
the Guided Tour disk shadow.

€ File Edit View

eci
Tou
344K in disk

Mousing Around  Notes Amazing

Example

3. Double-click on the System Folder to open it. (If it doesn't
open, double-click faster.)
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4. Move the System Folder window up the screen so that it
covers most of the Guided Tour window.

&

File Edit Uiew Special Training

Guided Tour
327K in disk 72K available

System Folder —
176K in folder 72K available

Systemn Finder

5. Shrink the System Folder so that it lies completely within
the Guided Tour window.

& File Edit Uiew Special Training

Guided Tour
335K in disk 64K available

System Folder
6 items 176K in folder 64K available

System Finder Mote Pad File Clipboar

"

6. Click on any visible portion of the Guided Tour window to
make it the active window. The System Folder window
will be completely hidden behind the Guided Tour
window.

7. Double-click on the System Folder shadow (shown at left)
to make the System Folder window the active window.
The window will now be back on top of the Guided Tour
window.
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Practice (cont'd)

8. Return the System Folder window to its original size and
location on the desktop.

% File Edit View Special Training

Guided Tour
327K in disk

8 items 72K available

&

Mousing Around  Notes Amazing

Example

System Folde
177K in folder

System Finder Mote Pad File Clipboard File Scrapbook File RealFinder Iy

6 items 72K available

9. Close the System Folder and place the icon back inside the
Guided Tour window.

Return to the Guided Tour screen and stop.

1. Choose Quit from the Training menu.
2. From the Guided Tour screen click I'm Ready to Stop!
The Guided Tour disk will be ejected.

Feedback

Mouse Techniques and If you had trouble, do one of the following:

Icon Shadows .
« Reread this section to be sure you understand the techniques

covered.

« Read the Summary of Mouse Techniques section of Chapter
3 in Macintosh, the owner's manual.

+ Ask a colleague, your course manager, or your Apple
support representative for help.

APPLE SUPPORT TRAINING LIBRARY



Basic Macintosh Techniques 41

Guided Tour of Macintosh (cont'd)

Command Key

Take a Break

Use the Command key to choose menu
commands from the keyboard.

Some people prefer to use the keyboard rather than the mouse.
The commands that can be chosen either way are those which
are listed in the menus followed by the Command-key symbol
and a letter of the alphabet. To choose one of these commands,
hold down the Command key (just to the left of the spacebar)
and type the appropriate letter.

Here's a summary of the Finder menu commands that have
keyboard equivalents.

New Folder 3N Undo E Y4
Get Info £ Cut #8H
Duplicate *®D Copy #8C
Eject RE Paste 8V

Select Al %A

You've been working hard. Relax for 10 to 15
minutes before continuing.
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Il Documents and Folders

Overview

Desktop Analogy

This section describes techniques for working
with documents and folders.

The Macintosh desktop environment is very different from the
operating environments of traditional personal computers. You
do many things on the Macintosh desktop using pictures of
documents, file folders, and trash cans, the same way you do
those same tasks at a real desk with real documents, file
folders, and trash cans. Therefore, many users will find using
Macintosh intuitive and very easy to learn.

However, despite its similarity to the real world, there are some
differences, as well as some techniques unique to Macintosh
that don't have a real-world analogy. For example, there's no
task associated with a real desk that's comparable to viewing
the contents of a folder by icon or by size.

This section describes how to do the obvious tasks, as well as
the not-so-obvious. You will learn how to move documents
and folders, copy them, save your work, and throw away what
you don't want anymore.

Practice exercises are included to give you an opportunity to try
each of the techniques. Read the description of each technique.
Then practice each technique in the exercises provided. Have
your Macintosh ready, along with the following:

* A Macintosh System Disk
¢ A MacWrite disk
e A blank disk

The desktop analogy encompases all phases
of information management on your computer.

Working on your Macintosh is, in many ways, like working at
your desk. But it goes beyond pictures of documents and
folders on the screen. It's worth spending some more time
drawing some parallels to help you understand what's going on
both inside the computer and on the screen.

So, let's go back to the precomputer office, and see how
closely the two worlds correlate.
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Computer memory is like a chalkboard.

Writing notes on a chalkboard is similar to working with
information in a computer's memory, commonly called RAM
(Random Access Memory). The information on the chalkboard
and the information in memory is easily removed or lost. A
colleague can come in and erase the board, and a power failure
can make the information in the Macintosh RAM disappear.

Transferring information to paper is analogous
to saving it on a disk.

Transferring the information from the chalkboard to a sheet of
paper is analogous to saving the information to a disk. A
version of the information is safely on disk and can easily be
referred to in the future. Also, both forms of storage are easily
transportable.

Duplicating some paper is similar to backing
up a disk.

Duplicating the sheet of paper and filing it in a different place
from the original is a safety precaution similar to backing up a
Macintosh document or disk. The information resides in two
separate places, ensuring that the destruction of one copy does
not result in the total loss of the information.

A filing cabinet is analogous to a hard disk.

A filing cabinet is used to store large amounts of information
and the information tends to stay there for a long time. A hard
disk performs the same function when you are using a
Macintosh. You can store your documents and file folders
there and retrieve them at some time in the future. Also, both
tend to be permanently located in one place.

A hard disk is basically the same as a smaller disk in its ability
to store information. It's different from a smaller disk in that it
can store much more information; it can access that information
more quickly; and it's not as portable.

The techniques for copying and moving
documents are similar.

The techniques for storing and duplicating paper also have
correlates in the Macintosh working environment. On the
Macintosh, you can copy documents and move them between
file folders and the hard disk (filing cabinet) just as you would
with pieces of paper.
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Moving Documents
and Folders

Throwing away documents is very similar, too.

‘Throwing away your papers and file folders when they aren't

needed anymore is the same as putting Macintosh documents
and folders into the Trash and erasing disks when the
information they contain is no longer needed.

Throwing away a file folder throws away its contents, too. In
Version 4.1 of the Finder, throwing away a disk actually ejects
it and removes its shadow from the screen (you don't lose any
information).

The technique is different depending on
the source and destination.

The Guided Tour of Macintosh introduced you to these
concepts and procedures. This section will show you the
techniques used to copy and move documents and folders, and
will clarify the difference between copying and moving
documents on the same disk and between disks.

Moving an icon from one place to another has
different effects.

Dragging an icon from one place to another moves that icon to
anew location. The result of the move depends on where you
move the icon.

» Dragging an icon onto the desktop has no effect.

» Dragging an icon from one place to another on the same
disk (or to a folder on that disk) just moves the icon to a
new location. No information is actually moved anywhere.

 Dragging an icon to another disk (or to a folder on another
disk) puts a copy of the document on the disk and leaves the
original where it is.

Choose Duplicate to place a copy on the same
disk.

Dragging an icon elsewhere on the same disk just moves the
icon. Choosing Duplicate creates a copy of the document on
the same disk as the original. The duplicate will be titled
"Copy of <original name>."
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Move a document onto another disk.

Remember that if you drag an icon to another disk, a copy of
that document or folder will be placed on the disk but the
original will stay where it is. Moving a document, by
definition, means that the document is in a new location, and
that it no longer exists at the original location.

For example, to create some room on a disk, move several
documents onto a separate data disk.

To move a document or folder to another disk:

1. Drag the document or folder to the destination disk.
2. Throw away the original.

Here is a table that summarizes the techniques just described.
The technique is the same for folders as it is for individual

documents.
SAME DISK DIFFERENT DISK
COPY gﬁ:?l;:tate Select
Drag to new location Drag to other disk
Select
Move | Select | Drag to other disk
Drag to new location | pyt original in Trash

Saving Your Work There are two ways to save the information in

your document.

To ensure that your work on the Macintosh will be around for
NeL modification in the future, save it on a disk. Use either of the
Open... two save commands in the File menu, Save and Save as, to
Close ’ preserve your work.

Save

- Save As...
Page Setup...
Print...

Quit

(Note: These commands are available only when a document
is open. They are not available when you're in the Finder.)
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Choose Save to store the information under
the same name.

If the document is new, you will be asked to enter a name for
the document. When you choose Save, you'll get the
following dialog box:

Save Current Document As | Disk Name

(Cancel ) i [ Drive )

Enter a name and choose which disk you want to save it to by

clicking Drive. If the disk on which you want to save the

document is not available, click Eject to eject the disk whose

name is displayed in the dialog box above the Eject button, and

then insert the appropriate one. This dialog box may vary

:}]lightly from application to application, but the basic content is
€ same.

The Save command automatically stores the document you're
currently working on under the same name it was stored under
previously (no dialog box appears). It also leaves the
document window open so you can continue entering
information or making modifications.

Choose Save As to store the information under
a different name.

The Save as command is similar to Save, except that it gives
you the opportunity to save your document under a different
name or on a different disk. Save as also leaves the window
open so you can continue making modifications.

Use Save as when you want to save a copy of a document to
a different disk or when you want to keep the original in
addition to the revised version.

When you choose Save as, you'll get the dialog box

described above. The name defaults to the original name of the
document. Changing the name is optional, but if you're saving
two versions of the document on the same disk, you can't use
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the same name. Choose which disk you want to save your
work on, and click Save.

After you click Save, the document displayed on your screen
is the one you just saved, not the original. For example, if you
created your original on the internal disk and then used Save
As to save a copy on a disk in the external disk drive, the
document open on your screen is the one saved on the disk in
the external drive. If you make changes and choose Save, the
changes will be written to the disk in the external drive.

Click Cancel if you want to ignore the Save command, close
the window, and continue editing the document.

Choose Close to close the document window.

You have already used Close and the close box to close a disk
or folder window while in the Finder. When you have a
document open, you also choose Close to close the window.

The Close command closes the document window that's
currently active, but leaves you in the application that was used
to open the document. If you have made some changes to the
document, the following dialog box will appear, asking you if
you want to save your changes:

Save changes before closing?
[_ves |

Click Yes to save your changes. Click No to throw away all
of your changes. Click Cancel to ignore the Close command
and leave the window open so you can continue working on
the document. This dialog box will vary slightly from
application to application, but the message is the same.

Choose Close, or click in the close box, when you want to
close the document you're working on so you can open another
document using the same application. This method is faster
than quitting, returning to the Finder, and opening the next
document. The technique for doing this is described in many
of the applications modules.
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Quit

Quit closes the window and returns to the
Finder.

Choose Quit from the File menu when you are finished with
the document you're working on and you want to stop using
the application. If you choose Quit before saving your
changes, the same dialog box that appears when you choose
Close will appear. Click either Yes, No, or Cancel.

Quit or Close?

Quit and Close both close the active window and give you an
opportunity to save your changes. The difference is that Quit
returns you to the Finder, whereas Close keeps you in the
application and allows you to quickly open another document.

Practice

Practice Working with
Documents and Folders

MacYrite

Do each step as it's described.

This Practice provides a series of exercises to help you practice
creating, saving, revising, and backing up documents.

Create and save a document.

Insert the MacWrite disk and turn on the Macintosh.

Open the disk icon.

Double-click on the MacWrite application icon (shown

at the left) to create a new MacWrite document.

‘When the window is open and you see the insertion point,

type something. (Anything but "The quick brown fox..."

Be creative.)

5. Save what you have done so far by choosing Save from
the File menu.

6. Enter a name for the document.

7. Click Save.

» b=

The work you've done so far has been saved. The window is
still open on your desktop with the new name in its title bar.

Modify the text, but don't save your changes.

Sometimes you will be revising or experimenting with a
document and will decide you liked the original better. Here's
how to throw away all of your revisions and keep the original:
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1. Enter some more text or change what you have already
typed. (Remember how to move text? Select it, choose
Cut, move your insertion point, and choose Paste.)

2. Choose Close (or click in the close box) to close your
document.

3. When asked if you want to save your changes, click No.

The window will be closed without the changes being saved.
But you are still in MacWrite—notice that the MacWrite menus
are still visible and the desktop icons have not appeared.

Save your changes and keep the original.

What if, as you are revising a document, you decide you want
to keep both the original and the revised version? Here's how
to do it.

To create two versions of the document;

1. Choose Open from the File menu. You will be presented
with the Document Directory dialog box.

If you don't see the name of your document, scroll down
through the list of names.

Point to the name or your document and click the mouse
button to select it (it will become highlighted).

Click Open.

Add some text to what you already have.

Choose Save as from the File menu.

Enter a new name for the document.

Click Save.

PN E WD

The original won't be affected and your changes will be saved
under the new name. The window will remain open on your
screen but the title will change to the name you just entered.
Further changes are made to the copy, not to the original.
When you choose Save, all changes will be made to the
document whose name appears at the top of the window.

Revise the original and keep the changes.

This is probably the most common situation you'll encounter.

1. Click in the close box to close the revised version.
Because you just saved it, you will not be asked if you
want to save changes.

Choose Open to open the original document.

If you don't see the name of your document, scroll down
through the list of names.

Double-click on the name of your document to open it.
This is the same as selecting the name and clicking Open.
Revise your document (change the text or add to it).

A
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Practice (cont'd)

6. Choose Quit from the File menu. You will be asked if
you want to save your changes.
7. Click Yes.

You have just edited a document, saved your changes, quit the
application, and returned to the Finder.

Make some backup copies of your documents.

Insert the blank disk into the external drive. If you are told the
disk is not a Macintosh disk, click Initialize in the dialog box.
This will take a couple of minutes. When the initialization is
complete, enter a name for the disk, and click OK (see the
Disks section of this module for more information about
initializing disks).

For this part of the exercise, let's be sure you have the terms
straight. The MacWrite disk, where you created your original
document and saved your revised document, is in the internal
disk drive. You just inserted the backup disk into the external
disk drive—and possibly initialized it.

To practice moving and copying documents, do the following:
1. Copy the original document onto the backup disk:

» Drag the icon on the original document onto the icon of
the backup disk.

» Be sure the backup-disk icon is highlighted when you
release the mouse button.

2. Make a duplicate of the revised document on the MacWrite
disk:

» Select the revised document icon.
* Choose Duplicate.

3. Move the duplicate you just made to the backup disk
(remember that moving something, unlike copying, by
definition means that it's no longer in its original location):

 Drag the icon for the duplicate you just made onto the
backup-disk icon to put a copy on the backup disk.

« Throw away the duplicate you just made to complete the
move.
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4. The MacWrite disk should contain the original document

and the revised document. Open the backup disk to
confirm that it contains backup copies of each document.

Often after creating documents, you'll want to move them onto
another disk, on which you'll revise them at some later date.
This last part of the practice exercise has you create a file folder
for the documents on the data disk, which will make them
easier to find, and then has you remove the documents from the
MacWrite disk.

1.
2.

e B A T

The backup-disk icon should be open and it should be the
active window.

Choose New Folder from the File menu to create an
Empty Folder on the backup disk. (If you don't see the
New Folder command, you have an old version of the
software. Instead, make a duplicate of the Empty File
Folder.)

Rename the folder (it's already selected, so just type a new
name). ‘

Put the documents that are on the backup disk into the file
folder.

Make the MacWrite disk the active window (click on any
visible portion of the window).

Throw away the original document and the revised
document from the MacWrite disk.

Empty the Trash.

Choose Shut Down from the Special menu. (If Shut
Down isn't in the Special menu, you have an old version
of the software. Instead, select each icon and choose
Eject.)

Turn off the Macintosh.

Feedback

Practice Working with
Documents and Folders

If you had problems, try one of the following:

[ ]

Reread the section of this module that pertains to the area
with which you had difficulty.

Read the section of Macintosh, the owner's manual, that )
contains complete explanations of the techniques covered in
this module.

Ask a colleague, your course manager, or your Apple
support representative for help.
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Il Disks

Overview

Disk Care

Learn what is on a disk, how to handle disks,
and how to use them.

Disks are one of the most important components of a computer.
You run applications from disks and save all of your work on
them. Because of the amount of handling involved, they're
also the cause of most problems. Therefore, the more you
know about disks, the fewer problems you'll have.

This section covers how to handle and care for disks, what's
on a disk, the difference between startup disks and data disks,
and how to initialize, back up, erase, and repair disks.

Exercises are included to help you practice the techniques
described in this section. Read the descriptions of disk
techniques in the first part of this section, and then complete the
practice exercises when you get to them.

(See the Supporting ProDOS and DOS module from the Apple
Support Training Library for a more technical description of
how data is stored on a disk.)

Take care of your disks, and you'll have fewer
problems with them.

Inside the disk's plastic shell is a small flat disk, made of
material similar to that used in audiocassettes. Like the
audiocassette, the disk must be treated with care.

The cause of many personal-computer problems is lack of

proper care for disks. If you adhere to these three rules, you
will have very few problems.
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Keep disks away from extreme heat.

Just like record albums, disks can warp and become useless.
Therefore, avoid leaving your disks in extreme heat or direct
sunlight for an extended period of time. Don't leave them in a
closed car on a hot day, or on top of something that gets very
warm, such as your computer.

Do not touch the surface of the disk.

Oil from your fingers can attract dust, which will interfere with
the computer's ability to read information from the disk.
Fortunately, the Macintosh disks have a shutter that
automatically closes over the disk surface to prevent you from
accidentally touching it. Still, be careful when handling disks.
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Keep disks away from magnets.

Information is stored on disks magnetically. If a disk gets too
close to a magnet, the information stored on that disk could be
lost.

This isn't as easy as you might think, because magnets are
everywhere. Telephone bells have magnets. Televisions and
video monitors have magnets that are used to align the picture.
Fluorescent fixtures, stereo speakers, and headphones also
have magnets. These magnets are usually quite small, but that
doesn't mean they can't do some damage.

Often, the damage to the disks is not immediate. However,
after storing disks near a magnetic source for a period of time,
noticeable damage may occur.

If your disk is damaged, you may get an error
message.

If your disk becomes damaged, the Macintosh may display a
message stating: "Disk has been damaged,” "Disk needs
repairs,” "Can't read this paragraph,” or something similar.

This is one of the reasons for keeping backups of your disks.
If you have a backup, you can copy the backup onto another
disk and continue working. If you don't have a backup and
your original disk becomes damaged, you may have just lost
everything. (See the Managing Macintosh Files module from
the Apple Support Training Library for techniques for
salvaging documents and disks.)
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A disk contains a directory and the information
you have saved.

e Y
Directory
Documents
Folders
Applications

i

The directory is like a table of contents for the disk. It contains
the name, location, and size of each piece of information, and
the size and location of any available space on the disk.

The information consists of applications, documents, folders,
operating systems, and so forth, that are stored on your disk.

Hard disks and disk have the same two basic components.

You must initialize all disks before you can
use them.

Initializing prepares a disk so that information, such as startup
information or documents, can be saved on it. A disk, before
it's initialized, is like a newly paved parking lot—totally blank
and without order. Initializing the disk is like painting the lines
in the parking lot—it provides a framework for organization.
Technically speaking, initializing a disk creates the directory.

Manufacturers don't seil disks already initialized because disks
usually can be used on a variety of computers and each
computer has its own way of storing information.

Initializing a disk erases all information previously stored on it.
To prevent you from accidentally losing valuable information,
initializing programs usually warn you just before they begin
that you're about to erase information, so you can cancel the
initialization if necessary.
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When you insert a disk that has not been initializedona N “

Macintosh, you will get the following message:

This is not a Macintosh disk:

Do you want to initialize it?

Click Initialize to go ahead and initialize the disk, or click
Eject to eject the disk, unchanged.

After the disk has been initialized, you'll be asked to name it.

Startup vs. Data Disks A disk is either a startup disk or a data disk,
depending on the information it contains.

(Note: A startup disk is often called a boot disk in other
computer systems.)

Startup disks contain the information needed to start up your
computer. When the Macintosh is first turned on, information
is read from the startup disk that tells the computer what to do
next. On the Macintosh, all of the startup information is in the
System Folder. In addition to getting your Macintosh up and
running, the System Folder also contains information that tells
the computer how to print your documents and how to create
the desktop screen display.

You can't do much with just the System Folder, though. So,
for most purposes, you will add an application, such as
MacWrite or MacDraw™, to your startup disk.

If a disk does not contain the startup information (the System
Folder), it is a data disk. This means that it's only used to store
data, and can't be used to start up your Macintosh. But because
you don't have the startup information on the disk, there is
much more room for data. To use a data disk, start up the
Macintosh using a startup disk, and then store information or
retrieve it from the data disk.

For example, the System Disk that comes with your Macintosh
is a startup disk because it contains the necessary startup

-
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information (in the System Folder). The blank disk that comes
with your Macintosh is a data disk.

Any disk can be used as either a startup disk or a data disk.

You can make a data disk into a startup disk
by moving the startup information onto it.

To make a data disk into a startup disk, copy the System Folder
onto a data disk. To make a startup disk into a data disk, throw
away the System Folder.

If you attempt to start up the Macintosh from a data disk, the
Macintosh will eject the disk and display a disk icon with a
flashing "X" to indicate that the disk is not a startup disk.

Practice

Create a Startup Disk

Practice different techniques for creating a
startup disk.

To use disk space most efficiently, some disks should be
startup disks and others should be data disks. An application
can reside on either a startup disk or a data disk. Most people
find it more effective to have the application on the startup disk.

There are two ways to create a startup disk:

« Copy the System Folder onto a data disk.
» Duplicate a startup disk and throw away what you don't
need.

Depending on which Macintosh configuration you are using,
one way of creating a startup disk may be easier or faster than
the other. The following Practice section will help you to
identify the best procedure to use on each Macintosh
configuration. There's an exercise for each that outlines the
steps used.
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Practice (cont'd)

Three Exercises

Create a Startup Disk:
Two-Drive System

Choose the exercise that's appropriate for the
system you're using.

There are three different practice exercises because the
techniques are different for different Macintosh systems. The
three exercises are for the following system configurations:

+ Macintosh 128K or 512K with two disk drives.
* Macintosh 128K with one disk drive.
» Macintosh 512K with one disk drive, or Macintosh XL.

Do the exercise that is appropi‘iate for your system, and read
through the other two to become familiar with the alternative
techniques.

Copy the System Folder.

If you have either a Macintosh 128K or a Macintosh 512K with
two drives, create a startup disk by copying the System Folder
from a startup disk to the data disk.

Use the System Disk and a blank disk to practice this. The
steps to create a startup disk are listed below. If you think you
already know how to do it, try it without looking at the
directions.

To create a startup disk on a two-drive system, do the
following:

1. Start up from the System Disk.

2. Insert the blank disk into the external drive.

3. Ifyou get a message saying the disk is not a Macintosh
disk, click on Initialize. After initializing the disk, enter
a name for it.

4. Open the System Disk icon.

5. Move the System Folder to the icon for the data disk.

When the copying process is finished, your data disk will be a
startup disk.

Read through the other two exercises, and then follow the
instructions to check your work.
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Disk Copy
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Copy the disk, and then throw away what you
don't want.

(Note: It is possible to use the two-drive method for creating a
startup disk on a one-drive system. But it takes longer than the
method outlined below because you will have to swap disks.)

On a Macintosh 128K with one disk drive, the fastest way to
create a startup disk is to use the Disk Copy program to copy
the original startup disk, and then throw away what you don't
need.

Disk Copy is designed for the Macintosh 128K with a single
disk drive. It does not take advantage of the external disk drive
and won't work on a Macintosh 512K.

Use the System Disk and a blank disk. If you think you
already know how to complete the exercise, try it without
looking at the directions.

To create a startup disk on a Macintosh 128K with one disk
drive, do the following:

Start up from the System Disk.

Open the disk icon.

Select and open the Disk Copy icon. If you don't see DlSk
Copy, look in the System Folder.

Follow the instructions on your screen to use the Disk
Copy program. It will involve swapping the original and
backup disks several times.

H L=

When the Disk Copy program has finished, you will have an
exact duplicate of the System Disk. The next step is to remove
what you don't want on your new startup disk.

5. Change the name of the destination disk, which is now a
startup disk identical to the System Disk, to ensure that all
of your disks have unique names.

o Start up from the copy of the System Disk. (If the new
startup disk doesn't work, go to the Feedback section
following this exercise.)

» Select the disk icon.

» Type a new name for the disk.

6. Open the disk and select all of the icons except the System
Folder and put them in the Trash. (Either use the selection
rectangle, or use the Shift-click technique to select the
icons you want.)
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Practice (cont'd)

Create a Startup Disk:
One-Drive 512K, or XL

Check Your Work

AR S o e

You have now created a startup disk from your System Disk.

Now read through the last exercise, or skip to the end of the
practice exercises and continue with this module.

Copy the System Folder.

If you have a Macintosh 512K with one disk drive or a
Macintosh XL, there is enough memory to be able to copy the
entire System Folder with only two disk swaps (one to read the
information from the original, and the other to write the
information to the destination disk).

Use the System Disk and a blank disk. If you think you
already know how to complete the exercise, try it without
looking at the directions.

To create a startup disk on a Macintosh 512K with one disk
drive, or on a Macintosh XL, do the following:

Start up from the System Disk.
- Choose Eject to eject the System Disk.
Insert the blank disk. Initialize it if you have not
previously done so.
Open the System Disk icon shadow (the gray image left
behind when you ejected the disk).
Move the System Folder to the blank disk.
Swap disks when you are asked to do so.

When the copy is finished, the System Folder will have been
added to your blank disk. If you already had other information
on the destination disk, it would still be there. The System
Folder was added to the existing contents of the disk.

Start up from the newly created startup disk to
be sure it works. .

If you are using a Macintosh 128K with one disk drive, you've
already checked your work, so you can move on to the
Feedback section.

Otherwise, you should start up from the newly created startup

disk to be sure you did everything correctly. Right now, your
screen should be displaying the desktop.
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To check your work, do the following:

1. Choose Shut Down from the Special menu. If the
Shut Down command isn't there, you have an old
version of the Finder. Instead, do the following:

* Eject both disks by first selecting the icon and then
choosing Eject from the File menu.

» Press the Reset button or turn the Macintosh off and
then on again.

2. Insert the newly created startup disk into the internal disk
drive.

If everything works as it should, you will see the desktop. If
the Macintosh doesn't start up, repeat the exercise.

3. Choose Shut Down again, or choose Eject to eject the
disk.
4. Turn off the Macintosh.

Feedback

Create a Startup Disk

You should now have two startup disks.

You should have your original startup disk, and the one you
just made and tested. If not, reread the exercise and complete
the steps you missed.

If you have problems, refer to the section on Creating a Startup
Disk in Chapter 3 of the Macintosh manual, or ask a colleague,
your course manager, or your Apple support representative for
help.

Disks (cont'd)

Add to the Startup Disk

Add applications so you can do more than just
start up the Macintosh.

You can't do much with a disk that has only the System Folder
on it (except start up Macintosh). Most of the time, you will
want to add an application to the startup disk to make it more

LEARNING TO USE MACINTOSH



62 Disks

Make an Existing Data
Disk into a Startup Disk

useful. To add an application, you need to start up from your
new startup disk, insert the application disk, and move the
application icon to the disk icon.

First check to be sure there's room.

If you want to convert an existing data disk, one that already
has information on it, into a startup disk, you must first check
to be sure there's room.

To see how much room a System Folder takes, open the
startup disk from which you're going to copy the System
Folder and choose by Size from the View menu. The first
item in the list should be the System Folder, and the first
column tells you how much room it needs.

Then open the data disk that you want to make into a startup
disk. The amount of free space is displayed at the right edge of
the title bar.

Add the System Folder to information already
on the data disk.

To convert a data disk into a startup disk on a two-drive
system, a Macintosh 512K, or a Macintosh XL, use the same
procedure you used to create a startup disk. Copy the System
Folder onto the data disk by moving the System Folder icon.
The information in the System Folder will be added to
information already on the disk.

What about a Macintosh 128K with one disk drive?

The technique for creating a startup disk on a Macintosh 128K
starts by completely erasing the contents of the destination
disk. What if there is data on that disk that you want to save?

If you want to add the startup information but don't want to
lose existing documents on the disk, do the following:

Start up from the System Disk.

Eject the System Disk. '

Insert the data disk.

Open the System disk's shadow.

Move the System Folder from the System Disk window to
the data disk.

AW -

On a Macintosh 128K, you will be asked to swap disks many
times, and you will end up with two startup disks: the System
Disk and one containing the System Folder and all of your
data.
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Because this technique adds the startup information to existing
documents on the disk, be sure there's enough room available.
Otherwise, you'll get a message saying there is not enough
room and you will have to start all over again. To create

more room on a disk, transfer some documents to other disks
or throw them away.

Locking Disks Lock your disks to avoid accidentally erasing
your information.

(Note: The term locked is the same as write protected on other
computer systems.)

B <—Disk Lockin g Tab To be absolutely sure you won't accidentally write over
information that you want to keep, lock the disk. To do this,
Back of Disk slide the small red (or black) tab at the top right corner toward
@ the top edge of the disk. This makes it impossible to write to
the disk or erase existing information until you move the tab
I ‘ back into place.
v Here is an easy way to remember what each position of the tab

means: Most disks have red tabs, and red generally means
danger. When you are looking at the front of the disk, if you
see the red tab, watch out! You are in danger of losing
information. The disk is not locked. If you don't see the red
tab (you see right through the disk), there is no danger. The
disk is locked.

Locking a disk doesn't interfere with reading information from it.

You can't lock the disk you use to start up your Macintosh.
This is because information regarding the desktop display and
other system information is constantly being written on the
startup disk.

Backing Up Disks Back up your disks in case you lose the
information on your original disk.

In the original office analogy, disks corresponded to pieces of
paper—a "'somewhat" permanent, portable copy of your
information. The reason it's only somewhat permanent is that
it is always possible to lose a piece of paper, accidentally throw
it away, or perhaps spill something on it that renders it
unreadable. This is true for disks, too, except the
consequences could be much worse. If you lose a disk or it
becomes unreadable, you could lose not just a page or two, but
hundreds of pages of work. That's why it's very important to
keep backup copies of your disks.
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A backup is an exact copy of your disk. If something happens
to your original disk, just make a working copy of your
backup, and in minutes, you're back on track.

Depending on how much work you are generating, you should
make a backup at least once a week, and possibly once every
day.

Back up either entire disks or individual
documents.

Creating a backup means saving a spare copy of the original in
a separate place. The backup can be of an entire disk or of
individual documents. The type of documents you're working
with and the amount of information that's changed will
determine which is appropriate.

If you are making changes to only one document on the disk,
it's necessary to back up just that document. If you are
working with a large document that takes most of the disk, it is
quicker to back up the entire disk. If the disk you are working
with is a startup disk, doing a full-disk backup will save all of
the startup information (which you don't really need to back
up). So, it might be more efficient to back up only individual
documents. ‘

When you back up a disk, the directory and all
of the information is copied.

- ™ 4 ™
Directory ® iDirectory
Documents ® :Documents
Folders ® iFolders
Applications ® Applications

Y E:] A S B e
Original Disk Backup Disk

Remember what's on a disk: the directory and all of the
information you have stored. When you do a disk backup, the
directory and all the information is copied exactly as it appears
on the original.

It's important to remember that when you finish backing up a
disk, the contents of the destination (backup) disk will be
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identical to the contents of the original disk. (The name of the
destination disk stays the same, though.) It's not a situation of
adding documents to a disk, but of replacing everything on a
disk with what is on the original. Therefore, be sure your
destination disk doesn't have any information you will need
later.

Don't do it yet.

Read this section. Then follow the instructions in the practice
exercises to try these techniques.

Macintosh 128K or 512K—two disk drives.

If you have a two-drive system, insert both disks and drag the
icon for the original disk onto the icon for the destination disk.
You will be asked if you want to erase everything on the
destination disk. Click Yes.

Macintosh 128K—one disk drive.

If you have a Macintosh 128K with one disk drive, use the
Disk Copy program on your System Disk. To use the Disk
Copy program, follow the instructions in the practice exercise
at the end of this section. Or, follow the instructions that the
program gives you (it tells you exactly what to do and is very
easy to use). The Disk Copy program works only on a
Macintosh 128K.

Macintosh 512K with one disk drive, or a
Macintosh XL.

If you have a Macintosh 512K with one disk drive, or a
Macintosh XL, do the following:

Insert the original disk.

Choose Eject to eject the original disk.

Insert the backup disk.

Drag the icon of the original disk onto the icon of the
backup disk.

When asked if you want to completely replace the contents
of the disk, click OK.

A

You will only need to swap disks twice. The name of the
backup disk will remain the same, so you may want to
change it.
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Backing Up Individual

Documents

Erasing a Disk

Use the Finder or the Save As command.

£ N £ ™
Directory Directory
Documents # :Document
Folders Document
Applications Document

\_ D S D o

\
Original Disk Backup Data Disk

If you are going to back up individual documents, create a
backup data disk. Don't put applications or startup
information on it—you should already have copies of those,
and they take up room you could otherwise use for backing up
additional documents.

If you are in the Finder, insert your backup disk and copy the
document from the original disk to the backup disk. The
document will be added to those already on the disk.

If a document is open (you're running an application), you can
make a backup copy by choosing Save as from the File
menu. Keep the original name or enter a new one, such as
"document—backup," and be sure you are saving it to your
backup disk. (For detailed instructions, see the section earlier
in this module about saving your work.)

Erase disks containing unneeded information
SO you can reuse them.

After you have had your Macintosh for a while, you will find
yourself with quite a collection of disks. You may not even
remember what is on many of them. Instead of letting those
disks gather dust as you continue to open boxes of new disks,
recycle any old ones that contain outdated information.

Erasing a disk removes all of the old information and creates a
disk identical to a brand-new disk that has just been initialized.
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Clean Up

Empty Trash
Erase Disk
Set Startup

Use MiniFinder...

Shut Down

Ejecting a Disk
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Here's the procedure for erasing a disk.

Read the procedure below. Then continue on to the exercise to
practice this and other techniques covered in this section.

1. Start up from any startup disk.

2. Insert the disk to be erased into the second disk drive. If
you are using a one-drive system, eject the startup disk and
insert the disk to be erased into the built-in drive.

3. The disk you just inserted should already be selected
(highlighted). If itisn't, select it (point to it and click the
mouse button).

4. Choose Erase Disk from the Special menu.

5. When asked if you really want to erase the disk, click OK.

An alternative is to open the disk, select all of the contents, and

. throw everything in the Trash. Be sure to empty the Trash to

recover all of the space taken up by what you threw away.

Here's how to erase a startup disk.

You can't erase the disk from which you started up. If you
want to erase a startup disk, start up from a different disk, and
then insert the disk to be erased and erase it using either of the
methods described above.

Eject a disk to be sure you don't accidentally
lose some information.

You have already ejected a disk a couple of times, so you
should know how to do it (select the disk icon and choose
Eject from the File menu). But you may not know why it's
important.

When you eject a disk, Macintosh does some straightening up
of the information on that disk before the disk is actually
ejected. The directory is updated, the Trash is emptied, the
location of icons in the window is recorded, and so forth.

If you turn the Macintosh off without first ejecting the disk,
you are preventing the Macintosh from doing this "house
cleaning” and you may actually lose some information.

You should always eject all disks before turning off the
Macintosh. Version 4.1 of the Finder added a new command
to the Special menu—Shut Down. Choosing this command
ejects all disks, and restarts the Macintosh. A fast and safe
way to turn your Macintosh off is to first choose Shut Down
and then turn the On/Off switch to off.
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Practice

Back Up and Erase

Three Exercises

Create a Backup Disk:
Two-Drive System

Practice backing up and erasing disks.

Now that you have read about how to back up and erase disks,
here's a chance for you to practice those techniques. '

Choose the exercise that's appropriate for the
system you're using.

There are three different practice exercises because the
techniques for backing up disks are different for different
Macintosh systems. The three exercises are for the following
system configurations:

» Macintosh 128K or 512K with two disk drives.
* Macintosh 128K with one disk drive.
» Macintosh 512K with one disk drive, or Macintosh XL.

Do the backup exercise that is appropriate for your system, and
read through the other two to become familiar with the
alternative techniques.

Then do the Erase exercise (which is the same for all
Macintosh systems).

Move one icon on top of the other.

If you have a Macintosh 128K or Macintosh 512K with two
disk drives, back up a disk by dragging one icon on top of the
other. Use the System Disk and a blank disk to practice. The
steps to back up a disk are listed below. If you think you
already know how to complete the exercise, try it without
looking at the directions.

To back up a disk on a two-drive system:

1. Start up from the System Disk.

2. Insert a blank disk into the external drive.

3. Move the System disk icon onto the icon for the blank
disk. Be sure the icon is highlighted so you know you are
in the right place.

4. When you are asked if you want to completely replace the
contents of the disk, click OK. v
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Create a Backup Disk:
One-Drive 512K, or XL

Disks 69

5. Change the name of the backup disk so you can identify it
later.

Read through the other two techniques, or skip ahead to
practice erasing a disk.

Use the Disk Copy program.

If you have a Macintosh 128K with one disk drive, back up a
disk using the Disk Copy program. Use the System Disk and a
blank disk to practice. The steps to back up a disk are below.
If you think you already know how to do it, try it without
looking at the directions.

To back up a disk on a Macintosh 128K with one disk drive:

Start up from the System Disk.

Open the disk icon.

Open the Disk Copy icon.

Click OK. (Follow the instructions at the bottom of the
screen.)

Reinsert the System Disk when requested to do so.
Swap the System Disk and the backup disk as instructed
(about eight times).

Click Quit when the copy has finished.

Change the name of the backup disk so you can identify it
later.

XN A WD

Now read through the third techmque, or skip ahead to practice
erasing a disk.

Drag the original disk's icon onto the icon for
the backup disk.

If you have a Macintosh 512K with one disk drive, or a
Macintosh XL, back up a disk by dragging the icon for the
original disk onto the icon for the backup disk. Use the
System disk and a blank disk to practice. The steps to back up
a disk are below. If you think you already know how to do it,
try it without looking at the directions.

To back up a disk on a Macintosh 512K with one disk drive or
a Macintosh XL:

1. Start up from the System Disk.

2. Eject the disk and insert a blank disk (or a disk whose
contents you don't mind erasing).

LEARNING TO USE MACINTOSH



70 Disks

Practice (cont'd)

Erase a Disk

3. Drag the icon shadow of the original disk onto the icon for
the backup disk. The icon will be highlighted.

4. Swap disks as directed.

5. f,’hange the name of the backup disk so you can identify it
ater.

Practice erasing a disk by erasing the backup
you just made.

You can't erase the startup disk, so regardless of what system
you are using, start up from the System Disk and then erase the
backup disk.

To erase a disk:

1. Be sure the backup disk is in the disk drive and the icon is

selected.

2. Choose Erase Disk from the Special menu.

3. 'When asked if you really want to erase this disk, click
OK.

The disk is now just like a new disk that has just been
intialized.

Feedback

Backup and Erase

You should end up with a System Disk and a
blank disk.

During the exercise you should have made a backup copy of
the System Disk, and then erased it. If you didn't do that,
reread the exercise and complete the parts you missed.

If you had problems, read the Copying an Entire Disk section
in Chapter 3 of the Macintosh manual, or the explanation of the
Special menu in the Menus section of Chapter 4. Or ask a
colleague, your course manager, or your Apple support
representative for help.
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B Review

Guided Tour of Macintosh

Learn the basic techniques for using
Macintosh.

The Guided Tour of Macintosh is a computer-based training
program that teaches you the basic skills you will need for
using Macintosh. After viewing all five sessions of the Guided
Tour and completing the practice exercises included in this
module, you should have mastered many of these techniques.
Here is a quick summary of the major areas covered by the
Guided Tour.

The Macintosh desktop.

The Finder maintains the desktop and enables you to keep track
of where your information is stored and what you want to do
next.

Each icon on the desktop has a different function. The icons,
in conjunction with the menu bar across the top of the screen,
represent all of your information and capabilities on the
Macintosh. To choose something from a menu, you just open
the menu, point to what you want, and then release the mouse
button.

There are two steps to doing most things on the Macintosh:

(1) Select what you want to work with, and (2) Choose the
appropriate menu command. For example, to open an icon you
should first select it, and then choose Open.

The menu commands that are currently available and
meaningful are shown in black type. The gray menu
commands are inapplicable to your current selection.

Working with icons.

Select icons by pointing to them and clicking the mouse button.
Select several icons by using either the selection rectangle or
the Shift-click technique. Open and close icons by using the
appropriate command from the File menu.

You can use the mouse to move icons. You can also duplicate
icons to create copies, and rename them by selecting the icon
and then typing a new name. Organize icons by depositing
them in the appropriate place. For example, you can deposit a
document into a file folder, a file folder onto a disk, or
anything into the Trash.
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You can open the Trash and retrieve anything you have thrown
away, until you empty the Trash. There are three ways to
empty the Trash: (1) Choose Empty Trash, (2) Start up an
application, and (3) Eject the disk.

Windows, and how to use them.

Windows are rectangles on the screen that display information
associated with specific icons. You can have several windows
open at once.

Across the top of a window is the title bar. Grab the title bar to
move a window. In the top left corner is the close box. Click
in the close box to close a window. In the bottom right corner
is the size box. Grab the size box to resize a window.

Down the right side and across the bottom are the scroll bars.
Use the scroll bars to view other parts of your document.

There are three ways to scroll through your documents:

Click on the arrows to scroll a little at a time.
* Grab the scroll box to move anywhere within the document.
* Click in the gray area above or below the scroll box to scroll
window by window.

To select a window, click in any visible portion. There are
four ways to identify the active window:

Its title bar is highlighted
The close box is visible
The size box is visible
It's on top of all other windows.

o o o o

Entering text.

The insertion point indicates where anything you type will be
added. To move the insertion point, position the pointer where
you want the insertion point to be, and click the mouse button.

To select text, position the pointer at one end of the text to be
selected, and hold down the mouse button. Then move the
pointer to the other end of the text to be selected, and release
the mouse button.

To edit text, select the text and type—whatever you type will
replace what was selected. This also works for icon names.

To move text, select it, choose Cut, move the insertion point to
the desired location, and choose Paste.
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Dialog boxes and applications.

Dialog boxes are windows that the Macintosh will periodically
display on the screen. They inform you of the current
situation, and enable you to enter some needed information or
to make a choice between available options. Until you respond
to them with the appropriate action, you can't do anything else.

To run an application, either open the application icon (a hand
on paper) or open a document that was originally created with
that application.

Mouse techniques and other skills.

There are four techniques for using the mouse:

click

press

drag
double-click

¢ e o o

There are two variations:;

* double-click, drag
« Shift-click

To find a lost window, move the other windows that are
covering it. Move the window, resize it, or close it. Or choose
Close All to close all of the windows and then open the one
you want.

An icon shadow is a placeholder for a window. It's an
indication that that icon is open on your desktop. Double-click
on it to make the window the active window.

The Command key enables you to perform many menu
commands from the keyboard. Hold down the Command key
and type the appropriate letter. The letters are indicated on the
right side of open menus.

Working on a Macintosh is like working at your
desk.

Many of the images you see and the techniques you use are
similar to the same activity without a computer. This is part of
what makes Macintosh so easy to learn and use. The
Macintosh environment in which you work is even called the
desktop.
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Copying and moving documents and folders.

» To make a copy of a document on the same disk, select the
document and choose Duplicate.

* To place a copy of a document on another disk, move the
document icon to the other disk's icon.

* To move a document elsewhere on the same disk, move the
icon (this doesn't actually move any information).

* To move a document to another disk, copy the document
and then throw away the original.

The techniques are the same for folders.

Saving your work.

If the document has already been saved, choose Save to save
your changes under the same name (without the Save dialog
box).

Choose Save as to save your work under a different name.

If you're saving a document for the first time or using the
Save as command, you can save the document to either disk
drive. You can even choose to eject a disk to save the
document on a disk that was not in either drive.

Choose Close to close a window but stay in the application.
Use this option if you want to open another document from the
same application. To open another document, choose Open.
When you choose Close, you have the opportunity to either
save or ignore your changes.

Choose Quit to quit an application and return to the Finder.

Again, you have the option of either saving or ignoring your
changes.

Take care of your disks.
+ Keep disks away from extreme heat and direct sunlight.

» Never touch the surface of the disk.
» Keep disks away from magnets.

A disk contains a directory and information.
The directory contains the name, location, and size of all of the

information on the disk, and the size and location of all
available space. The information includes all applications,

APPLE SUPPORT TRAINING LIBRARY



Review 75

documents, startup information, and the operating system.
The directory is first created when you initialize a disk. You
can't use a disk until you initialize it.

Startup disks vs. data disks.

Startup disks contain specific information needed to start the
Macintosh. This takes up a lot of room. Keep some of your
disks as strictly data disks, containing nothing but information
you have created and want to keep. You can only start up your
Macintosh from a startup disk.

To create a startup disk, move the System Folder to any data
disk or new disk.

Locking, backing up, and erasing disks.

Lock disks to prevent accidental loss of stored information. To
lock a disk, slide the red (or sometimes black) tab in the top
right comer of the disk so that you can't see it from the front
side (move it toward the top edge of the disk).

Back up your disks as a precaution in case something happens
to your original disk.

Backing up an entire disk copies the directory and all of the
information. Backing up an individual document backs up
only that document and updates the existing directory (instead
of replacing it).

To back up an entire disk, use the Disk Copy program
(Macintosh 128K with one disk drive) or drag one disk icon
onto the other (Macintosh 512K, Macintosh XL, or Macintosh
128K with two disk drives).

Erase a disk to remove outdated information, so you can reuse
the disk. To erase a disk, choose Erase Disk. Everything on
the disk will be lost, so be sure there's nothing you want to
save. The result is the same as initializing a disk.
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* Macintosh, the owner's manual, Apple Computer, Inc.

* Macintosh publications (The premier issue of Macworld,
February 1984, has an entire section on the Macintosh
desktop. Read Macworld and other Macintosh publications,
such as MACazine, A +, Macintosh Buyer's Guide, and
Macintosh Connection, for up-to-date information about
Macintosh.)

Books
There are dozens of books about the Macintosh. Many of them
are basic product overviews that contain little more than the

manual. But sometimes a new perspective and a different
author can clarify an area that was previously unclear to you.

Here are a few of the product overview books that are
particularly good:

Macintosh! Complete, by Doug Clapp, Softalk Publishing.
The Apple Macintosh Book, by Cary Lu, Microsoft.

Macintosh: The Definitive User’s Guide, by John M.
Allswang, Brady Communications, Inc.

Tips & Techniques for the Macintosh Computer, by Susan
Sutphin, Price-Waterhouse.

MacGuide: The Complete Handbook to the Macintosh, by the
Editors of Microtrend, Inc., New American Library.

Apple Computer does not endorse any of the third-party products or publications mentioned in this module. They are
included only to make you aware of their availability.

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. MacDraw, MacPaint, and MacWrite are
trademarks of Apple Computer, Inc. Macintosh is a trademark of Mclntosh Laboratory, Inc. and is being used with

express permission of its owner.
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2 Overview

B Overview

The information and exercises presented in this module are
designed to acquaint you with the Macintosh™ Finder. Finder
Version 4.1 is highlighted in the first sections, while Finder
Version 1.1g is discussed in later sections. Many of the
differences between the two released versions of the Finder are
noted throughout the text. A chart is provided at the end of the
module to summarize the differences between the two.

This module is intended for use by people who support the

Macintosh computer and Macintosh software applications
published by Apple Computer, Inc.

Prerequisites
Basic knowledge of Macintosh and the Macintosh Finder. This

can be achieved by completing the Apple Support Training
Library module, Learning to Use Macintosh.
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Use the About command in the Apple menu to display the
amount of memory in your system.

Choose the commands in the Choose Printer desk
accessory to print a document.

Use the New Folder option in the File menu to add a
new folder to an active window.

Print a catalog of the files on a disk or in a folder using the
Print Catalog and Page Setup commands.

Choose the commands in the View menu to manipulate
documents and folders.

Install and remove the MiniFinder using the commands in
the Special menu.

Shut Down Macintosh.

Use the MiniFinder commands to open applications,
documents, and disks.

Use other features of the Finder to name icons, drag icons,
and eject disks.
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B Materials

To complete this moduie, you will need:

°

°

A Macintosh 128K, Macintosh 512K, or Macintosh XL
An external disk drive

A startup disk that includes the Finder Version 4.1,
Choose Printer, and the Ima%eWriterTM and/or
ImageWriter 15, and/or Apple™ LaserWriter™ printing
resources with AppleTalk™

A disk containing MacWrite™ Version 4.5, MacPaint™
Version 1.5, and the Font/DA Mover

Two blank disks

If available, the following are recommended:

[ ]

A startup disk that includes the Finder Version 1.1g

Macintosh Update (May 15, 1985), a written update
distributed with the Macintosh System Update disk (It
discusses the Finder Version 4.1 and the Font/DA Mover;
Macintosh Update can be obtained by contacting your
Apple support representative, or by using AppleLink™. If
you use AppleLink, search the "Technical Info Library" for
"Macintosh and Update and July and 1985.")

APPLE SUPPORT TRAINING LIBRARY



Using the Finder Menus

5

Bl Using the Finder Menus

The Five Finder Menus

Knowing these five menus is the key to using

Macintosh.

The Finder menus offer a great deal of power and flexibility.

Knowing how to use their commands will help you use
Macintosh, and will help you to support other users. These
menus are from Version 4.1 of the Finder. They are only
slightly different from the menus in Version 1.1g.

About the Finder...

Choose Printer
Scrapbook
Alarm Clock
Note Pad
Calculator

Key Caps
Control Panel
Puzzle

New Folder 3N
Open
Print
Close

Get Info £
Duplicate 8D

Page Setup
Print Catalog

by lcon

Eject BE

by Name
by Date
by Size
by Kind

Undo ®8Z
Cut #¥H
Copy &C
Paste 8V

Clear
Select All 8A

Special

Clean Up

Empty Trash
Erase Disk

Set Startup

Use MinifFinder...

Shut Down

Show Clipboard
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The Apple Menu

Read the Macintosh Update.

Read the Macintosh Update that was released with the System
Update disk (see the Materials section to locate this document).
It discusses the updates to the Finder, and to the Font/DA
Mover.

Choose "About the Finder."

The Finder 4.1 version of the About the Finder dialog box
has a different look from the Finder 1.1g dialog box—the
Finder 4.1 dialog box is very simple in appearance. Its
function is only slightly changed, however, in that it displays
the memory size of your Macintosh: either 128K, 512K, or
about 900K for the XL (the actual size of the XL memory
depends on which version of MacWorks™ you're using).

The Macintosh™ Finder
Bruce Horn and Steve Capps

128K Version 4.1 ©1985 Apple Computer

APPLE SUPPORT TRAINING LIBRARY
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The File Menu

Using the Finder Menus 7
The Choose Printer desk accessory expands
your printing options.

The Apple menu has been expanded to contain the Choose
Printer option.

Imagewriter {» Port:
LaserWriter (g
ol
® Connected
AppleTalk QO Disconnected
via

When you select this option, a dialog box appears. It allows
you to choose the Printer port, or the Modem port to be used
for printing, and to use any of the printing resources named on
your system. In this example, you could choose the
ImageWriter or the LaserWriter. You could also choose to
connect or disconnect AppleTalk .

For additional information, see the Apple Support Training
Library module, Using the LaserWriter, available from your
Apple support representative.

New Folder, Page Setup, and Print Catalog
are File menu commands.

The File menu contains these new commands: New Folder,
Page Setup, and Print Catalog. Close All and Put

Back are Finder 1.1g commands, but aren't included in
Finder 4.1.

Choose New Folder.

When you open a disk window, you may notice that there isn't
a folder titled "Empty Folder." The folder function has been
replaced by using the File menu command, New Folder.

SUPPORTING THE MACINTOSH FINDER



8 Using the Finder Menus

This command can be chosen either from the File menu, or by
pressing Command-N (see the illustration on page 5 for this
and other Finder 4.1 commands and Command-key
equivalents).

Use the Get Info command to lock a file.

The ability to lock a file hasn't changed. The difference is that
when you lock a file, the icon of a padlock appears in one of
the following locations:

* In the upper left-hand corner of an open window, when
viewing the contents by Icon.

IECI= Fonts Folder

A 1 item 9K in folder 394
w
>

S——
Taliesin Font

<l | )

* Next to the date when viewing the contents in any function
other than by Icon.

Update
Name Size Kind Last Modified

) Frrits Frldsr 9K folder Fri, Jun 21, 1985 ﬁi
D Font/DA Mover 25K application Tue, Apr 9, 1985

D MacPaint 60K application Thu, May 23, 1985

D PageSetMenu 11K MacPaint document Fri, Jun 21, 1985

[ System Folder 145K folder Fri, Jun 21, 1985

) System Update 99K application Tue, Apr 9, 1985

Page Setup and Print Catalog are a pair.

Choose Print Catalog to print out the catalog of an active
disk or folder window. The documents and folders are listed
according to the View menu command chosen, and in the
order of their appearance in the window.

APPLE SUPPORT TRAINING LIBRARY
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Print Catalog uses the Page Setup dialog box to select
various print options, as shown below:

ImagelWriter (Standard or Wide)

[m DR\
Paper: @ US Letter O A4 Letter
Q US Legal O International Fanfold

QO Computer Paper
Orientation: @ Tall QOTall Rdjusted QO Wide
Pagination: @ Normal pages O No breaks between pages
Reduction: @ None QO 50 percent

See the Apple Support Training Library module, ImageWriter
II Basics, for specific details on how to use this dialog box for
printing.

Practice

Print Catalog

Practice printing the catalog using different
View menu commands.

1. Start up with your System Disk.

2. Open the disk icon and choose the by Icon command
from the View menu.

3. Print a catalog of the disk by choosing the appropriate
command from the File menu.

4. After you've used the by Icon command, choose the by
Name command and print the same catalog. Notice that the
print function is formatted to the currently selected View
menu command.

SUPPORTING THE MACINTOSH FINDER



10 Using the Finder Menus

Feedback

Print Catalog

Print Catalog is a useful command.

If you have any questions about how to use this command, or
about how it could be useful to you, ask a colleague, your
Course Manager, or your Apple support representative.

Using the Finder Menus (cont'd)

The Edit Menu

The View Menu

The options in this menu haven't changed.

The commands and the Command-key equivalents have
remained the same. See the Finder 1.1g section at the end of
this module, the Apple Support Training Library module,
Learning to Use Macintosh, or Chapter 4 in Macintosh, the
owner's manual, for more information about the Edit menu.

The View menu is a file-management tool.

Each View menu command has the same file-management

capabilities as the by Icon command. You can create new

folders, place documents in folders, and throw them away.
You can also duplicate documents and folders in any View
menu command.

The practice exercise will demonstrate some of these View
menu functions.

APPLE SUPPORT TRAINING LIBRARY



Using the Finder Menus 11

Practice

Use the View Menu

Select different views at the same time, and
perform the same function in each view.

1.

Start up from your System Disk ( use a backup disk, not
your original copy).

Choose by Name from the View menu.

Choose New Folder from the File menu, or by pressing
Command-N. Notice that an Empty Folder appears in
the by Name list.

While still viewing by Name, drag a document or
application into the Empty Folder.

Open the Empty Folder. Notice that the icon inside is
displayed by Icon (the preset View menu command).
Drag the icon out of the folder, and place it back in the disk

window.

Close the Empty Folder window, and throw away the
Empty Folder from the by Name listing.

Change the view back to by Icon.

SUPPORTING THE MACINTOSH FINDER



12 Using the Finder Menus

Feedback

View Menu Options

The fesults of this exercise demonstrate the
flexibility of the View menu commands.

The System Disk window and the Empty Folder window
should look similar to the windows shown below.

System Disk

Name

I8
[ Font/DA Mover
D) MacPaint

) PageSetMenu

[ System Folder

[ System Update

Size Kind Last Modified
9K folder Fri, Jun 21, 1985
25K application Tue, Apr 9, 1985
60K application Thu, May 23, 1985
EDE Emptg Folder ht document Fri, Jun 21, 1985
1 item 9K in folder 474 Fri, Jun 21, 1985
G ion Tue, Apr 9, 1985
Taliesin Font -{—}—
K] [

The windows you see might be a different size, and the name
of your System Disk might be different. But, as long as you
can use the Empty Folder and the different commands in the
View menu, you're doing fine.

If you need some practice, or have some questions, another

practice session is provided at the end of this module. Your

Apple support representative is always available to answer any

of your questions, so don't hesitate to ask. You can also check
‘with a colleague, or with your course manager.

APPLE SUPPORT TRAINING LIBRARY
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Using the Finder Menus (cont'd)

The Special Menu

The Use MiniFinder and Shut Down commands
are new to this menu.

Clean Up, Empty Trash, Erase Disk, and Set Startup

are the same in the Version 4.1 as in the Version 1.1g. Use
MiniFinder and Shut Down are new. See the section

"More of the Finder 1.1g Menus" at the end of this module for
more about the Special menu.

The Use MiniFinder command gives you a key
to file management.

The Use MiniFinder command allows you to establish
another operating level on your Macintosh desktop. It is used
to move quickly between applications without having to return
to the Finder each time you quit an application. This command
can be used on any disk that has an application on it, not just
on startup disks. This command is explained in detail in the
next section.

Shut Down allows you to change startup disks
quickly.

The Shut Down command is a convenient way to eject the
current startup disk and restart your Macintosh (128K or
512K). Just choose the Shut Down option. When the "?"
icon appears, insert a new startup disk, and begin working
again (see the Apple Support Training Library module,
Fundamentals of the Macintosh Operating System, for more on
the "?" icon).

If you're using a Macintosh XL, the Shut Down command
will eject your disk and turn off the system.

SUPPORTING THE MACINTOSH FINDER



14 Installing the MiniFinder

B Installing the MiniFinder

Overview

Use MiniFinder

Choose Use MiniFinder for faster response
time when moving between applications.

The MiniFinder's faster response time allows you to move into
and out of applications quickly. When it's installed, it allows
you to keep the documents and applications you use most often
at your fingertips. This section provides some practice with the
MiniFinder, and offers some suggestions for its use. The
buttons you see in the screen shot below will be covered in the
next section.

The MiniFinder can be used with any disk, and
acts as an application.

The MiniFinder is an application that resides on your disks. It
provides quick access between applications and specific
documents, significantly increasing the response of the
software. Part of the reason for the increased speed is that the
Finder doesn't have to reconstruct the desktop each time you
quit an application.

Write & Paint
MacPaint Macllrite

Open Other

It can be used on any Macintosh, and can have from 1 to 12
documents or applications installed in it.

APPLE SUPPORT TRAINING LIBRARY



Installing the MiniFinder 15

To install the MiniFinder, open a window.

First, open a disk or a folder window. Use it to group the
application and document icons (folder icons don't work) you
want to install in the MiniFinder for use on this disk.

Be sure that all of the documents and applications you want to
install are selected. Your selection must include one
application.

E[J=== To Be Installed
3 items 139K in folder 261K available
iy
% g
WPEF S
Ka| =

When you choose the option, Use MiniFinder, a dialog box
appears that looks like this:

Io

Install the MinifFinder using the
selected documents or applications,
or remove the MiniFinder.

(lnstall] [Remoue} [Cancel]

Click Install. Once the MiniFinder is installed, a Macintosh
icon titled "MiniFinder" is displayed in the disk window. Open
the icon. When you do, a screen that is similar to the
MiniFinder screen shown on the previous page will appear.

SUPPORTING THE MACINTOSH FINDER



16 Installing the MiniFinder

Other MiniFinder
Commands

The MiniFinder icon is like any other document icon. It can be
opened, duplicated, moved, or thrown away.

You can change the icons in the MiniFinder,
and you can remove it.

The commands in the MiniFinder install dialog box allow you
to change the icons in the MiniFinder (using Install), to
remove the MiniFinder, or to cancel the Use MiniFinder
command.

Click Install to add an icon to, or remove an
icon from, the MiniFinder.

If you want to add an icon to, or remove one from, an installed
MiniFinder, follow the procedure for installation that was
discussed on the previous page:

1. Open a disk or folder window.

2. Select the icons you want to install (use a selection box or
use the Shift-click method of icon selection).

3. Choose Use MiniFinder from the Special menu, and
click Install.

This process will install a new MiniFinder and replace the last
one you installed on that disk.

Deleting a document or application from a disk
doesn't automatically update the MiniFinder.

The MiniFinder is a separate application from the Finder. So,
when you delete a document or application from the Finder,
you must also delete it from the MiniFinder.

If you do delete a document or application from the Finder, and
then try to open it from the MiniFinder, the MiniFinder will
notify you that the document or application you've chosen can't
be found.

You would simply follow the installation process to reinstall
the MiniFinder without the missing document or application.
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Installing the MiniFinder 17

Two other ways to remove the MiniFinder.

In addition to reinstalling the MiniFinder (which removes one
and replaces it with another), you can just throw the current
MiniFinder icon into the Trash. Or you can choose Use
MiniFinder from the Special menu, and click Remove.

A MiniFinder startup disk can save roomon a
disk.

You can create a disk that has a MiniFinder, a System file, and
the icons you want to use, but no Finder:

1. Start up Macintosh with a regular startup disk.

2. Insert the disk you want to use as your MiniFinder startup
disk.

3. Copy the System file and the icon(s) you want to use onto
the disk you just inserted.

4. Select the icon(s) you want to install.
5. Choose Use MiniFinder.

6. When the MiniFinder icon appears, click it, and choose
Set Startup from the Special menu.

7. To use the new disk, choose Shut Down and insert the
MiniFinder startup disk you just created.

8. Macintosh will start up from the MiniFinder screen.

By following this procedure, you will create a startup disk that
has roughly an extra 45K of disk space because it doesn't have
a Finder. You can open any application on the disk from this
screen. If you click Finder, though, you'll get the message,
"Application not found." Just select another application and
continue working.

Change the disk back to a nonstartup (data)
disk.

If you decide you want to remove the MiniFinder, and use the
disk as a nonstartup disk, eject the disk. Restart Macintosh
from a regular startup disk (one that starts up from the Finder).
Insert the MiniFinder startup disk, and throw away the System
file and the MiniFinder icon from that disk. The disk is now a
nonstartup, or data disk.
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18 Installing the MiniFinder

Practice

Install the MiniFinder

Follow these steps to set up the MiniFinder:
1. Open the disk you want to install the MiniFinder on.

2. Place all the icons you want to access from the MiniFinder
into an active disk or folder window and select them.

3. Choose Use MiniFinder from the Special menu.
4. When the dialog box appears, click Install.

5. When the MiniFinder icon appears in the disk window,
double-click on the MiniFinder icon to use the MiniFinder.

Feedback

Install the MiniFinder

The MiniFinder screen should look like the one
in this module.

When you've completed the steps in the practice exercise, you
should see a MiniFinder screen similar to the one described
earlier.

More practice is provided at the end of this module. If you

have any questions, discuss them with a colleague, your course
manager, or your Apple support representative.
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Il Using the MiniFinder Buttons

Overview

Use the MiniFinder buttons to heip you
manage your files.

These buttons offer a convenient, speedy way to access
documents and applications on the current startup disk, or on
any other Macintosh disk. This section discusses how to use
them.

Write 4.5/Paint

1.5 A
Finder )
Open )

Eject |
Drive J
Shut Down )

Use the Finder button to access the desktop.

Click Finder, or press the Enter key to go to the desktop.

The Open button opens a selected document
or application icon.

This button works in the same way as the Open button in the
Document Directory dialog box. Once you've selected the
document or application you want to open, click Open to
"launch" the application, or to open the document.

SUPPORTING THE MACINTOSH FINDER
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Using the MiniFinder Buttons

Open a file from the MiniFinder screen.

Another way to open a document or file from the MiniFinder is
to double-click the icon you want to open. If you've selected a
document, the document will open within its correct
application, whether or not that application is on the disk with
the MiniFinder. If you open an application, it will open to an
"Untitled" document, just as you would expect. You may
begin working at that point, or you may close the document
and open the document of your choice.

If the application that will open the icon you've selected can't
be found on either the internal or external disk, the message

" Application not found" will appear at the bottom of the
MiniFinder screen.

The Open Other button opens a Document
Directory dialog box.

The Open Other button opens a Document Directory dialog
box that lists all of the applications residing on the disk
identified above the buttons. This includes the applications
visible in the MiniFinder window. When you're working with
a two-drive system, click Drive to view the application(s)
available on your other disk.

Select an application from the dialog box.

To select an application from the Document Directory dialog
box, click the application. If you have a list of applications and
would like to select an application that you can't see, scroll
through the directory, or type the name of the application. The
application will appear highlighted in the Document Directory
window.

If you type the name of the application, type fast, or simply
type the first few letters of the name of the application.

To open the application from the dialog box, double-click on
the application name, or select the application and click Open.

Click Eject to eject a disk.

Click the Eject button to eject the disk whose name appears
above the buttons, without having to return to the Finder.

APPLE SUPPORT TRAINING LIBRARY



Using the MiniFinder Buttons 21

Click Drive to select a disk.

Click the Drive button to display the contents of the inactive
drive (if there isn't a second drive, Drive will be dimmed).

If a MiniFinder has been installed on the other disk, that
MiniFinder's screen will be displayed. You will be alerted if
there is no MiniFinder installed on the other disk. In that case,
you can still open an application on that disk by choosing
Open Other.

Click Drive in conjunction with Eject to select files on other
disks. When you click Eject {(using a two-drive system), the
disk in the active drive will eject. If there is a startup disk
remaining in either drive, that disk will function as the current
startup disk.

The Shut Down button ejects your disks and
resets your Macintosh.

If you are using a Macintosh 128K or Macintosh 512K,
choosing Shut Down ejects the disk(s), both internal and
external, and resets Macintosh. A "?" icon should appear,
indicating that the Macintosh is waiting for another startup
disk. See the Apple Support Training Library module,
Fundamentals of the Macintosh Operating System, for more on
the 7" icon.

The Shut Down command, when used on a Macintosh XL,

will eject the disk, and completely power down the Macintosh.
To restart the system press the white On/Off button.
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Bl Other Finder Features

Overview

Other Finder Features

The Finder has several features not included
in the menus or in the MiniFinder.

The Finder Version 4.1 has several features in addition to those
provided by the menus and the MiniFinder.

The Finder has a hard-disk orientation that
facilitates its overall operation.

The Finder Version 4.1 is faster than its predecessor. That's
one reason it's good for managing files on a hard disk. It races
through file-management commands such as Open, Copy,
and Close, and it opens and closes windows quickly. With
this version, handling up to 500 files isn't a problem. Version
1.1g gets bogged down after about 100 files.

Rename your icons.

To rename a disk or folder icon, you must click the icon, even
if it's highlighted. This makes it less likely that a disk or folder
icon will be renamed accidentally. Other icons, such as those
for a new folder, a document that has been moved, or a
duplicated icon, can be renamed—while they're highlighted—
without being clicked. Press Enter after you type the name, to
ensure that you don't accidentally rename the icon.

Some methods for ejecting disks have been
enhanced.

» You can eject unhighlighted disks from both drives by
choosing the command Eject from the File menu, or by
using its Command-key equivalent. This will eject disks
one at a time, beginning with the startup disk.

* You can also eject disks (other than the startup disk) by
moving them to the trash. This will eject the disk, and
remove its icon from the screen.

For other methods of ejecting disks, see the section "More of
the Finder 1.1g Menus."

Drag icons to icon shadows to copy them.

If you move the icon of a document, application, or folder to an
icon shadow of a folder or disk, the Finder will copy the icon
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to that folder or disk. The Finder will place the copied icon in
the first available spot in the disk or folder window.

This method can also be used for copying the contents of one
disk to another disk on a Macintosh 512K, or a Macintosh XL.

(Note: You can't use this to copy over the contents of the
startup disk.)

First level folders are kept during the repair
function.

When you use the repair function (hold down the Option and
Command keys while starting up Macintosh), you lose all of
your folders except for those at the first level. In other words,
you'll lose all of the folders except for the ones that have at
least one document or application residing in them.

When a disk repair is done, the first level of folders will be
renamed as Unnamed #1, Unnamed #2, and so on, as shown
in the example below.

EDE System Disk =
S items 305K in disk 95K available

>
@ O &

Font/DA Mover Unnamed #¥1  MacPaint

e

Unnamed ¥2 Unnamed ¥3

<l [

(5]
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Select a Document

Now That You've
Reached This Point

It's up to you to put the folders in their proper order and to give
them their proper names—Macintosh won't do it for you.

Open a dialog box, and type the characters of
the document you want to open.

Earlier you typed the name of an application to select it from the
Document Directory dialog box. You can do this inside an
application to select a document. When using this feature, be
sure to type the name in quickly and correctly. Macintosh uses
the typing speed you've selected in the Control Panel in the
Apple menu to help you select the desired file.

You can continue with the module, or skip to
the Summary Exercise section.

This completes the information on Finder Version 4.1. The
information in the rest of the module was written to help
support Finder Version 1.1g; some of it is a repeat of
information you've already read. However, it provides
exercises and information that apply to both versions. Reading
it will help you provide support for these two versions of the
Macintosh Finder.
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( Il Using Finder Version 1.1g

Overview

The Finder

The Apple Menu

This section of this support module is optional.

This section provides information and exercises specific to the
Finder Version 1.1g. It also discusses Finder menu commands
that are employed in both of these versions of the Finder.

The Finder manages your Macintosh
documents and applications.

The Finder is an application that's always available on the
desktop; in fact, it is often synonymous with the desktop. You
use it to manage documents and applications, and to access
disks.

This application and its menus are your keys to working
efficiently with Macintosh. Whether you're a Macintosh user,
or you support other Macintosh users, you should be familiar
with all of the functions of the Finder.

Use the About function and the desk
accessories to help you support Macintosh.

You can use the Apple menu to:

» Find out which version of the Finder you're using. (One of
the first questions a support representative will ask is,
"What version of the Finder (or software) are you using?")

 Find out which version of the software you're using. You
must know this to be able to answer questions about its
capabilities and limitations, such as the number of pages a
particular version of MacWrite can accommodate.

« Use the desk accessories. Desk accessories contain
information and resources such as a Clock, Note Pad, and
Scrapbook that can help you become more productive with
your Macintosh.
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26 Using Finder Version 1.1g

"About the Finder..."

Information about the Finder is available by
choosing the "About..." command.

~ About the Finder....

Choose Printer
Alarm Clock
Scrapbook
Note Pad
Calculator

Key Caps
Control Panel
Puzzie

When you start up Macintosh, choose About the Finder
from the Apple menu. It provides information about the
version of the Finder that you're using. The example shown
here is of Finder Version 1.1g, which was authored by Bruce
Horn and Steve Capps.

The Macintosh™ Findﬂer

tharzion 119 S92 f'«pﬁl-:- Cornputsr : Eiruce Hon ared Stews Capps

Different versions of the Finder have been
released.

Different versions of the Finder are available. Check with your

Apple support representative for the latest version, and update
your files to that version.
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Other information The Apple menu contains information about
"About..." the application currently open on the desktop.

WSS Encore Systems
|

MacWrite, the Macintosh Word Processor

written by Randy Wigginton, Ed Ruder, and
Daon Breuner of cncore Systems.

Version 4.5, April 4, 1985.
Document occupies 213K on disk,
with 74K remaining. Saving the
document may change these values.
© 1985 Encore Systems
© 1985 Apple Computer Inc.

As shown above, choosing About MacWrite from the
Apple menu while using MacWrite will produce a display of
the following information:

* The version of MacWrite you are using.

» The amount of disk space occupied by the document
currently on the desktop.

» The amount of space remaining on the disk.

(Remember, it's important to know the software version in
use, particularly if a problem occurs.)

Other applications, such as MacProject™, use the " About..."
command to supply you with introductory information or help
notes regarding the use of that application.

All Macintosh applications from Apple use the Apple menu
command, About... to display information about the version
of software that's being used. This isn't necessarily done by
other developers of Macintosh applications, so consult the
documentation accompanying your software for the specific
use of this command.
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Practice

Use "About..." the Finder

"About..." an Application

"About..." a Document

Choose "About..." to get information about the
Finder.

1.

Start up from a MacWrite disk. When the desktop
appears, choose About the Finder from the Apple
menu.

Write down the version of the Finder you're using. Label
your disk with this information after the exercise. It's
useful to have this available if you have any questions
regarding the Finder.

Click the mouse button at any point on the screen to close
the dialog box and return to the desktop.

Choose "About..." to get information about an
application.

1.

3.

Open MacWrite and choose About MacWrite from the
Apple menu.

Write down the version of MacWrite you're using. It will
be useful to have this available if you have any questions
regarding MacWrite. Be sure to label your disk with this
information.

Close the dialog box and return to the desktop.

Choose "About..." to get information about a
document.

1.

Start up from a MaéProject disk. Open a MacProject
document and choose About MacProject from the

Apple menu.

Write down the version of MacProject you're using.

Read the other information contained in About
MacProject.

Close the dialog box return to the desktop.
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Feedback

Use "About..." Remember this about "About..."

Knowing the version of your software can be your key to
answering many questions about it. When you call an Apple
support representative, the first question you'll be asked is,
"What software version are you using?"

Always note the software version on the disk label for quick
reference. If you have any questions about this, talk to a
colleague, ask your course manager, or call your Apple support
representative.

Using Finder 1.1g (cont'd)

Desk Accessories The desk accessories can save you time, and
serve as a valuable resource.

About the Finder...

Choose Printer
Alarm Clock
Scrapbook
Note Pad
Caiculator

Key Caps
Control Panel
Puzzle

As you can see from the Apple menu shown above, the
Macintosh desktop comes with many of the desk accessories
that you'd find on your own actual desktop.
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Several Apple desk accessories can be on the
desktop at once.

Scrapbook

3:39:35 PM

Il

Calculator

Control Panel

As you can see here, all of the desk accessories except
Choose Printer are on the desktop. This makes them
convenient to use while working in most applications. There
are a few applications, such as MacPaint, that require you to
close the desk accessories before you can work on any
documents.

Try using some of these accessories. In particular, experiment
with the elements on the Control Panel. These are explained in
detail in Chapter 4 of Macintosh, the owner's manual.

You can cut and paste between Macintosh applications and
three Apple desk accessories: the Scrapbook, Note Pad, and
Calculator. For example, if you're editing a report in MacWrite
and notice that a few of the accounting numbers don't seem to
add up properly, you can open the Calculator, do the addition
again, copy the correct sum from the Calculator, and insert it
into your text—all without leaving the MacWrite document.

To practice using Choose Printer, see the LaserWriter
owner's manual or the Macintosh Office Quick Reference
Guides.

(Note: A Desk Accessory Mover is part of the system update

released with the Finder Version 4.1. It can be used like the
Font Mover to add or delete desk accessories.)
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Also, software is available from third-party developers that will
allow you to manipulate your desk accessories, adding to or
subtracting from them. A calendar, desktop text editor, and
data communications application are some of the options
available. Check recent issues of Macworld, The Macintosh
Buyer’s Guide, and other major computer publications for
more information about the latest software available.

A convenient application of the Note Pad and
Calculator.

For those who need to run and rerun the same calculations, the
Calculator can be used as a programmable calculator. (You
could try this now, but there's a practice exercise on the next
page that covers this.)

1. Open the Note Pad and the Calculator.

2. Type a formula on the Note Pad (for example, 9*8-12/24)
and choose Copy.

3. Open the Calculator and choose Paste.
4. The Calculator outputs the answer.

5. For successive calculations, just repaste the formula into
the Calculator.

How to use multiple Note Pads.

If you find that the Note Pad has too few pages, you can use
the following procedure to create additional pads:

1. When the Note Pad's eight pages are filled up, rename its
icon (stored in the System Folder) to something like
Notel.

2. A new pad is created the next time you choose Note Pad
from the Apple menu.

3. If you need to look at something in the original pad,
change the name of the second Note Pad to "Note2", or
"Other Note," and rename the first Note Pad icon with the
original name, "Note Pad File."

4. You can continue to create storage files for notes until the
disk is full.
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As you have seen, the Apple menu provides excellent
resources for saving notes and checking numbers you want to
include in a document. Think of these Apple menu resources
as you would the note pad and calculator you normally keep at
your fingertips.

Don't try to use the Puzzle for anything other
than entertainment.

If you try to use the Puzzle to cut or copy from, the results will
be less than fruitful. The Puzzle is there to provide a break
from your real work. Similarly, the Control Panel isn't a
source of illustrations or text. It's there to help you get the
most from your desktop environment. For more information
on the Control Panel, see the Apple Support Training Library
module, Learning to Use Macintosh.

Use the Scrapbook and the Note Pad.

You could fill an entire disk with illustrations and notes in the
Scrapbook or the Note Pad. The only limit is the size of the
disk. But remember, there are only 400K bytes of information
available on a disk. So, if you need a lot of room on a disk for
text or for data-base files, you might want to keep the
Scrapbook and Note Pad clear of all but really important
illustrations or truly brilliant ideas.

Print the Note Pad pefiodically, and back up the Scrapbook to

an archive disk. Then you won't overload working disks with
these files.
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Practice

The Note Pad

The Calculator

Use a MacWrite document and the Note Pad.

1.

SO

Start up from a MacWrite disk, and open a MacWrite
document.

Choose Note Pad from the Apple menu, and type a few
lines of text.

Select the text you have just typed, and copy it.

Close the Note Pad.

Paste the text onto the MacWrite.documcnt.

Once you've completed steps 1 through 5, try the same

procedure with other desk accessories, such as the
Calculator.

Use the Note Pad and the Calculator.

1.

Start up from any startup disk that has the Calculator and
Note Pad. From the desktop, or within any application,
open the Note Pad.

Type the formula, 9*8-12/24. Don't add any spaces or
punctuation.

Select the formula, and choose Copy.
Open the Calculator.

Choose Paste, to paste the formula onto the Calculator
(watch the Calculator keys when you do this).

Try this same exercise with another set of numbers such
as, 52384/6548*4*2+8*7/12. Type the numbers and the
functions onto the Note Pad the same way you would enter
them into the Calculator.
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Feedback

The Calculator and
Note Pad

The Apple menu provides additional
resources.

The answer to the first practice calculation is 2.5, and the
answer to the final calculation is 42. The operation can also be
performed using MacWrite instead of the Note Pad.

If you have any questions, ask your course manager, a
colleague who is familiar with the Macintosh, or your Apple
support representative.
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Bl More of the Finder 1.1g Menus

Overview This section reviews the File, Edit, View, and
Special menus.

In this section, you'll read more about the options and
commands in each menu. You'll learn to use the
Command-key equivalents as an alternative to using the
pull-down menus. The Enter key can also be used as a
shortcut.

Command-Key These equivalents can be used as shortcuts in
Equivalents place of the pull-down menus and the mouse.

You'll learn the Command-key equivalents for some of the
Finder commands. As you practice, you'll find that there are
times when the mouse is easier to use than the Command-key
equivalents to choose commands, and times when the opposite
is true. A combination of these is often best.

As you develop these techniques, you'll find the combinations
that are fastest and most comfortable for you. During this part
of the module, experiment with the different techniques
available.
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The File Menu.

The Command Key

The File menu has many useful commands.

& BA[8 Fdit Diew Special
2 D p e n OOVOLOOLOLOIT O OOLLORTOON00L
Duplicate %D
L GetiInfo 1
Put Back
Close
Close Rl
Printv
Eject BE

All of the commands in the File menu help you manage your
documents, applications, and folders. For example, Open will
open any selected icon.

For more information about the File menu, review the "Finder
Menus" section in Chapter 4 of Macintosh, the owner's
manual. '

Use the Command-key equivalents as
shortcuts to the menu commands..

One way to access some of the commands in many menus is to
hold down the Command key and type the letter that
corresponds to that command ("Command-key equivalents").
This way, you can select these commands from the keyboard
without having to open the menu.

Duplicate, Get Info, and Eject all have Command-key
equivalents. To duplicate an icon, hold down the Command
key and and type D (often shown simply as, Command-D).
To get information about a specific icon, select that icon and
press Command-I. And, to eject a highlighted disk, press
Command-E.

The Command key (also called the Apple key on the Macintosh

XL, and the feature key or function key on the Macintosh) is
the key just to the left of the space bar.
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The Enter Key The Enter key can be used to respond to
dialog boxes.

The Enter key can be used as a shortcut to save a trip from the
keyboard to the mouse. Most often, using the mouse to click
command buttons is the quickest way to respond to a dialog
box. However, there are times when pressing the Enter key is
faster. For example, the Enter key will mean "OK" or "Yes"
when a dialog box contains a "Do you want to continue”
message. Also, if a specific button is highlighted, pressing
Enter will initiate that action, as shown below:

Save changes before closing?
[__ves ]

In this example, pressing Enter will save the document and
then close it.
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Practice

Use the Command Key

Try using the Command-key equivalents, and
the Enter key.

Start up from a MacWrite disk.

Open the disk icon and select the MacWrite icon (be careful
not to open the application).

Press Command-I (Get Info).

Note the information avaﬂable in the information window.
Close the information window.

Select the MacWrite icon again.

Press Command-D (Duplicate).

A duplicate file, called "Copy of MacWrite," will appear.

Press Command-I to Get Info on "Copy of MacWrite."

. Choose Close from the File menu to close the "Copy of

MacWrite" information window.

. Throw away the "Copy of MacWrite" icon.

. A dialog box will appear, asking you if you really want to

throw away this application. Instead of clicking OK,
press the Enter key to respond.

fAire you sure you want to remove the
application "Copy of Macllrite"?

( ok ) (cancel)

13.
14.

Choose Close All to close all of the open windows.

Select the MacWrite disk icon, and press Command-E to
eject the MacWrite disk.
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Feedback

Using the Command Keys

These keys are listed in the menus for your
convenience.

As you can see, using the Command-key equivalents and the
Enter key can be useful and fast.

Don't worry about knowing all of these keys. They're all
listed in the pull-down menus next to the command they
initiate. You'll become more familiar with their use as you
progress through the Macintosh modules.

If you have any questions, be sure to discuss them with a

colleague, your course manager, or your Apple support
representative.
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More of the Finder 1.1g Menus (cont'd)

The Edit Menu

The Edit menu has several Command-key
equivalents.

& File BX[® View Special

Undo ®Z %

HRODORRORRORRDORNRD

Cut ®BH —
Copy - &#C
Paste )
Clear

Select RIl %A

Show Clipboard

The Edit menu uses more Command-key equivalents than any
of the other Finder menus. Practice these commands using
both the mouse and the Command-key equivalents. This
practice exercise will demonstrate how even basic processes for
managing and naming documents can be done faster using the
Command-key equivalents.
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Practice

The Edit Menu

Use the Edit menu on the desktop.

1.

2
3.
4

10.

11.
12.

13.

Start up from a MacWrite disk.
Open the MacWrite disk icon.
Choose Show Clipboard from the Edit menu.

Be sure that you can see all of the icons in the MacWrite
startup disk window. :

Check the Clipboard window. Be sure it's open enough
for you to see at least a few words of text, and that it isn't
overlapping the MacWrite disk window (you'll want to
watch all of your work as it appears on the screen).

Select the MacWrite application icon.

Press Command-C (Copy). Notice that the title,
"MacWrite," is all that appears in the Clipboard window.
Copy copies only the name of the icon, not the entire file.
Try this again, but this time, select the System Folder.
Press Command-X (Cut). The text "MacWrite" has
been replaced with "System Folder," and the System
Folder title has been removed from under its icon.

To replace the icon name, press Command-V (Paste).
"System Folder" becomes the icon name, and it
("System Folder") remains on the Clipboard.

(Note: The text on the Clipboard can't be selected.)

Activate the MacWrite disk window. Press Command-A
(Select All). All of the icons are selected.

Click the mouse button once on the desktop or in the
window to deselect the icons.

Close the MacWrite disk icon window and press
Command-E (Eject).
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Feedback

The Edit Menu

Use the Command key to invoke Edit menu
commands.

If you have any questions about this exercise, ask your course
manager, consult a colleague, or ask your Apple support
representative.

More of the Finder 1.1g Menus (cont'd)

The View Menu

Catalog or Directory

This menu displays the ways you can view a
catalog or directory of your files.

€ File Edit QUM Special
by Icon

= by Name |—

by Date |——

by Size

by Kind

[}

Use the View menu to display document and
folder information by the categories listed.

By using the commands available in the View menu, it's easy
to find the latest version of a document you've created. Or, if
you've forgotten which document had all the latest information
added to it, you can check the size of the documents, and select
the largest.

The information is displayed in a format similar
to those used by other operating systems.

In the View menu, the information displayed is similar to that
which is provided when you type the "catalog" or "directory”
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commands at the opening prompt in other operating systems
such as ProDOS®, MS-DOS, PC DOS, or CP/M.

So, if you're acquainted with these other systems, and would
like to see what you would consider a "typical" directory of
files, you can select the option that most closely resembles that
of the system you're familiar with.

View commands display specific information.

You can read a lot about a file by using the commands in the
View menu. For example, if you view the contents of a
window using the by Name command (see example below),
you'll see the size, name, and kind of document or folder, and
the date it was last modified, displayed in alphabetical order by
name. This same information is displayed when you use the
other View menu commands (except by Icon), but it appears
in a different order.

E0) Special Write
Size Name Kind Last Modified
60K MacPaint application Wed, Aug 22, 1984 {3
SSK MacVYrite application Mon, Sep 24, 1984
g; 7K Sample Memo Mac¥rite document Thu, Jan 10, 1985
223K System Folder folder Fri, Mar 22, 1985
20K Test Folder folder Fri,Mar 22, 1985 |—
<a] | e

Most Finder commands are available to you
when using any viewing method.

In Finder Version 1.1g, when you're displaying the contents
of a window by name, date, size, or kind, you have access to
many of the same commands as when you're using the by
Icon command.

In Version 4.1 of the Finder, all of the desktop operations are
available in any view.
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Viewing by Icon

Viewing in Several Ways

By lcon offers more Finder commands.

[E[[=———== special Write ==V——=|
8 items 369K in disk 30K available

& "

System Folder MacPaint MacWrite Empty Folder

test print Sample Memo Test 1

|2[<a]

&

The by Icon command allows you to do more than the View
menu commands just mentioned. You can move documents
and folders, name them and rename them, throw them away, or
arrange them in any order on your desktop.

You can view the contents of each disk or
folder window using any of the methods.

Hard Disk
Name Size Kind Last Modified
i System Folder 2011K folder Fri, Mar 22, 1985
[ Applications [E[] System Folder E=———"bs5
(O SelfPaced | 12 jtems 2011K in folder 5398K available P85
[0 CBA Module 7 D85S
[ AppleLinks D85
3 MultiPIn — — — — 5
D) Screen2 System Finder Note Pad File Scrapbook File tes
[ Screen0 E 5 85
E = o= =
LaserWriter Imagewriter Laser Prep Clipboard File N
& =[]

In the example shown above, the Hard Disk window is being
viewed by Size, and the System Folder is being viewed by
Icon.
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The Special Menu The options in the Special menu provide tools
for effective file management.

&€ File Edit View EBIIIEG]

Clean Up
Empty Trash
Erase Disk
Set Startup

Clean Up lets you organize your desktop.

This command will move icons to the closest open space in a
window. Even if the icons are already close to being in a
straight line, the Clean Up command will make that row
neater, as shown below.

Step one: The icons are out of alignment.

e Special Write B
6 items 361K in disk 38K available

System Folder i
y MacPaint

MacYrite

] .

Sample Memo lcon/Name
Test Folder

O
<] [

You may have a disk that is arranged like this. If you choose
Clean Up, your desktop would change to look like the one
shown under Step two.
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Step two: The icons are in a neat arrangement
on your desktop.

[ECI=== special Write =——=
6 items 369K in disk 30K available

— & & |

System Folder MacWrite MacPaint

m "

Sample Memo Test Folder Icon/Name

(=<l

] =

Now all of the icons are neatly arranged. If you keep your
office desktop neat, it follows that you'd like to keep your
Macintosh desktop neat. This is an easy way to do it.

Another benefit of this command is that it may help you find a
"lost" file. The file may just be buried under one or two other
icons, in which case Clean Up may reveal it. Or if you're
moving a disk window from the larger XL screen to the smaller
Macintosh screen, you may seem to have lost an icon or two.
They're probably still there. By choosing Clean Up, you

may be able to find them.

Set Startup lets you start up quickly.

You can use Set Startup to start up Macintosh in a specific
application, such as MacWrite. If you're a writer, you may use
your Macintosh primarily for word processing. To save time,
you can create a MacWrite disk that starts up from the
MacWrite application, without bringing up the desktop.

To create the special startup disk, select the MacWrite icon

that's on the desktop, and choose Set Startup. The next time
you start up from that disk, it will start up in MacWrite.
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You can change the disk back, so it starts up
from the Finder again.

To start up from the Finder again, quit MacWrite. When you
return to the Finder, select the Finder icon and choose Set
Startup. Next time you use that startup disk, you'll start up
from the Finder. To practice this, follow the instructions in the
exercise that starts on the next page.

Use this command to set up a disk that starts
up from an application, and has no Finder.

Can a startup disk have a System file only, and no Finder?
Yes. See the Installing the MiniFinder section in this module.
Using Set Startup works the same with an application as it
does with the Finder, or the MiniFinder. When used without
the Finder, it saves time and disk space, since the Finder
consumes about 45K of disk space.

Additional options are available using the
Finder Version 4.1.

The first sections of this module were written about the Finder
Version 4.1. You'll notice many similarities between it and
Version 1.1g, and several differences. The reference chart at
the end of this module summarizes some of the differences
between the two versions.

If you have any questions about the Finder, talk to a colleague

who is familiar with Macintosh, ask your course manager, or
contact your Apple support representative.
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Practice

Use the Special Menu

Use each of the Finder 1.1g Special menu
commands. '

Choose Clean Up to arrange the documents and folders on
your MacWrite disk.

Throw away any unnecessary documents, or your Empty
Folder, by choosing Empty Trash (if you need another
Empty Folder, use the Finder to create one).

Find a disk you don't need any more, and choose Erase Disk
to erase it.

Choose Set Startup. Follow the steps below to set up a disk
to start up from MacWrite. Then return the startup function to
the Finder.

1.

10.

11.

Insert your MacWrite startup disk, and open the MacWrite
disk icon.

Select the MacWrite application icon, and choose Set
Startup from the Special menu.

Press Enter when you see the dialog box that says, "Are
you sure you want to make MacWrite' the startup
application?"

Close the MacWrite disk window, eject the disk, and turn
off Macintosh.

Turn on Macintosh. Macintosh will start up immediately in
MacWrite with an "Untitled" document on the desktop.

To start up from the Finder again, choose Quit from the
File menu.

Open the System Folder and select the Finder.
Choose Set Startup from the Special menu.

Press Enter when you see the dialog box that says, "Are
you sure you want to make 'Finder' the startup application?"

Close the System Folder, eject the disk, and turn off
Macintosh.

Turn Macintosh on again. The Finder and its menus will
appear on the desktop.
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Feedback

The Special Menu

In this exercise you used all of the Special
menu commands.

If you have any questions about any of the commands in this
exercise, ask a colleague who is familiar with Macintosh, ask
your course manager, or contact your Apple support
representative.
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Bl Summary Exercise

Using Finder Commands Use most of the Finder Version 4.1 commands.

Refer to the module or use any resources you need to complete
this exercise.

1. Use the disk that you set up in the first exercise of this
module.

2. Install a MiniFinder. Use the MacWrite, MacPaint, and at
least one document.

3. Open the MiniFinder, and open (launch) a MacWrite
document. Make a few modifications to the document.
Save the changes, and quit MacWrite.

4. Choose Finder and create a new folder. Place the
MacWrite document you just modified into the empty
folder, and name the folder.

5. Insert another disk into the external disk drive, and open it.
Copy the folder onto the new disk by dragging the folder
icon to the disk icon shadow.

6. Rename the folder that you just copied to the other disk.

7. Rename the disk in the external drive and eject it without
using menu options or the Command key.

8. Reinsert the disk into the external disk drive, and Shut
Down Macintosh.

10. When the "?" icon appears, insert the startup disk with the
MiniFinder into the internal disk while holding down the
Option and Command keys.

11. Rename the folder(s), and lock one of them.

12. Use Choose Printer to verify your printing resource,
then use Page Setup and Print Catalog to print a
catalog of your disk. Use a View menu option other than
by Icon when you print the catalog of your files.

13. Remove the MiniFinder.

14. Shut Down the Macintosh, and turn it off.
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Feedback

Summary Review

This exercise covered most of the Finder 4.1
menu commands.

If you have any questions about any of the functions presented

in this exercise, consult a colleague, ask your course manager,
or contact your Apple support representative.
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I Questions and Answers

Startup Disks

Startup-Disk Icons

Folders

- What is a startup disk?

It's a disk that you can use to start up Macintosh.

What must be on a disk to make it a startup disk?

A startup disk usually has a System Folder on it. However, it
really only needs to have a System file and one application (for
example, the Finder) that has been designated as a startup
application. For an example and an exercise, see the Installing
the MiniFinder section in this module.

1 started Macintosh with my MacWrite startup disk. I quit
MacWrite, and opened MacPaint (it’s also a startup disk) from
the external disk drive. When I quit MacPaint, I noticed that
the two icons had switched positions on the screen. The
MacPaint icon was in the top right corner, and the MacWrite
icon was underneath. What happened?

Macintosh keeps track of the current startup disk by keeping it
in the upper right corner of your screen. In this case, both
disks are startup disks, so Macintosh assumes that MacPaint is
the current one, since it was the last to be used. If you opened
MacWrite again, you'd notice that the two icons would switch
positions again.

I understand that you can select your current startup disk by
opening the Finder on the preferred disk. How is this done?

Press and hold the Option and Command keys while you
double-click on the icon of the Finder you want to start up
from.

What files must be in a System Folder?

None. Macintosh doesn't require a System Folder to operate
properly. Typically, however, you will have a System Folder,
containing a System file, Finder, Note Pad file, Clipboard file,
Scrapbook file, and your printing resources, such as an
ImageWriter file or a LaserWriter file or both.
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‘ I've updated my startup disks with the Finder 4.1. How can I
\ : be sure they're all updated?

First, check the menus to see if they contain any new
commands, such as Shut Down. If they do you're in good
shape. If an Empty Folder keeps appearing when you don't
want it to, even when you keep throwing it away, it's a good
indication that you need to update at least one more disk.

Restart Macintosh XL How can I restart my Macintosh XL without turning it off?

while you press the white On/Off switch.

You can also start up from the internal disk. Press the Option
key while you press the white On/Off switch.

Shut Down Can I use Shut Down even if there aren’t any disks in my
disk drives?

Yes. If you're using a Macintosh 128K or 512K, Shut
Down will restart Macintosh and a "?" icon will appear. Of
course, if you use Shut Down on a Macintosh XL, it will
shut down and turn off.

Standard File I've heard of a Standard file on Macintosh. What is it?

It appears while you are in an application. If you close one
window, and choose Open from the File menu, the dialog
box that appears is called the Standard file. It's often just
called a dialog box. In these modules, it's referred to as the
Document Directory dialog box.
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Increased file-management

MiniFinder to open applications and
documents

Click on icons to name them
Duplicate names in Trash emptied
Move disk icon to Trash to eject
Eject unhighlighted disks

Drag icons to hollow icons to copy

Folders kept during "Repair" function

Type file name to open document or
application

About 500 files

Yes

Yes
Yes
Yes
Yes
Yes
Yes (first-level
folders kept and

renamed)

Yes

Features Version 4.1 |Version 1.1g
Menu Options
Apple Menu
Choose Printer Yes No
File Menu
New Folder Yes No
Get Info Yes (lock feature) Yes
Put Back No Yes
Close All No Yes
Page Setup Yes No
Print Catalog Yes No
‘Edit Menu
No Changes
View Menu
Available Options were expanded Options
expanded
Special Menu
Use MiniFinder Yes No
Shut Down Yes No
Finder Features
Enhanced speed management Yes No

About 100 files

No

No
No
No
No
No

No

No
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I Finder Features Comparison Chart

Each Feature Is
Reviewed

The features listed on the opposite page
compare the Finder Versions 4.1 and 1.1g.

Use the chart on the opposite page to compare some of the
features of the Finder 1.1g that have been enhanced or deleted
in Version 4.1.

The list is a long one, and it will continue to grow as the Finder
is enhanced. Be sure to ask your Apple support representative
for the latest version of the Finder, and for a list of its
enhancements.
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B Review

Using the Finder Menus

Installing the MiniFinder
The MiniFinder Buttons

Other Finder Features

Using Finder
Version 1.1g

More of the Finder 1.1g
Menus

Knowing the Finder menus is fundamental to
using Macintosh.

The Finder menus offer information about the software you are
using, and help control the Macintosh processing environment.
The menus are the keys to managing Macintosh files,
documents, and applications.

The MiniFinder commands provide quick
access to documents and applications.

Click these buttons to move quickly between
disks, documents, and applications.

Finder utility functions are provided on the
desktop to facilitate file management.

The Finder desktop utilities perform vital functions to handle
disks, files, documents, and applications, such as Copy,
Move, Duplicate, and Repair.

This was the first Finder released with
Macintosh, and is still widely used.

The Apple menu provides you with many valuable
commands. You can work with the Calculator, Scrapbook, or
Note Pad, and control a lot of your Macintosh operating
environment—or play with the Puzzle.

Many people still use Version 1.1g of the Finder. Users
should be encouraged to upgrade to the most recent version
that's appropriate for their needs, because it's more powerful
and offers more commands.

The Finder 1.1g File, Edit, View, and Special
menus still provide powerful tools.

Even though there are more recent versions of the Finder,

many commands haven't changed at all. Much of the
information remains the same from a support point of view.
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Il Resources

» Apple Support Training Library modules: Fundamentals of
the Macintosh Operating System, ImageWriter Il Basics,
Learning to Use Macintosh, and Using the LaserWriter.

» AppleLink Technical Info Library (available to Apple
support personnel)

e LaserWriter, the owner's manual
* Macintosh, the owner's manual

e Macintosh 68000 Development System User’s Manual and
Inside Macintosh (included with the Macintosh 68000
Development System), Apple Computer, Inc.

e The Macintosh Buyer's Guide, Redgate Publishing
Company, Vero Beach, Florida 32963

* Macintosh Update (5/15/85), a written update distributed
with the Macintosh System Update disk. Also available on
AppleLink.

e Macworld, PC World Communications, Inc., San
Francisco, CA 94107

Apple, the Apple logo, and ProDOS are registered trademarks of Apple Computer, Inc. AppleLink, AppleTalk,
ImageWriter, LaserWriter, MacPaint, MacProject, MacWorks, and MacWrite are trademarks of Apple Computer, Inc.
Macintosh is a trademark of McIntosh Laboratory, Inc. and is being used with the express permission of its owner. CPIM
is a registered trademark of Digital Research, Inc. MS-DOS is a trademark of Microsoft Corporation.
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Use the Font Mover to copy, move, and remove fonts from the
System file.

The DA (Desk Accessory) Mover

Use the Desk Accessory Mover to copy, move, and remove desk
accessories from the System file.

Using the Original Font Mover

This section discusses the original Font Mover. Complete this
section only if you actively support the product.

Questions and Answers

Review

Resources



2 Overview

l Overview

This module is designed to acquaint you with the Font/DA
Mover. The first section describes the Font/DA Mover and its
features. The second section discusses how to use the
Font/DA Mover to copy, move, and remove fonts from the
System file. The third section details how to copy, move, and
remove desk accessories from the System file.

Included in this module is a brief section on the original Font
Mover. It's provided to help you support that product, and to
demonstrate some of the differences between the original and
current products. Completing the section is optional. Most of
the information in it is also discussed in the first three sections.

This module is intended for use by people who support the
Macintosh™ computer and the software applications for
Macintosh published by Apple Computer, Inc.

Prerequisites

* You should know how to use Macintosh and MacWrite™.
This can be achieved by completing the Guided Tours of
Macintosh and MacWrite, or by reading Chapter 3 in
Macintosh, the owner's manual.

Il Objectives

» Add afont or a desk accessory to the System file on a disk.

» Create more room on a disk by removing fonts and desk
accessories from the System file.

» Create special font and desk accessory files, such as a

"fonts only" or "desk accessory only" file to move and store
groups of fonts and desk accessories.
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I Materials

To complete this module you will need:

¢ A Macintosh 512K (with external disk drive), or a
Macintosh XI. (A Macintosh 128K may be used.
However, a font other than Taliesin 18 must be used during
the practice exercise in the Font Mover section)

» A disk containing these applications:
Font/DA Mover (Version 1.2)

MacWrite (Version 4.5)
MacPaint™ (Version 1.5)

+ A startup disk containing Finder (Version 4.1),
ImageWriter™, ImageWriter 15, and/or Apple®
LaserWriter™ printer resources

* A blank disk

SUPPORTING THE FONT/DA MOVER
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B Overview of the Font/DA Mover

Overview

Managing with the
Font/DA Mover

The Font/DA Mover application is a useful
Macintosh utility.

The Font/DA Mover can be one of your most useful
applications. This section describes its purpose, and provides
an overview of its functions.

Use the Font/DA Mover to manage the fonts
and desk accessories in your System files.

By using the Font/DA Mover, you can tailor your System files
to meet your data-processing needs. The commands within
this application allow you to move the fonts and desk
accessories that you need into the System file on a startup disk.
The Font/DA Mover also lets you move them off the disk to
free up space, maximizing the disk space available for use with
other applications, to create large documents, or to
accommodate printing resources.

Macintosh uses the fonts and desk accessories
in your System file.

» Macintosh uses the fonts in your System file to take the
information that you're typing and put it on the screen, or to
print that information on your ImageWriter or LaserWriter
printer.

» Desk accessories, such as the Calculator, Note Pad, and
Scrapbook, are handy desktop tools, as functional as their
counterparts on your desk. You can use the Control Panel,
another desk accessory, to control some of the Macintosh
processing environment. Then, you can take a break and
use the Puzzle for some recreation.

However, before you can use any fonts or desk accessories,
they must already be in your System file, or else loaded into the
System file using the Font/DA Mover.

(Note: There are some desk accessories that require special
installation software, such as Choose Printer, and some
third-party accessories. Still others have special backup files
that must be copied to your startup disk before they can be
used. Carefully read the instructions that come with these
accessories before you install them.)
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Overview of the Font/DA Mover 5

The Font/DA Mover handles fonts and desk
accessories in the same way.

Operationally, fonts and desk accessories are handled in the
same way. But because of some of the functional differences
between font files and desk accessory files, this module is
divided into three sections: the Overview (this section), the
Font Mover, and the Desk Accessory Mover.

The original version of Font Mover should be
updated to the Font/DA Mover.

You may be familiar with the icon of the Font Mover
application (it's shown below on the left). That original Font

Mover is no longer in use. If you find it, update it to the
Font/DA Mover (the icon shown below on the right).

Applications f

Font Mover Font/DA Mover

(4] (E]

DAFonts DA Accessories

K>

Cormresponding
File Icons

-n
[-]
3
—
@

The original Font Mover could move fonts into a System file.
It could be used to create storage files to archive fonts for
future use, or to remove fonts to create more room on a disk.
The Font/DA Mover can do all of these things with fonts, and
with desk accessories. For more information on the original
Font Mover, see the optional section near the end of this
module.
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Font/DA Mover and
Disk Space

The System File

The Font/DA Mover helps manage disk space.

Fonts and desk accessories are necessary to the operation of
Macintosh. They also take up disk space. One font in your
system can consume from 4K to 14K of disk space. Desk
accessories (such as the ones on your Macintosh system disk)
need from 1K to 8K each. The fonts and the desk accessories
supplied with Macintosh occupy about 160K. That's a lot of
disk space on a startup disk.

The Startup Disk

The System Folder:
Operating
System | System File |
Finder Other Documents
Fonts Clipboard and
Printing Resources Applications
Desk Desk Accessories
Accessories (Scrapbook and
Note Pad)

You can use the Font/DA Mover to add the fonts and desk
accessories that you want to use right away, to remove the ones
that you don't want, and to store the rest on another disk for
use at another time. This helps you to maximize your available
disk space.
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The disk-space management process begins
with the Font/DA Mover window.

When you open the Font/DA Mover, you're opening a window
into your System file. The window is preset to open to the
Font Mover, and to display the fonts in your startup disk's
System file.

l
Click he;:re for Font Mover-©

Click here for DA Mover —&) Desk Accessory  1oVer

Font

Click here for basic instructions-—— Help ]

( open.. ]
L.

) (__Copy ) i
( Remove ]

] ]
[ Quit ] [ Jpen... ]

L.
Click here to open System, Font and DA files ——/

The Operations are the
Same

As the module continues, you'll look closely at each of the
commands available in the application window, and see how
these commands affect the use of fonts and desk accessories.

The same operations are used by both the
Font Mover and the DA Mover.

The Font Mover and DA Mover use the same operations to
manipulate fonts and desk accessories, and to create storage
files. Therefore, the practice exercises in the Font Mover
section can apply to the DA Mover section. If you would like
more practice with the DA Mover after you have completed the
module, use the practice exercises in the Font Mover section
substituting a desk accessory wherever a font is indicated.
You'll see how similar the operations are.
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8 The Font Mover

I The Font Mover

Overview

Copy, Move, and Remove

The Font Mover accesses the fonts in your
System files and in special font files.

In this section, you'll learn how to use the Font Mover to add
more working space to your disk, and how to store fonts for
future use.

Choose the Font Mover section of the Font/DA
Mover.

By selecting the Font Mover, you can move fonts between any
combination of System and storage files.

@ Font
QO Desk RAccessory Mover
Chicago 12 > Cop =
Geneva 9
Geneva 12
Monaco 9

When you open the application, the fonts in the System file of
your startup disk are displayed in the box on the left. Several
fonts are displayed, including the four basic fonts that the
System file requires: Chicago - 12, Geneva - 9, Geneva - 12,
and Monaco - 9. The fonts are used on the screen in menus, in
icon names, and in other places where system- or software-
generated text appears on the screen. These fonts are also
available for your use whenever you need them. Don't try to
remove them, though—the system won't let you.

Copy, move, and remove fonts to maximize
disk space.

Since fonts take up space on a disk, you'll want to remove any
you aren't using, and store them where they can be easily
accessed. Fonts that you use for word processing aren't
necessarily the same as fonts you might want to use for the
overhead slides in a sales presentation. But you still want them
to be accessible.
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Fonts-Only Disks

Print Quality

Use Your Old Font Files

The Font Mover 9

Create a fonts-only disk.

One way to archive fonts is to create a fonts-only disk. Use the
Font Mover to move as many fonts as you can to a specific
disk. (It won't take long to fill a disk with fonts, unless you're
using a hard disk, in which case you can have as many fonts as
you like on your disk.) There are a few limitations: Some
applications can use as many as 15 different fonts, while others
are limited to only a few. To be sure you haven't added too
many fonts, look at the Font menu. If you can see all of your
fonts, great. If not, remove the fonts you don't need until you
can see all of the fonts available in your Font menu.

If you want to create a fonts-only disk, there is
a practice exercise that can help.

There are two practice exercises in the section of this module,
Using the Original Font Mover. Use the second exercise to
create a fonts-only disk.

Standard-resolution print quality requires one
font size; high-resolution output requires two.

If you're using an ImageWriter as your primary printer, you
need to have only one font size for each font to be able to print
in standard print mode. To print text in high-resolution mode
requires a larger font size. For example, with text input using
12-point Geneva, you must have 24-point Geneva for
high-resolution printing. The ImageWriter takes the 24-point
Geneva and shrinks it to produce the higher-quality printed
text.

The Font/DA Mover can use any font file.

You can use the Font/DA Mover to open font files created with
the Font Mover. However, font files created using the
Font/DA Mover aren't compatible with the original Font
Mover.

Though the Font/DA Mover can open original Font Mover
files, it won't upgrade or "convert" them. This means that
Font Mover files that are opened using Font/DA Mover can still
be opened by the original Font Mover.

The best thing to do is to throw away any copies of the old
Font Mover, and upgrade to the Font/DA Mover.
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File Names

Font file names do not have to be changed to
be used by the Font/DA Mover.

The Font/DA Mover can use any font file on a disk, regardless
of its name. This is unlike the situation with files created using
the original Font Mover, in which the name of the file must be
"fonts." If you want to create more than one font-storage file
on the same disk (with the original Font Mover), you must
change the name of the font file to something like "Fonts1".
Only one file per disk can be called "Fonts" and be used by the
Font Mover.

Practice

Use the Font Mover
Portion

Remove a font from the System file on one
disk, and add it to the System file on another.

1. Create a "Font Disk" that contains these files: a System
file, Finder Version 4.1, and the Font/DA Mover.

[ECJ=—— Font Disk =———=
3 items 164K in disk 235K available
i
A}
System Finder Font over 5
<] [

2. Open the Font/DA Mover on your new Font Disk. When
the Font/DA Mover dialog box appears, it should look
similar to the one on the next page.
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The Font Mover 11

® Font
QO Desk Accessory Mover
Chicago 12 Ol [ Copy | oy
Geneva 9
Geneva 12
Monaco 9
Monaco 12
New York 9 »
New York 12 | 5
System
on Font Disk
236K free
( close ) ( auit J: ([ open. )

3. Click Open on the lower right side of the dialog box. This
should open another dialog box that has a directory of the
font files that includes the System file.

_W——T
@® Font

O Desk Accessory Mover
Chicoaa 19 IAL [ £ e 11
6§ |
G§
M| |Taliesin Font | Font Disk
M
N ( New ] i [ Eject )
N 53
— (_Cancel ] i (_ Brive ] A

Cooe ) [ mr )| G

4. Open the Taliesin Font file (if you're using a Macintosh
128K, use a font other than the Taliesin 18).

5. When the document directory disappears, select the

Taliesin 18 font (as you select a font, you'll notice that the
Copy and Remove buttons are highlighted).
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Practice (cont'd)

® Font

QO Desk Accessory Mover

Chicago 12 DRI 1aliesin 18

Geneva 9

Geneva 12

Monaco 9

Monaco 12

New York 9 8074 bytes

New York 12 5| selected

System ;  Taliesin Font
on Font Disk i onFont Disk
236K free 236K free

( cClose ) (it )i [ close )

Taliesin 18: §$_® QEPE:*J’ ‘,C’Q@ Qy

(Note: So far the operation of the software is very similar to
that of the Font Mover. But the similarity ends quickly. Now,
you can use either side of the dialog box for System files, or
for storage files. The options aren't as limited as in the old
Font Mover.)

6. Click Close at the bottom of the screen. The screen
should look almost blank (compared with a moment ago).

7. Click Open on the lower left side of the screen. The
document directory dialog box should appear.

8. When it does, open the Taliesin Font file. The Taliesin 18
font should now be showing in the upper left corner of the
directory window on the left side of the dialog box.

9. Click Open on the lower right side of the screen. When
the dialog box appears, open the System file. The
directory window on the right side should display the fonts
contained in the System file.
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10. Copy the Taliesin 18 font to the System file on the Font
Disk. Notice that two things happen:

» The elevator bar on the right side of the window should
be highlighted. Scroll it down to view all of the fonts.

@ Font

QO Desk Accessory Mover

( >> Copy> ) [Chicage 12
Geneva 9
Geneva 12
Monaco 9
Monaco 12
8074 bgtes New York 9
| selected New York 12
Taliesin Font System
on Font Disk on Font Disk
227K free 227K free
( cClose ] ( auit i [ Close ]

Taliesin 18: §$® M= b ﬁé&@ Y

« The amount of free space on the disk is reduced by
about 9K (as indicated by the number just above the
Close button).

11. Scroll the System file down. You can see that the Taliesin
18 font has been copied to that file.

12. Click Close to close the Taliesin Font file.
13. Click Open.
14. Insert a startup disk in the external disk drive. Use

the Font/DA Mover buttons to open the System file on
the disk in the external drive.
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Practice (cont'd)

Taliesin Font System Update

( New ] i Eject )

( cancel ) i ( Drive )

<]

15. Now, copy the Taliesin 18 font from the System file on the
internal drive to the System file on the external drive.

@® Font
QO Desk Accessory

Chicago 12 r-G— ( << Copy<< ] [Geneva 9
Geneva 9 Geneva 12

Mover

Geneva 12 Monaco 9
Monaco 9 Monaco 12
New York 9 New York 9
New York 12 8074 bytes |New vork 12

5| selected e ~
System System
on System Update on Font Disk
98K free 227K free

Car ) Coome
Taliesin 18: E$_® ﬁEFEﬁJ) ‘é&@ %ﬂ

16. While the Taliesin 18 font is highlighted on the internal
disk, click Remove.
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@ Font
QO Desk Accessory

Mover

Chicago 12 > ( << Copy<< ] [Geneva 9
Geneva 9 Geneva 12
Geneva 12 Monaco 9
Monaco 9 Monaco 12
New York 9 New York 9
New York 12 8074 bytes  |New vork 12
o ERAALL I Taliesin 16 5
System System
on System Update on Font Disk
98K free 227K free
( clese ) [ aquit Ji [ Close )

Taliesin 18: §$® QEE&J‘ ﬁ(f&@ %ﬂ

(Note: By removing the Taliesin 18 font from the
System file, you have increased the amount of available
space on the disk by about 9K.)

17. Your final Font/DA Mover screen should look like the one

on the next page.
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Feedback

Using Font Mover Your final screen should resemble this one:
Font
8 Desk Accessory Mover
Chicago 12 <3| (___Copy ) [Chicago 12 &
Geneva 9 Geneva 9 |
Geneva 12 Geneva 12
Monaco 9 Monaco 9
New York 9 Monaco 12
New York 12 New York 9
Taliesin 18 > New York 12 ~
System System
on System Update on Font Disk
90K free 236K free
)| Ctiose )

L E—

Both System files should be showing. You should have a
copy of the Taliesin 18 font in the external disk, and copies of
the seven fonts in the System file on the Font Disk that you
started out with.

In this practice, you should have been able to move a font
between two System files, remove a font from a System file,
and use the Document Directories in the application dialog box
to help maximize free disk space.

You also practiced moving font files between disks and using
the buttons to manage files on two disks at once. It is also
possible to use the buttons to help cycle a number of disks
through the Font/DA Mover application.

If you need any help, or require further assistance, ask a

colleague, check with your course manager, or contact your
Apple support representative.
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( Il The DA (Desk Accessory) Mover

Overview

G

Desk Accessories

The Desk Accessory Mover is similar to the
Font Mover in function.

The Desk Accessory Mover portion of the Font/DA Mover can
be used to move desk accessory files into and out of System
files.

O Font
@ Desk Accessory

> Copy > ] [Key Caps >
Puzzie

Mover

Alarm Clock
Calculator
Choaose Printer
Control Panel

Desk accessories are accessed through the Apple menu. See
Chapter 4 in Macintosh, the owner's manual, for more on the
desk accessories.

About the Finder...

Choose Printer
Scrapbook
Alarm Clock
Note Pad
Calculator

Key Caps
Control Panel
Puzzle

You can have as many as 15 desk accessories
on a disk.

Although the Apple menu can hold up to 15 desk accessories,
you won't necessarily want to keep all of your desk accessories
in your System file, where they can be accessed from the

Apple menu. Desk accessories, like fonts, take up disk space.
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That space can be used for other things, such as
word-processing documents or high-resolution graphics.

The standard Apple-supported accessories are shown on the
previous page, in the illustration of the Apple menu. These
accessories are supplied with most Apple-supported Macintosh
applications.

Not all of them are necessary to run applications. So, to create
more disk space, you can remove some accessories, or move
them to another disk for storage. Do not, however, remove all
of the accessories from the System file. If you try to, you'll
get a dialog box with the following message:

Piease don't remove ALL of the desk
accessories on that disk! This will destroy
the disk!

In addition, all of the standard Apple desk accessories,
combined, require less than 30K of disk space. The Puzzle,
for example, requires less than 1K, Choose Printer requires
6K, and the Control Panel, which helps control much of the
Macintosh user environment, needs about 8K. You're not
going to gain much space by removing them (but you may need
that extra bit of room some time).

The Scrapbook, Note Pad, and Clipboard are
unusual.

You can throw away the icons for these files. As long as the
Scrapbook and the Note Pad are in the System file, they can
always be used, whether their icons appear or not. The icons
will reappear when you choose them from the Apple menu.
The same is true for the Clipboard icon. It can be thrown
away, but it will reappear when you use Cut or Copy.

Third-party applications use the desk
accessories, and add some of their own.

Third-party vendors use the Apple-supported desk accessories,
and have created many of their own. Some software is written
to run exclusively as desk accessories, serving as
"mini-applications." These mini-applications can provide very
creative solutions to everyday processing needs. You can
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customize your own desktop options by adding some of this
third-party software using the Font/DA Mover.

There is an advantage to running small
applications as desk accessories.

A popular data communications package that's available as
public-domain software is used on the desktop at the same time
you're running an application such as MacWrite. Itisn't as
powerful as MacTerminal™, but you don't have to quit your
application to use it.

Appointment calendars, telephone/address books, and
spreadsheets are a few of the many desk accessory offerings
that are currently available.

Apple supports only the desk accessories it supplies with its
Macintosh system disks.

(Note: Some of these third-party accessories work very well.
Others may not be completely compatible.)

Practice

The DA Mover Use the Desk Accessory Mover to remove a
desk accessory from the System Folder.

1. Use a backup of the System Update disk, or create a
startup disk that contains the Font/DA Mover.

2. Check the startup disk to be sure that the Apple menu has
all of the standard Apple-supported desk accessories (see
page 14 for the list).

3. Open the System Folder on your backup disk. Throw
away the Scrapbook and the Note Pad icons.

(Note: You're only throwing away the icons. If you open
the Apple menu you'll see the Scrapbook and Note Pad
still listed (even if you use Empty Trash). Don't worry,
you'll have a chance to clear them out of the system.)

4. Close the System Folder, and open the Apple menu.

Compare the list of accessories, and notice which
accessories are still there.
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Practice (cont'd)

Try This

10.

11.

12.
13.

14.

Now, open the Font/DA Mover. Notice which part of the
application opens first (Font or DA), and which file opens
first (it should be the System file on the startup disk).

Click the Desk Accessory Mover button. Note the names
of the files that are displayed in the Document Directory
window of the System file, and write down the amount of
space remaining on the disk.

Close the System file on the external disk, and click Open.
Create a new file called "For DAs Only."
Select the Scrapbook and the Note Pad.

(Note: You threw away just the icons in Step 3; you
didn't throw away the files held in the System file itself.
The icons hold information not the actual Scrapbook and
Note Pad files held by the System file.)

Copy the Scrapbook and Note Pad files into the "For DAs
Only" file.

Remove the Scrapbook and Note Pad files from the
System file on the internal disk. When that operation is
complete, note how much space is free on the disk in the
internal drive. It should be about 6K more than the amount
you noted in Step 6.

Click Quit.

When you have returned to the Finder, select the Apple
menu, and notice that the Scrapbook and Note Pad are no
longer there.

Check the System Folder, and notice that the icons aren't
there either. You have succeeded in throwing them away.

Throw away the icons.

To experiment further, try this with another disk:

1.

2.

Throw away the icons of the Scrapbook and Note Pad, and
empty the Trash.

Open the Apple menu, and choose the Scrapbook and
then the Note Pad.
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3. Check the disk window. The icons should appear.

4. Place them back in the System Folder, or else throw them
away.

Use the information in this exercise to back up
your desk accessories.

The other Apple menu desk accessories don't have icons on

the desktop. The only way to access them is through Font/DA
Mover.

Since they can't be copied using icons, use what you've
learned in this practice exercise, and create a "DAs Only" disk
that'll be a backup file for your accessories. Then they'll
always be available when you need them.

Feedback

The DA Mover

More Practice

The Scrapbook and Note Pad don't act like the
other desk accessories.

‘When you threw away the Scrapbook and Note Pad icons,
only the icons were deleted, and not the files. One of the ways
to remove those files completely is to remove them using
Font/DA Mover, as you just did.

Creating a backup DA file.

If you create a backup desk accessory file, you have some
insurance against the unexpected.

To get more practice using the Desk Accessory
Mover, use the Font Mover practice.

As you've seen, the Font Mover and Desk Accessory Mover
are the same operationally. So if you would like more practice
using the DA Mover, use the Font Mover practice exercise, just
substitute desk accessories for the fonts.

If you have any questions, or need some help with this

exercise, ask a colleague, your course manager, or contact your
Apple support representative.
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B Using the Original Font Mover

Overview

The Original Font Mover

Review this section only if you support the
original Font Mover.

This section of the module was written prior to the release of
the Font/DA Mover (Version 1.2). There are people who still
use the original Font Mover, this section was included to help
you support those people.

Much of the information in this section is repeated from the
earlier part of the module. You don't need to complete this part
of the module if you aren't supporting the original Font Mover.

When you're asked about the Font Mover, suggest that the user
upgrade to the latest version of the application.

The Font Mover can be an effective
file-management tool.

Review the section about the Font Mover in Chapter 3 of
Macintosh, the owner's manual, and read the Font Mover "help
notes" contained within the application. The notes are available
when you open Font Mover and select "Help" from the Font
Mover menu.

Use the Font Mover to manage disk space.

One of the advantages of word processing on the Macintosh is
that you can use various fonts, font sizes, and type styles. The
Font Mover and the Fonts file help keep track of the various
fonts that are available, and can help to manage fonts efficiently
on your disks.

Don't use too much of a good thing.

Fonts are maintained in files that average from 4K to 6K in
size; 52 of the most commonly available fonts for the
Macintosh require a total of about 230K of disk space.
However, some fonts can require up to 14K. For example, the
four basic fonts used by the system each require a total of 11K
on a disk. Slightly less than 100 fonts can fill a disk. With all
the various fonts available from Apple and third-party
developers, it's tempting to load your disks with a multitude.
Try to resist this temptation.
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Create a master font disk.

To maximize the amount of space available on your disks for
applications and documents, use Font Mover to create a master
font disk. The fonts on this disk will be available to all of your
other disks through Font Mover. By creating a separate disk to
hold all of your fonts, you are assured of having all the fonts
you need, when you need them.

Fonts reside in the System file or Fonts file.

The System file holds fonts and font sizes you can use with
each application; each System file has its own set of fonts.
You can customize your System files to hold the fonts you use
the most. Fonts can be stored in a Fonts file when they are not
being used by the System file.

Fonts can't be used within an application until
they are moved into the System file.

The only time a font can be used by Macintosh is when that
font has been moved into the System file by Font Mover. Each
application can use a very wide variety of fonts. However, the
actual number of fonts that can be used is limited by the size of
the Font menu within each application.

Font Mover is like a moving van.

Disks are like houses that have rooms (files). The System file
and the Fonts file are like rooms of furniture that store the fonts
for current and future use. Font Mover is a vehicle used for
moving and removing fonts.

The Fonts moving van is used to move furniture (fonts) from a
fonts room in one house (disk) to a fonts room in another
house (disk). The Fonts moving van is unique in that it can
both move furniture from house to house, and also from room
to room within a house.

The furniture can be either stored for future use, or moved into
the System file for immediate use.

Font Mover is simply a vehicle to move fonts from one disk

file to another, and from a Fonts file on a disk to the System
file and back again.
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Some fonts are reserved for system use.

Chicago-12, Geneva-9, Geneva-12, and Monaco-9 are the four
fonts reserved for system use. You see them displayed on the
screen in menus, icon names, and other places where system-

or software-generated text appears on the screen. These fonts

can't be removed from the System file.

Font Mover
in System file in Fonts file
*Chicago-12 O | Help ) )
*Geneva-9
*Geneva-12
*Monaco- 9
ol (it ) D]

Name:

Point size:

Disk Space:

* reserved for system use

Basic fonts, the System file, the Finder, and
the Font Mover require about 130K.

To create a master font startup disk, start with the basic file
configuration shown below. You need to have the System

file, Finder, and Font Mover on the disk. Those three files and

the four basic fonts (shown above) take up about 130K.

=[J=—— Basic Fonts =——|
3 items 130K in disk 270K availa

System Finder Font Mover  N»

<] [
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The disk used in the illustration below has 52 fonts and uses
about 200K for fonts only. It has the 4 fonts needed by the
system, and 48 other fonts from Apple and third-party
developers.

E[I=——= 52 Fonts
3 items 334K in disk 65K availab]
s
)
£ J &
System Finder  Font Mover L
K] ==

Fonts can crowd a disk.

As you can see, 52 fonts plus the System file, the Font Mover,
and the Finder, nearly fill a disk. Below is an example of a
disk that has no System file or Finder, just 52 fonts and the
Font Mover—yet more than half the disk is full.

|

[ECJE For Fonts Only
2 items 228K in disk 172K

Y

Fonts (52) Font Mover

O
& [

Create a fonts-only disk.

To create a fonts-only disk, simply use Font Mover to copy as
many fonts as you have into one Fonts file. After you have
done this, move the Fonts file and Font Mover onto a disk that
contains no other files. There is a practice exercise at the end
of this section to help you do this.
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Print Quality

(Note: If you are working on a Macintosh XL, you can load
up the disk with all the fonts you think you will be using on a
regular basis. Remember, though, the more files you have on
your hard disk, the more the Finder has to work to keep track
of them.)

How many fonts do you need on a disk?

The best MacWrite startup disk is one that has the smallest
number of fonts on it, thus providing the maximum available
space for your documents. Using Font Mover, you can create
a MacWrite disk that contains only those fonts and resources
you will need for a particular document or set of documents.

To do this, you need to determine what font and font sizes you
plan to use, and then decide on the type of printing:
ImageWriter (standard or high-resolution), LaserWriter, or
another printer such as a daisy wheel printer. Making these
decisions and selecting your fonts ahead of time will help
minimize the number of "Disk full" messages you'll get.

Standard resolution print quality requires one
point size.

Most of this document was created using Helvetica™ 12-point
font. That font had to be available to the application from the
startup disk's System file. No other font (except the required
system fonts) was needed on this disk to create it or to print it
in standard-resolution print on an ImageWriter.
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High-resolution print quality requires two point
sizes.

High-resolution printing uses the point size that is twice the
size you see on the screen, and compresses it to produce
higher-quality printed letters. For example, to print
high-resolution 12-point Geneva output, 24-point Geneva must
be available.

Font Mover

in System file in Fonts file

Cairo-18 | (__Help ) [ Geneva-12 5]
*Chicago-12 Geneva-24
*Geneva- 9

Geneva-10
*Geneva-12

Geneva-18

Geneva-20 I Quit ) >

Name:

Point size:

Disk Space:

* reserved for system use

Once a font is no longer needed on a disk, remove it.
Otherwise you'll be wasting disk space.

Practice

Disk Space

How much room do fonts consume?

1. Turn on your Macintosh and insert your MacWrite
application disk.

2. Do not use your original MacWrite disk for this exercise.
Back it up onto a "clean" disk (either initialize, erase, or
copy over a disk). Label your new disk, and set aside
your original MacWrite disk.
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Practice (cont'd)

3. Be sure there's a Font Mover file on the MacWrite disk
you've just created. If there isn't, find a disk that has Font
Mover on it and move it to your new backup MacWrite
disk.

4. You should now have a new startup disk with MacWrite
and Font Mover on it.

5. Turn off your Macintosh and start it up from your new
MacWrite startup disk.

Open the disk window.
Write down the amount of space on your disk.

Open the Font Mover.

A S

Count the number of fonts in the System file. In the
example on the previous page, there are about eight fonts
available (only seven are showing).

10. Follow the directions in Chapter 3 of Macintosh, the
owner's manual. Use Font Mover to remove all of the
fonts except those required by the System file. Remove
any fonts in the Fonts file, also.

11. Choose Quit from the Font Mover menu.

12. Once you're back to the desktop, write down the amount
of space you now have on your disk. You should have
more space now as a result of removing the fonts from

your disk. You also now have a MacWrite disk that isn't
cluttered with unnecessary fonts.
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Create a fonts-only disk using Font Mover.

(Note: This exercise is for use with the original version of
Font Mover, not the Font/DA Mover.)

1.
2.

10.

11.

Get a recycled or erased disk (an initialized disk).

Insert the disk into your external drive and name it "Fonts
Only."

Copy Font Mover onto the disk.

Open Font Mover, select all of the fonts in the System fiie
and copy them to the Fonts file. If there isn't a Fonts file
on your disk, Font Mover will create a new one.

Choose Quit from the Font Mover menu.

Since your new MacWrite startup disk has so few fonts (in
the previous exercise we removed all of the fonts except
the ones required by the System file), you'll need to get
your Macintosh system disk. This will have several more
fonts on it.

Eject the MacWrite disk. Turn off Macintosh. Insert the
System disk and turn on Macintosh.

Open Font Mover on your fonts-only disk.

You'll see that there are more fonts available to you. Select
all of the fonts you want to move.

(Note: If you try to copy fonts from the System file to the
Fonts file, and they are already there, a dialog box will
appear and state which fonts are already present. Click
OK, or press Enter to continue.)

Continue the process of copying fonts from other System
files until you either fill the disk or have as many fonts on
the fonts-only disk as you feel you might use (be sure to
save space for some of the exotic fonts such as Cairo and
Symbol font—they're fun to use).

Eject the fonts-only disk and label it. Store it where it's
safe and easily accessible.
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Feedback

Fonts-Only Disk

If You Have a Question

Using a fonts-only disk saves disk space and
time.

Now that you have a fonts-only disk, you don't need to worry
about removing fonts from different disks to free up more
space for documents. All of your fonts are on one disk. Since
you don't have to hunt through several disks to find them,
you'll save time.

Use the fonts-only Fonts file to supply the System file with the
fonts you need for a particular document or application. To use
it open the Font Mover on the fonts-only disk.

If you had any trouble with this exercise, ask
questions.

Your course manager, a colleague, or your Apple support

representative will help you with any questions you might have
about the Font Mover.
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I Questions and Answers

Font Mover

Select Multiple Fonts

MacDraw Fonts

Desk Accessories

I tried copying the Taliesin 18 font with my Macintosh 128K.
All I got was a Finder error. How can I copy this font? It has
a few characters on it I would like to use.

Due to a system enhancement, you can't use the Font/DA
Mover (Version 1.2) to copy the Taliesin 18 font on your
Macintosh 128K.

How do I select multiple fonts (to copy, or to remove)?
There are two methods:

+ If you're selecting multiple fonts that follow each other in
succession in the directory window, click the first font, and
drag to the last font you want to select.

« Shift-click, as if you were selecting documents or files.

(Note: These same methods apply to selecting desk
accessories.)

I installed a few more fonts in my System file, but now when I
open MacDraw™ [ can't use some of the fonts. In fact they
don't even appear in the Font menu. How can I correct this?

To correct this, you must:

1. Copy the font(s) you want to use from the System file.
2. Remove the font(s) from the System file.
3. Then copy the font(s) back into the System file.

This will change their position in the Font menu and allow you
to access them.

For example, you want to use the Taliesin font. Since you've
just installed the LaserWriter fonts, the Taliesin font no longer
appears in your MacDraw Font menu. To change its order in
the Font menu, you must follow the steps shown above.

Are all desk accessories compatible all the time?
All Apple desk accessories are compatible with all Apple

applications. This isn't necessarily true for all third-party
applications.
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New System File

New Accessories

When I installed a new System file, I lost a lot of my desk
accessories. What happened? .

When you replaced your System file with another System file,
all of the desk accessories and fonts in the new file replaced the
old ones. Always back up your files, including your System
files so that you have copies of your desk accessories. If you
have to replace a special System file, it's always easier to do
from a backup file.

I tried to install a desk accessory using the installation disk
supplied with the application. All I got were errors, and now
my System file doesn’t work at all. What should I do?

Start up Macintosh from another startup disk. Replace the
damaged System file with the one on the current startup disk
(use your backup System file in place of the damaged file).

The error you encountered could have been because there
wasn't enough room on the disk for the new desk accessory.
Some desk accessories can require up to 35K of disk space.
Use the Font/DA Mover to free some space on the disk, and try
the operation again. If you are still unsuccessful, call your
support representative for that application.

I used the Font/DA Mover to install a desk accessory, but it
doesn’t work. Why?

There could be several reasons. A common situation with
third-party desk accessories is that they require backup files on
the disk. For example, one popular calendar program uses a
document in the System Folder to hold its text files. If that
backup file isn't present, the desk accessory won't work

properly.

Check the installation disk for a file or a document other than
the desk accessory file. Copy that file or document onto the
startup disk, and try the desk accessory again. If that doesn't
work, read through the instructions again; if you still have a
problem, call the support representative for that product.
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B Review

Overview of the Font/DA
Mover

Font Mover

DA (Desk Accessory)
Mover

Using the Original Font
Mover

The Font/Da Mover is one application that can
manage two types of files.

The features of this application allow you a great deal of
flexibility. The functions of fonts and desk accessories are
different, but this application handles both of them to create a
specialized and personalized processing environment.

Font Mover moves, removes, and copies fonts
for use and for storage.

Font Mover has been enhanced to include the ability to move
fonts between several files of different names, including the
System file. You can create your own Font files, and name
them anything you wish.

Font Mover is used primarily to save disk space; however, its
use also saves a lot of time. You don't have to look far to find
your favorite fonts, and since you are managing your disk
space, you don't have as many "Disk full” messages.

Operationally it's the same as the Font Mover.

The greatest advantage of this application is its ability to move
desk accessories into and out of the System file (the same way

" you can move Font files).

You can remove desk accessories from a disk to create more
space for truly great documents, and fascinating illustrations.
Any desk accessories that you remove can be stored for future
use. "

This section is a review of the original Font
Mover application.

The original application is still used by many people.

However, users should be encouraged to upgrade to the
Font/DA Mover.
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I Resources

»  AppleLink™ Technichal Info Library, (available to Apple
support personnel from Apple Computer, Inc.)

*  Macintosh, the owner's manual

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. AppleLink, ImageWriter, LaserWriter,
MacDraw, MacPaint, MacTerminal, and MacWrite are trademarks of Apple Computer, Inc. Macintosh is a trademark of
Mclntosh Laboratory, Inc. and is being used with the express permission of its owner. Helvetica is a trademark of the
Allied Corporation and is used by Apple under license.
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2 Objectives, Materials
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Folders can define a file structure or file hierarchy.
15 LockanIcon
The Get Info information window can be used to lock an icon,
and to make notes about the information in that icon.
18  The Document Directory Dialog Box
Learn more of the uses of the Document Directory and the Save
As dialog boxes.
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Il Overview

This module is an overview of techniques you can use to
manage Macintosh™ computer documents, applications, and
files. It discusses how to use dialog boxes and other
Macintosh desktop features to organize your documents and
folders.

This module is designed for everyone who uses Macintosh or
who supports other users.

Prerequisites.

 Before beginning this module you must know how to use
Macintosh, the Macintosh Finder, Font/DA Mover, and
MacWrite™. To achieve this level of knowledge, complete
the Apple Support Training Library modules, Supporting
the Macintosh Finder, Supporting the Font/DA Mover, and
their prerequisites.



2 Objectives

B Objectives

Define what's meant by a Macintosh file, document, and
application.

Define the difference between a startup disk and a data
(nonstartup) disk.

Use folders, and describe why they help to define file
structure.

Use the Finder to effectively manage the system and
minimize disk swapping.

Lock an icon. Describe what that does, and use other
information window features to help keep track of the
information in your documents and files.

Open, name, and save documents to the current startup
disk, or to another disk, using the Document Directory
dialog box.

Use the Document Directory dialog box to cut and paste
information within an application.

B Materials

To complete this module, you will need:

.

[

A Macintosh 128K, a Macintosh 512K, or a Macintosh XL,

An external disk drive

Macintosh, the owner's manual

A startup disk that includes the Finder Version 4.1, the
Font/DA Mover, and MacWrite
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B Folders and File Structure

Overview

Files, Documents, and
Applications

Macintosh uses foiders to help you organize
your files, documents, and applications.

The Macintosh Finder uses a flat file structure with 400K disk
drives and the Macintosh XL. It uses a hierarchical file
structure with other Macintosh disk drives, such as the Hard
Disk 20.

This section discusses how to use folders to organize your
files, documents, and applications within a flat file structure. It
tells how a flat file structure differs from a hierarchical file
structure.

Organize files, documents, and applications in
folders on disks.

Macintosh has three designations for icons (files): System files,
working documents, and applications.

» System files are normally found in the System Folder.
They typically include the System file, Finder, printer
resource files (such as the ImageWriter™), Scrapbook file,
Note Pad file, and the Clipboard file.

* Working documents can be MacWrite word-processing
documents, MacPaint™ graphics documents, or any other
working file created by an application. Often they are
referred to as data documents, or data files.

o Applications are the programs used to create documents.
MacWrite and MacPaint are examples of applications.

During this module, the term "file," as in "file-management,”
will be used generically.

For more information on these designations, see the Disks,

Documents, and Folders section in the Apple Support Training
Library module, Learning to Use Macintosh.
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4 Folders and File Structure

Macintosh and File

Structure

Macintosh uses a flat file structure rather than
a hierarchical file structure.

All Macintosh disk files (except those using the HFS Finder)
are maintained at one level on the disk directory in a flat file
structure. That means that Macintosh looks at all of the files on
the directory at one time.

Some operating systems, such as ProDOS®, MS-DOS, PC
DOS, and CP/M, have a hierarchical filing system. The object
of hierarchical file structure is to group files in a logical order
within a directory and subdirectories on a disk.

Directories and subdirectories are used to
access files.

When a disk (or volume) is first formatted, it gets a name and a
directory. Anything you save on that volume is accessed
through its directory. The directory is a file that keeps track of
where other files on the disk are stored. You could say that a
directory file is like an address book.

Directory

Subdirectories
and Files

Files

| Your Directory |

| Spreadsheets| | Financial

tem

| Forecast| | Memos |

| EOM |

[ Incentives | | System| | Printer |

At some point, you'll want to organize your files (especially if
you're using a hard disk) so you won't have to shuffle through
your financial reports to get to your incentive plan. To do this,
you'll need to establish a "hierarchical" file structure.

In the example shown above, the file structure starts with a
directory file named "Your Directory." It has subdirectories
titled "'Spreadsheets" and "Ops System." The subdirectories
contain the documents "EOM" and "Incentives," in addition to
the System and Printer files. Financial, Forecast, and Memos
are files (or documents), not subdirectories.
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So, "Your Directory" knows the addresses for Spreadsheets,
Financial, Forecast, Memos, and Ops System. '"Spreadsheets"
knows where to find the EOM and Incentives documents.
"Ops System" knows the location of the System and Printer
files. This kind of arrangement is called a hierarchical file
structure because files are organized into successive levels.

Folders create the illusion of a hierarchy.

Structure
Folders were developed to allow Macintosh icons (files) to
appear in a hierarchical display on the screen.
By placing one or more icons and/or folders into another
folder, Macintosh icons can be grouped logically. The System
Folder, shown below in a screen shot (from a Macintosh XL)),
is like the Ops System subdirectory in the previous example.
The files you see (System, Finder, Note Pad File, and so on),
are organized in the System Folder (subdirectory), just as
System and Printer were found in the Ops System
subdirectory.
Hard Disk
Name Size Kind Last Modified
S0 ey Fodder 1720K folder Tue, Mar 26, 19XX
(3 Applications =[] System Foldler S=—————|
(3 SelfPaced  ['45 stems 1720K in folder 5341K available
[ Game file 7N
[ Co Info . |
O AppleLink
0O MultiPIn System Finder Note Pad File Scrapbook File Calndr File
=
=] — =" = = |
LaserWriter ImageWriter Laser Prep Clipboard File Special Ace %

<]

RE

The directories, subdirectories, and files (folders and
documents) are displayed as icons that can themselves be
placed within icons of folders. You can create multiple levels
of folders, similar to a hierarchical structure with directories
and subdirectories, by putting folders within folders.
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Practice

Create a Series of
Folders

Use folders to organize your files, documents
and applications.

1.
2.

Choose New Folder, and name it "The Directory."

Open The Directory and put all of the documents and
folders on your MacWrite disk in it (don't include the
applications).

Choose New Folder and name the empty folder
"Applications."

Place all of your applications, such as MacWrite, in that
folder, and place it inside The Directory.

Create another folder named "MacWrite Docs," and place
all of your MacWrite documents in it. Place that folder in
The Directory.

Stop here, or continue to add new folders until you've
arranged all of your icons (files, documents, and
applications) in folders.
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Feedback

Folder Review

Organize your files, documents, and

applications by using folders.

At the beginning of the exercise, your desktop may have
shown icons of many files, documents, applications, and

folders, similar to the screen shot below.

[T

[[==———————= Write Disk

12 items 352K in disk

48K available

&

System Files MacWrite Staff Meeting

&

Meeting Memo MacPaint Equipment

= b

Font/DA Mover Memo Pic Screen 1

&l

No matter how many icons you started with, your final screen
should look similar to the screen shot below.

=[J== Write Disk ==
4 jtems 352K in disk 48K avail
. O

System Files  Applications

P

MacYrite Docs MacPaint Does

& |

I2[<A]
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Open each folder. Your organization should look like this.

Irite Disk

2 items 352K in disk 48K available

The Directory

3 items 191K in folder 48K available
MaclUrit¢=C]===— Applications Socs
| i 3 items 143K in folder 48K available
3 items 9K in fold; = der 48K available

@ 8 @l L

Meeting Memo Equ| Mac¥rite MacPaint Font)DA Mover 6
|

Step 3

«l =

The folders on the Write Disk form a hierarchy.

The folders shown above, when illustrated as a hierarchy, have

the structure shown below.
Write Disk
Dirctory
Subdirectories : T
and Files I Mac Write Docs] I Applications J IOther Docs ]
Files [ MacWriteJ fMacPaint i I Font/DA Mover I

Discuss the use of folders with a colleague, your course
manager, or your Apple support representative. Since
everyone has a different method, ask these people how they
use folders. Do they organize documents by date, by subject,
or by project? Choose a method that works for you.
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Folders and File Structure (cont'd)

Managing Files on a Disk

System Folders and
Startup Disks

Disk Swapping on a
Two-Drive System

Review your icons and their organization
regularly.

As you can see, the effective use of folders to organize your
files, documents, and applications is very important. It is even
more critical if you're using a hard disk for storage. You
should monitor all of your icons regularly. Since documents
on your disks can become outdated very quickly, it's helpful to
review them once a month and remove any that are unneeded.
The fewer icons the Finder has to manage, the faster it will
perform its functions.

The Finder can, however, keep track of a large number of
icons. Version 1.1g, for example, can keep track of over 100
files, documents, and applications. Newer versions of the
Finder can manage increasingly larger numbers of icons
quickly and efficiently. For example, Version 4.1 manages up
to 500 icons.

Keep track of your startup disks.

Most startup disks have a System Folder that contains a System
file and a Finder. Nonstartup disks, or data disks, don't
contain the System file or Finder. They therefore have more
room for applications and documents. For more information
on startup vs. nonstartup disks, see the Installing the
MiniFinder section of the Supporting the Macintosh Finder
module.

Disk swapping might be necessary even with a
multidrive system.

A frequent complaint is as follows: "I tried to copy a document
onto this disk, and the system keeps prompting me to swap
disks. Ithought that since I have a second disk drive I
wouldn't have to swap disks again.”

If you copy your internal startup disk to your external disk by

moving the icon (disk copy on the 512K), you usually won't
have to swap disks.
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1o

Completely replace contents of "External
Disk B" (external drive) with contents of
"Internal Disk A" (internal drive)?

[ ok ] (cancel)

However, if you're copying a disk other than your startup disk
to your external disk, the Finder will ask you to swap disks.

Completely replace contents of "Another
Disk C" (not in any drive) with contents of
"Internal Disk A" (internal drive)?

[ ok ) (cancel)

A Startup Disk in Each
Drive

The startup disk uses its Finder to keep track
of your disks during the copy sequence.

When you start up a disk, its Finder keeps track of your files.
If you start up your two-drive Macintosh with a startup disk in
each drive (insert them both before you turn it on), the
Macintosh will use the Finder and System files in the internal
drive to keep track of the files on both disks.

Macintosh will default to the System file and
Finder on the application disk.

As soon as you start up from an application that's on the
external disk drive, Macintosh will use the Finder and System
file on that disk instead of those on the original startup disk.
Until you change it, the startup disk is now the one located in
the external drive. '
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The Macintosh XL's icons reflect any changes.

One of the easiest ways to see this change in startup disks
occur is by using a Macintosh XL.. When the Macintosh is
started up and the desktop appears, the icon in the upper right
corner of the screen is usually the hard-disk icon.

PR

In

Insert a startup disk that has an application on it—for example,
a MacWrite or MacPaint startup disk. Open the icon for that
disk and double-click on an application icon in the disk
window.

Once the application's "Untitled" document appears on the
screen, quit the application. As you return to the desktop, the
internal-disk icon will appear in the upper right corner.

&€ File Edit View Special

The hard-disk icon will appear below the internal-disk icon for
the smaller disk. Sometimes (depending on the version of the
System file you're using) the hard disk may have the 3.5-inch
icon image.
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Documents use the startup disk applications.

If you open a document from the second disk, and that
document's application is on the first disk, the first disk will
remain the current startup disk (even if the application is also
on the second disk)—see example, below.

€ File Edit View

.V Internal Dis

kA

Special

[E External Disk B

2 items 293K in disk 106K af

3 items 248K in disk 151K a

i

System Folder MacWrite

oS

Other File Management
Hints

4}

System Folder MacVWrite

Make the second disk in a two-drive system
the startup disk.

Another way to change the startup disk in a two-drive system
with two startup disks is to:

1. Open the System Folder on the disk that isn't the current
startup disk.

2. Double-click on the Finder icon while holding down the
Command and Option keys.

This is handy if you want to keep one disk as your startup
disk, and change either disk quickly, without restarting
Macintosh.

Maximum number of windows open on the
desktop.

Generally, you can have up to seven windows open on your
desktop at one time. This allows for easy visual file
management, and offers flexibility in moving files from one
folder or disk to another.

MANAGING MACINTOSH FILES
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Folders and File Structure

But be careful: Trying to open more than seven windows at
once will bring up a dialog box that will warn you not to open
any more. You won't lose any files, however. Just click OK
and close a few windows before you continue.

Restart a Macintosh XL without turning it off.

Beginning with MacWorks™ Version 3.0, you can restart your
Macintosh XL, or change your startup disk from the hard disk
to the internal disk, without turning the system off.

» Torestart the Macintosh XL, hold down the Command key
while you press the white On/Off switch. You will restart
the Macintosh XL from the hard disk, and return to the
desktop.

¢ To restart the Macintosh XL from the internal disk drive,
hold down the Option and Command keys while you press
the white On/Off switch. You'll restart from the disk in the
internal drive. If you have neglected to insert a startup disk
in the internal dirve, a "?" icon will appear until you do
insert one.

Additional techniques are available.

Other helpful techniques are available from resources such as
Macworld and other Macintosh publications. Also, see the
Apple Support Training Library modules that cover each
application.
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I Lock an Icon

Overview

Lock an icon to help you keep track of what's
in it, and to protect information.

People often assume that when a document, application, folder,
or disk is locked, it's completely protected. This isn't always
true. This section discusses locking, and describes the handy
information box that helps you keep track of what's in a locked
icon.

Lock an icon to keep it from being renamed or
thrown away.

To lock an icon, choose Get Info from the File menu.

New Folder &N
Open
Print
Close

Duplicate €D

Page Setup
Print Catalog

Eject 36E

When you do, a window such as the one on the next page will
appear. Read the note at the bottom of the window.
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E[J==————= Information about Macllrite EFFcF0F—

Maclrite
Kind: application

Size: 69814 bytes, accounts for 73K on disk
Where: Hard Disk, AppleBus

Created: Wednesday, February 27, 1985 at 4:58 PM
Modified: Wednesday, February 27, 1985 at 4:58 PM

X Locked

IWhat can be done to a locked icon, anyway?
Anything...
Except change its name or throw it away.

You can cut, copy, and paste to and from a locked icon, just as
you would with any other file. Some operating systems have
"write protect" or "read only" functions available that won't
allow a specific file or document to be edited. A locked
document, System file, application, or folder isn't a "write
protect” or "read only" icon—it can be changed.

But you can't change the name of a locked icon, and you can't
throw it away. You can remove an icon from a locked folder,
but you can't put it back without unlocking the folder.

If you want to lock a document so that parts of it can't be

removed or destroyed, you must lock (or "write protect') the
disk that the document is on.
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Use the Get Info window for notes about icons.

When you lock an icon, be sure to use the box that's provided
for notes. You can use it to record brief notes about the
contents of the icon, or to explain why you've locked it. That
way you never have to leave the Finder to know what you've
put in a document. For example, see the notes on the
Switcher™ document below.

E[J=————— Information about WPOf =ie0—=—
WPEF II%!I
Kind: Switcher document
Size: 156 bytes, accounts for 4K on disk

IWWhere:  Hard Disk, Internal Hard Disk
Created: Friday, September 6, 1985 at 9:10 AM
Modified: Friday, September 6, 1985 at 9:10 AM

[JLocked
Finder 128K Save Screen — Off

Macllrite 512K Save Screen — Off
MacPaint 128K Save Screen — 0n

If you use the Switcher regularly and have several Switcher
documents, the names of the documents can't tell you very
much. But, you can use the box to record notes that tell you
about the applications you've installed, the options you've
selected, and the amount of space allocated for each.
Otherwise, you must open the document and watch Switcher
install it to find out what it contains.

For more information about how to use Get Info, see
Chapters 1 and 4 in Macintosh, the owner's manual, or see the
Apple Support Training Library module, Learning to Use
Macintosh.
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18 The Document Directory Dialog Box

Il The Document Directory Dialog Box

Overview

The Document Directory dialog box resides
inside each application.

A convenient way of managing documents within an
application is by using the Document Directory dialog box.

Close Rk
Save
Save fis...

Page Setup...
Print...
Quit

The Document Directory dialog box appears
on the screen when you choose Open.

When a document is closed and you choose Open, a dialog
box similar to the one shown below will appear. The
documents shown on the left side of this dialog box are
MacWrite documents that are available on the disk titled
"Write."

(Document Directory ) (Disk Nam’e)

fipple 32 Oper... )

Equipment Write
Meeting Invite

( cancel ],[ Drive ]

<
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Sometimes the Document Directory dialog box
is referred to as the Standard File.

Occasionally you'll hear the term "Standard File." This is a
technical reference to the Document Directory dialog box.

The Document Directory and Save As dialog
boxes are available in most applications.

Within most applications, there's a Save As dialog box that
appears the first time you save an "Untitled" document, or
when Save As is chosen from the File menu.

There are two ways to save an entire document or text from the
Save As dialog box. The first way is to type in the name of the
file and click-Save. The document will be saved to the disk
displayed in the upper right corner of the dialog box. If you
want to display the documents that are on the other drive, click
Drive, and you'll see the name of the other disk appear, along
with the display of its documents.

The colon in the document name box can be
used to save files.

Another way to save a document to a specific disk is to type the
name of the disk you want to save the document to, followed
by a colon (:) and the name that you want to use for that
document, as shown in the example below.

Save Current Document As Write

Write Data Disk:Document

@ Entire Document QO Texrt Only

Macintosh, the owner's manual, states that you can use any
character on the keyboard except the colon when naming a
document. This is because the colon is used by the Macintosh
to separate the name of the disk from the name of the individual
documents on that disk. If you use this command, be sure the
icon name appears exactly as it's spelled.
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Save Time When Saving
Documents

Other buttons extend your Save As options.

In the example above, you can see the Entire Document and
Text Only commands. These commands change with
different applications. Also, some Save As dialog boxes have
a different look. See the manual for each application for the
specific meaning of each of the options available.

Save files by choosing either Close or Quit.

An easy way to save time is to choose Close or Quit from the
File menu before choosing Save from the File menu. This
reduces the number of keystrokes it takes to Save and Close a
document.

When you choose Close or Quit after making changes to a
document, and before you choose Save, you'll get the
following dialog box:

Save changes before quitting?
[__ves |

Click Yes to save your changes. Click No to close or quit
without saving the changes (the document will revert to the
previously saved version). Click Cancel to ignore the Quit or
Close command you just issued, and to return to the current
document.

Although this method isn't recommended, it can be used

occasionally. It's also a "safety net" in case you forget to save
your work.
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Practice

Document Directory and
Save As

Use the Document Directory and Save As
dialog boxes as file-management tools.

In this exercise, you'll use the functions of the Document
Directory and Save As dialog boxes to:

* Open, name, and eject disks.

* Copy and paste within an application using multiple disks.

+ Save documents to disks using a colon () in the
document-name field.

Open a disk, name it, and eject it.
1. Start up your Macintosh from a MacWrite startup disk.

Insert a blank, initialized disk into your external disk drive.

Name the disk in the external drive "Write Data Disk."

A owo

Eject the disk in the external drive (remove its shadow,
t00).

Copy data from a document on one disk, and
paste it into a document on another disk.

1. Insert a disk that has a MacWrite document on it into the
external drive.

2. Open the disk icon and the icon of the MacWrite document.

3. Select a few lines of text, and copy them to your
Clipboard.

4. Click on the close box, to close the document.

5. Choose Open from the File menu. Be sure the disk name
displayed in the Document Directory dialog box
corresponds to the disk that's in the external disk drive. If
not, click Drive to change the disk.

6. Eject the disk in the external drive by choosing Eject from
the Document Directory dialog box. Then insert the Write
Data Disk.

7. Choose Cancel and open a new MacWrite document by
choosing New from the File menu.
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Practice (cont'd)

10.

11.

12.

13.

14.

Paste the contents of the Clipboard into the new "Untitled"
document, and choose Save from the File menu.

When the dialog box appears, type Document 1 as the
name of the document, and press Enter to continue.

When "Document 1" appears in the title bar on the screen,
choose Save As from the File menu.

After the dialog box appears, click on Drive. The name of
the 1é'lisk in the internal drive will appear as your current
disk.

Type Write Data Disk:Document 2.

(Note: Part of the name will disappear from the screen,
but once the new copy of the document is loaded, the name
oflthg disk and the new document name will appear in the
title bar.)

Save Write Data Disk:Document 2 by pressing Enter to
continue.

Close the document you just saved, and choose Open
from the File menu. When the Document Directory dialog
box appears, you'll notice that the current disk is your
MacWrite applications disk.

Verify that all the documents have been saved
to the proper disks before you Quit.

1.

Click Drive. The current disk will change to the Write
Data Disk where you saved the Document 1 and
Document 2 files.

Double-click the Document 1 title to open it. Don't click
Open.

Close Document 1 and return to the Document Directory
dialog box by choosing Open from the File menu.

Choose Eject from the dialog box to eject the Write Data
Disk. '

Choose Cancel from the dialog box and Quit from the
File menu to return to the desktop.
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Feedback
Document Directory Using the Document Directory dialog box to
Dialog Box manage files.

When you choose Open from the File menu, this dialog box
appears on your screen:

Apple 32 Oper... {7

Equipment Write
Meeting Invite
-

( cancel ] : ( Drive ]

|

You can double-click to open a document.

To open files from this dialog box, you can highlight the
document name and choose Open from the menu...

Equipment | Upeni ] Write
Meeting Invite

( cancel ] i ( Drive )

<a
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Feedback (cont'd)

...or you can double-click on the document name.

fipple 32 Oper... &
BQue Write

Equipment

Meeting Invite

(_cancel ] i ([ Drive )

<

You can eject disks using the Document
Directory dialog box.

Use the Document Directory dialog box menu as you'd use the
File menu. Eject is an example of a Finder command that
works well within an application to help manage files on
various disks. While in an application, you can look at the files
on different disks and load the documents from each disk
without continually returning to the Finder.

Apple 32 Oper... &
Equipment Write

Meeting Invite
| Eject )

( Cancel ] | ( Drive )

<

il
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Select the disk drive.

Selecting the drive and juggling disks from the Document
Directory dialog box can be a shortcut to saving documents,
copying files, and ejecting disks while remaining in an
application. For some Copy and Save routines that involve
more than one disk, some disk swapping may be involved.

25

Apple 32 Oper... ik
Equipment
Meeting Invite

Write

( Drive k]

<]
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B Review

Folders and File Structure

Lock an Icon

The Document Directory
Dialog Box

Use folders to create your own hierarchical
filing system.

You can structure your Macintosh files, documents, and
applications for easy access by using folders like you'd use
folders in your desk to store documents.

Locking an icon keeps you from renaming it or
throwing it away unintentionally.

Use Get Info to lock an icon. When you do, be sure to
record informational notes about that icon. That way, you
won't have to open the document to find out what's in it.

The Document Directory dialog box is used to
manage documents.

Use the Document Directory dialog box within an application to
avoid going to the Finder when you want either to save, copy,

.or name documents, or to eject disks.

Use the Save As command to rename documents, or to name
them and save them to the current startup disk or to another
disk.
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B Resources

» Apple Support Training Library modules: Learning to Use
Macintosh, Supporting the Font/DA Mover, Supporting the
Macintosh Finder.

» AppleLink™ Technical Info Library (available to Apple
support personnel)

* Macintosh, the owner's manual

*  Macintosh 68000 Deveiopment System User's Manual and
Inside Macintosh (included with the Macintosh 68000
Development System), Apple Computer, Inc.

e Macworld, PC World Communications, Inc., San
Francisco, CA 94107

Apple, the Apple logo, and ProDOS are registered trademarks of Apple Computer, Inc. AppleLink, ImageWriter,
MacPaint, MacWorks, MacWrite, and Switcher are trademarks of Apple Computer, Inc. Macintosh is a trademark of
MeclIntosh Laboratory, Inc. and is being used with the express permission of its owner. CP/M is a registered trademark of
Digital Research, Inc. MS-DOS is a trademark of Microsoft Corporation.
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Fundamentals of the Macintosh
Operating System

[l Contents

Overview, Objectives

Materials

An Overview of Macintosh ROM

Explains the two levels of Macintosh ROM, the operating system
and the user interface.

13 Macintosh Drivers and the Elements of ROM

How Macintosh uses drivers in ROM and in the software to

control peripheral devices and desk accessories.
19  Macintosh Startup Icons

What the "Happy Macintosh,” "Sad Macintosh," " Question icon,”
and "X icon" indicate.

23 Reference Chart for Startup Icons
A handy aid that shows the message conveyed by each icon, and the
correct response to the situation, if one is necessary.

24  How to Handle "Disk Full" Messages
"Disk full” messages are a common occurrence. This section
suggests some ways you can avoid them.

28  How to Repair a Crashed Disk
Techniques that are commonly used to try to open a crashed disk,

or document.
33 Review
34  Resources
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2 Overview

" Overview

Some of the support questions you'll frequently be asked
require a knowledge of the Macintosh™ computer operating
system, and its utilities. This module discusses the
fundamentals of the operating system and the user interface
contained in Macintosh ROM. It provides some solutions and
suggestions on how to use the Macintosh system utilities to
recover lost documents and to avoid many disk full messages.

Who should complete this module? Anyone who hasn't taken
the Macintosh technical training course and who supports
people who use Macintosh.

Prerequisites

* The material presented in this module assumes that you have
read Macintosh (the owner's manual), and have a working
knowledge of Macintosh.

Il Objectives

+ Identify the elements of the Macintosh operating system and
user interface. Explain how they work together to form the
Macintosh operating environment.

» Describe how the elements of ROM work with the disk
operating system to drive printers and other peripheral
devices.

¢ Describe what a "Happy Macintosh" indicates.

+ Describe what a "Sad Macintosh" indicates, and recommend
a response.

+ Identify the "Question" and "X" icons, state what they
indicate, and state how to respond.

» Demonstrate how to handle a "Disk full" message or a
message that indicates there's not enough room on the
disk to print a document.

» Detail various ways to repair a crashed disk.
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Il Materials

To complete this module, you will need:

* A Macintosh 128K or a Macintosh 512K with an external
disk drive, or a Macintosh XL

» A system disk that includes Finder Version 4.1

If available, the following is recommended:

* A crashed disk and/or a disk with a '"lost" file
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'@ An Overview of Macintosh ROM

Overview

One Basic Similarity

Macintosh ROM contains the elements of the
operating system and the user interface.

Programmed into the Macintosh ROM (read-only memory) is

the heart of what makes Macintosh work, the operating system
and the user interface.

The user interface forms a buffer between the
operating system and the Macintosh user.

Macintosh is dynamic and different because a buffer called the
user interface has been placed over the operating system.

Macintosh ROM

User Interface

Operating System

The user interface has been placed over the operating system to
act as a "shell." This frees users from having to deal with the
operating system directly allowing them to concentrate on
productivity instead of on coping with the many different file
commands (slashes, spaces, and colons) that are common to
most other operating systems.

The operating system is a traffic cop.

Even though it includes the user interface, the Macintosh
operating system is basically the same as other microcomputer
operating systems. It's the traffic cop of the computer. It tells
information that's being fed into it where to go, and tells the
other parts of the computer what to do with it. The user
interface masks almost all of these operations from the user.
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The Big Question

First Consideration

Second Consideration

An Overview of Macintosh ROM 5

How do you access the Macintosh operating
system?

This question can be posed in several ways, such as, "I want to
get into the operating system to write a simple program. How
can I do this?" Other frequent questions are those regarding
recovering lost data, or accessing system utilities. Many
people are simply curious, or use operating systems that don't
have a user interface similar to that of the Macintosh. A few
others are interested in developing major applications for
Macintosh.

Macintosh Pascal, and several other programming languages
are available to write programs to run on Macintosh. To write
major applications in the Macintosh development environment,
there are two considerations about Macintosh and the
Macintosh operating environment that must be understood.

Macintosh is designed to be easy to learn and
to use.

Macintosh was designed for people who want to set up their
computers and begin working with a minimum of instruction.

The operating system is protected by the user
interface.

To accomplish this desired ease of learning and use, the
designers of Macintosh placed the shell called the user interface
over the operating system. Nearly everything that happens
between the Macintosh user and Macintosh goes through this
shell.

The television is an example of a simplified
user interface.

If it's working properly, a television will carry information into
your home with very little effort on your part. You can use it
with very little information about how it works, switching from
program to program, without any effort. But dispite this ease
of use, the television, like Macintosh, is a very sophisticated
machine.

There are few advanced television users (no matter how many

hours they watch it). There aren't many advanced Macintosh
users either, and that's just the point.
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Consistent Commands

Developing Macintosh
Applications

Alan Kay, Apple Fellow, once summed up the net effect of the
user interface to a group from Apple Technical Support with
the following words:

"...The Macintosh user interface is a very simple design. It
was designed so that the average user could be familiar with
how to use it within 20 minutes. To become an intermediate
user doesn't take much longer.... This has some trade-offs in
that there's no room for the advanced user...."

However, an applications developer may be considered one
example of an advanced Macintosh user. One way to become
an advanced Macintosh user is to learn to use the applications
development tools.

Even if you don't plan to become a developer, there's a lot to
be learned about Macintosh to help you support it. But the
simplified user interface also simplifies the amount of
information you need to know, and makes your job as a
technical support person much easier.

Some commands are the same in almost all
Macintosh software.

Because of the user interface, many of the commands and basic
techniques, such as Cut and Paste, are the same in every
application. The same commands in different programs are
invoked the same way: using a double-click of the mouse
button to issue a command, pressing and dragging to move
icons, or placing the insertion point to insert text. This
consistency, along with the graphics and the mouse, makes the

Macintosh easy to use, and simplifies the development process.

One way to learn to access the Macintosh
operating system is to become a developer.

An applications developer needs to become thoroughly
knowledgeable about the Macintosh user interface. To do that,
the developer must attend the "Macintosh Technical Training,"
(also known as "Macintosh High School") presented by Apple
Support Programs, and/or attend "Macintosh College,"
presented by Apple Software Development.

Macintosh 68000 Development System and
Inside Macintosh are the tools.

The Macintosh 68000 Development System is a complete

programmer's tool for developing Macintosh applications.
This development system, when used with the Apple
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Macintosh ROM User
Interface

Elements of ROM

An Overview of Macintosh ROM 7

publication Inside Macintosh, is all that the experienced
applications programmer needs to begin creating programs for
Macintosh.

The user interface is the higher of the two
levels of ROM.

The user interface, (or User Interface Toolbox), is provided to
facilitate the use of Macintosh applications. It is the most
visible and accessible part of Macintosh ROM.

This high-level user interface provides windows, menus, and
the desktop, as well as text and utility functions. It also
provides an element called "QuickDraw" that underlies all of
the graphics.

Programmers should notice that the user interface is called
"high level." This is because the interface is positioned a level
above the operating system and is in constant use by the user
(or user application). The user interface seldom works directly
with the hardware. So don't confuse this use of the term "high
level" with traditional high-level machine language.

The operating system is the lower level.

The lower level of Macintosh ROM works directly with the
Macintosh hardware. This part of the system supplies the
elements of what is generally thought of as an operating
system. Drivers, direct system managers, and
memory-management and event-management routines are
handled at this level.

To summarize from Inside Macintosh...

"The User Interface Toolbox is a level above the operating
system; it helps...implement the standard Macintosh user
interface.... The Toolbox calls the operating system to do
low-level operations.... The operating system is at the lowest
level; it does basic tasks such as input and output, memory
management, and interrupt handling."

The ROM is composed of a number of elements
with specific functions.

The chart on the next page, and the definitions that follow,
briefly illustrate the function or operation performed by each of
the elements of Macintosh ROM. For complete definitions of
these elements, read the sections that discuss each element in
Inside Macintosh.
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Macinth ROM Overview

AR RRRIRES

Macintosh User Application

RS

Dialog Manager

Control Manager Menu Manager TextEdit
'~ Window Manager
Toolbox Utilities

Toolbox Event Manager

Disk Manager Scrap Manager
QuickDraw
Package Manager Font Manager

Resource Manager

The Operating System

Memory Manager
Segment Loader
Operating System Event Manager
File Manager
Device Manager
Disk} Driver
Sound Driver Serial Driver
Vertical Retrace Manager
System Error Handler
Operating System Utilities

The Macintosh Hardware
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The User Interface Toolbox contains the
following elements:

Resource Manager. The part of the Toolbox that reads and
writes resources, such as data used by an application, or the
application code itself.

QuickDraw. Performs all graphics operations on Macintosh.
QuickDraw is often called the "heart of the Macintosh User
Interface Toolbox routines."

Font Manager. Supports the use of various character fonts
for QuickDraw when it draws text.

Toolbox Event Manager. Allows an application to monitor
the user's actions with the mouse, keyboard, and keypad.

Window Manager. Provides routines for creating and
manipulating windows and menus.

Control Manager. Provides routines for creating and
manipulating controls, such as buttons, check boxes, and
scroll bars (see Operating System Utilities).

Menu Manager. Deals with setting up menus and letting the
user choose from them.

TextEdit. Supports basic text entry and editing capabilities.

Dialog Manager. Provides routines for implementing dialog
and alert boxes.

Desk Manager. Supports the use of desk accessories from
an application.

Scrap Manager. Enables cutting and pasting between
applications and desk accessories, or between windows.

Toolbox Utilities. Performs generally useful operations
such as fixed-point arithmetic, string manipulation, and logical
operations on bits.

Package Manager. Lets you access Macintosh RAM-based
packages.
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Macintosh ROM Overview

R

‘Dialog Manager

Control Manager Menu Manager TextEdit
Window Manager
Toolbox Utilities

Toolbox Event Manager

Disk Manager Scrap Manager
QuickDraw
Package Manager Font Manager

Resource Manager

The Operating System

Memory Manager
Segment Loader

Operating System Event Manager

File Manager
Device Manager
Disk Driver
Sound Driver | Serial Driver
Vertical Retrace Manager
System Error Handler
Operating System Utilities

The Macintosh Hardware
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The operating system is the lowest level of
ROM, and interfaces with the hardware.

It contains the following elements:

Memory Manager. The part of the operating system that
dynamically allocates and releases memory space in the heap.
The heap is an area of memory in which space can be allocated
and released on demand.

Segment Loader. Loads the code of an application into
memory, either as a single unit or divided into dynamically
loaded segments.

Operating System Event Manager. Reports
hardware-related events such as mouse-button presses and
keystrokes.

File Manager. Supports file input and output (I/0).
Device Manager. Supports device 1/0.

Disk Driver. The device driver that controls storage and
retrieval on 3 1/2-inch disks.

Sound Driver. The device driver that controls sound
generation in an application.

Serial Driver. The device driver that controls
communication, via serial ports, between applications and
serial peripheral devices.

Vertical Retrace Interrupt. An interrupt generated 60
times per second by the Macintosh video circuitry while the
display tube beam returns from the bottom of the screen to the
top. The Vertical Retrace Manager schedules and
executes it.

System Error Handler. Assumes control when a fatal error
(such as running out of memory) occurs.

Operating System Utilities. Operating-system routines

that perform miscellaneous tasks such as getting the date and
time, finding out the user's preferred speaker volume and other
preferences, and doing simple string comparison.
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- A Key Graphic Element

Managing Macintosh

QuickDraw is key to Macintosh graphics.

Macintosh depends on graphics. For example, the screen,
printers, and software are all graphics oriented. MacPaint™
and MacDraw™ are examples of graphics applications that
have been written specifically for Macintosh. They take
advantage of most of the Macintosh graphics capabilities. Even
MacWrite™, a word-processing software package, depends on
graphics.

Briefly stated, QuickDraw does it all!

Whenever an object is placed on the Macintosh screen,
QuickDraw draws a rectangle. If a circle is being drawn,
QuickDraw first draws a rectangle, and then fills it with a
circle. When a letter is typed on the screen, QuickDraw draws
a rectangle, and the Font Manager supplies the size, font style,
and letter to be placed on the screen. QuickDraw gets the letter
from the Font Manager and puts it in the rectangle.

Managers work together as a group to manage
Macintosh.

A "Manager" in the Macintosh user interface and operating
system is a group of subroutines, a library, a convenient way
to group routines that are used to manage the same type of data
objects (text or graphics).

Managers such as Quickdraw, the Control Manager, the
Toolbox Event Manager, and Resource Manager, don't
perform any functions by themselves. They perform as a
group to coordinate and complete related tasks, like putting
letters on the screen, or responding to the click of the mouse.

The good news is that half of the programmer’s
work has been done.

There are about 500 calls to the Macintosh user interface and
operating system, as compared to 50 calls to ROM in
ProDOS®, and 100 calls to MS-DOS. In other words, half of
the programming has been done for the programmer. It's there
in Macintosh ROM. That's the good news. The other news is
that the programmer has to understand that half.

APPLE SUPPORT TRAINING LIBRARY



Macintosh Drivers and the Elements of ROM 13

Il Macintosh Drivers and the Elements of ROM

Overview

ROM Needs Software to
Run I/O Devices

The elements of the operating system work to
control various peripheral devices.

Macintosh ROM contains a number of drivers. The Device
Manager, Disk Driver, and the Serial Driver control the
peripheral devices that are necessary to all Macintosh users.
Disk drives, video output, sound from the Macintosh speaker,
and output to all printers and modems are each controlled by
their respective elements in ROM. Input via the mouse,
keyboard, and serial ports (from a modem or digitizer), is also
controlled from the programs resident in Macintosh ROM.

But the elements in ROM depend on information from the
software to coordinate such tasks as receiving input from the
mouse or printing on an ImageWriter™ printer.

The correct software must be used to drive the
input and output devices used by Macintosh.

The elements of Macintosh ROM need instructions to help them
drive the input/output (I/O) devices that are used by Macintosh.
These instructions come from the corresponding drivers in the
information contained on the Macintosh startup, system, and
application disks.

Open the System Folder on any Macintosh System Disk, or on
most startup disks. The folder will contain at least a System
file, and a Finder, and may also contain a printer driver file (for
example, the ImageWriter) as shown in the following System
folder window.

E[J== System Folder =—
3 items 210K in folder 112K available
L

)
System Finder Image¥Writer —5
] [
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Chances are you'll have the icon of the ImageWriter in your
System Folder. This icon represents the file that contains the
printing instructions to drive this printer. This file works with
the Device Manager and the Serial Driver to send your files to
the ImageWriter.

Macintosh needs the operating system and the
software drivers to print files.

To print a file, the Macintosh operating system and the System
file on the Macintosh disk must talk to each other. When you
start up Macintosh, the elements of the operating system and
user interface get instructions from the disk (for example, from
the ImageWriter Driver) and load those instructions into RAM.

Macintosh checks the printing resources on the disk and uses
the resources you have chosen along with the resources in
ROM. The document is printed, based on those instructions.

Macintosh \
Operating
System in ROM
Startup Disk
Device M:nager — ]
and ImageWriter
Serial Driver | <@— | Driver

Some of these instructions come from the System file and the
application, but without the specific information provided by
the ImageWriter Driver, the selected document won't print.
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(’ You may have a few printer drivers on your
disk.

In addition to the ImageWriter Driver file, you may have
software that allows you to use a variety of printers, for
example the Apple® LaserWriter™. If so, you may have a
group of files that look similar to the ones shown in the

following picture.
El==———————"Printers=F————
10 items 131K in folder 4403K available

>
B ™ i

LaserWriter Imagewriter Diablo630 AppleDaisy NEC7710

m- || l

Laser Prep Imagewriter 15 Typewriter Brother Another ? =
K =)

R

If the appropriate printer driver file for the printer you have
choosen isn't on your disk, then you can't print your
documents on that printer.

Macintosh Serial Ports The Modem and Printer ports support the
serial interface for Macintosh.

Macintosh has two RS-232/RS-422 serial ports. These are a
Modem port and a Printer port. Macintosh assumes that you
will use each port as it is labeled. Unless you have software
that allows you to use the ports differently, always be sure that
devices are plugged into the proper ports.
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Some Apple and third-party products have
expanded connection capabilities.

Apple products such as the LaserWriter can use either port once
the software is installed. The LaserWriter uses the
AppleTalk™ Network Driver to make this possible.
Third-party hardware and software manufactures use the two
serial ports and the mouse port for many different input and
output devices. For example, bar-code readers, digitizers, and
optical scanners take advantage of the advanced graphics
capabilities of Macintosh.

AppleTalk Driver The AppleTalk Driver and software allow you
to use both serial ports for printing.

If you have several serial devices available to you (such as an
ImageWriter, AppleTalk, and a modem), you may need to use
your serial ports differently from the way they originally were
labeled. For example, you can use MacTerminal to connect a
modem to either port. Also, if you choose Choose Printer
from the Apple menu, you can connect your ImageWriter to
either port.

When you select Choose Printer, a dialog box will appear:

ImagelUriter Port:

Laserllriter

@
@ Connected

QO Disconnected
( ok ] [ cancel ]m

AppleTalk

From Choose Printer you can opt to use either the Modem
port or the Printer port for printing. In this illustration, the
LaserWriter is using the Printer port, AppleTalk is connected,
and the ImageWriter is available.
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If you have other printer drivers available, the names of those
printers appear in the dialog box. Without this special
software, the standard ImageWriter printer file uses the Printer
port for printing.

Macintosh has several programs, such as the
Desk Accessories, that are considered drivers.

Each Apple Desk Accessory in the Macintosh system file is
labeled as a driver. This includes the alarm clock, keyboard,
control panel, and other devices. Some of them help run the
Macintosh hardware, and are controiied by the user from the
Control Panel, Font/DA Mover, or from Choose Printer.

The fact that these accessories are referred to as drivers,
doesn't mean they're drivers. Some are called drivers for
programming convience. For example, the alarm clock and
calculator aren't drivers, but have a DRVR (driver) application
type. Applications developers and some users need to be
aware of this designation.

Many new products become available for the
Macintosh every day.

Macworld and the Macintosh Buyer’s Guide, as well as many
other publications on the market announce new products in
each issue. Consult these to discover the growing number of
ways to use your Macintosh more effectively and productively.
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Il Macintosh Startup Icons

Overview

The "Happy Macintosh"

The Macintosh startup icons provide important
support information.

Often the opening Macintosh screen provides an important clue
to a Macintosh support question. This section discusses the
startup icons, and provides answers to the support questions
involved.

What does a Happy Macintosh indicate? When
does this icon appear?

This icon appears on the Macintosh screen when Macintosh is
turned on and a startup disk is inserted into in one of the disk
drives.

What message is conveyed?

The Happy Macintosh appears on the screen to let you know
that:

+ Macintosh is working and has completed the first part of its
self-test.

» The disk that has been inserted has started to load part of the
Macintosh operating-system software.

Is a solution needed?

No. So far, so good. As long as the system continues to
function, the portion of the operating system contained in the
software will continue to be loaded into RAM. As the
operating system is properly loaded, Macintosh will progress
to the "Welcome to Macintosh” screen, and on to the desktop
environment.
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- "Question Icon"

What does a Question icon Indicate? Whé.n |
does this icon appear?

This icon appears on the Macintosh screen when Macintosh is
turned on and is waiting for a working startup disk to be
inserted into either of the disk drives.

What message is conveyed?

The Question icon appears on the screen to let you know that:

» Macintosh is working and is waiting for a startup disk.
This could be due to either of two reasons:

» There wasn't a disk in Macintosh when it was turned on.
* You've just used Shut Down.

Is a solution needed?

Yes.

Possible solutions are:

 Insert a working Macintosh startup disk, or simply turn off
Macintosh.
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What does the X icon indicate? When does
this icon appear?

This icon appears on the Macintosh screen when Macintosh is
turned on and the disk it tries to start up from is an uninitialized
disk, or a non-Macintosh disk. Macintosh ejects the disk and
displays this icon. This icon can also appear when a disk ejects
from a working Macintosh as it's turned on (because the user is
holding down the mouse button).

What message is conveyed?
The X icon appears on the screen to let you know that:
¢ Macintosh is working.

+ The disk that was in the disk drive when Macintosh was
turned on isn't a startup disk (so, it's ejected).

Is a solution needed?
Yes.
Possible solutions are:

» Insert a working Macintosh startup disk, ot simply turn off
Macintosh.
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"Sad Macintosh"

What does the Sad Macintosh indicate? When
does this icon appear?

This icon appears on the Macintosh screen when Macintosh is
turned on and isn't working (it can't read the disk, and won't
ctart up). Sometimes when a startup disk is inserted, Happy
Macintosh will appear on the screen, but before the "Welcome
to Macintosh" screen can appear, a Sad Macintosh take its
place, and the disk will be ejected.

What message is conveyed?

The Sad Macintosh appears on the screen to let you know that:

» The startup disk began to load the operating system and then
a problem occurred, such as an address error, a bad System
file, or no System file, and Macintosh was unable to
continue (Macintosh probably also ejected the disk).

* Macintosh isn't working. It may be a hardware problem.

Is a solution needed?

Yes.
Possible solutions are:

» Turn off Macintosh, insert a working Macintosh startup
disk, and turn on Macintosh again.

o Turn off Macintosh and follow the instructions in the "How
to Repair a Crashed Disk" section.

« Call your service representative. It might be a hardware
erTor.
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B Reference Chart for Startup Icons

Keep this chart as a reference.

ICONS 2 (=]
? X - —
Yhen a Macintosh| When a working When a disk is Yhen Macintosh
when does is started with a | Macintosh is ejected from the lis turned on, or a
. startup disk, or |turned on without {disk drive while [Happy Macintosh
each icon when a disk is ] a disk in the starting up a appears, but the
appear? inserted in drive. Macintosh, either jdisk then ejects
response to a ? manually or by due to a software
or X icon. the system. system error.
Macintosh is Macintosh is Macintosh is Macintosh is not
Message working and a | working, no disk | working, but the | working, it may
conveged good startup in drive, (X icon Jdisk is ejected be a hardware
bg each disk is in the may have appear- | due to damaged error or you
) disk drive. ed), Macintosh is | software. didn't use a good
icon. waiting for a good startup disk.
startup disk.
Solution
needed? No Yes Yes Yes
Insert a good Insert a good Insert a good
; startup disk or startup disk or startup disk or
POSS],D le turn off the turn off the turn off the
solutions Macintosh. Macintosh. Macintosh. If
are: Macintosh does
not work, call
your service rep.
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B How to Handle "Disk Full" Messages

Overview

Some Causes

This section explains how to handle "Disk full”
messages.

"Disk full" messages occur at various times while you're using
Macintosh. But, all these occurances have a very similar
message: There isn't enough room on your disk or in memory
to complete the operation just initiated. For example, if you
want to copy a section of text, you might get a message that
alerts you that the disk is out of space and you can't. Or, you
might try to print a file, only to be interupted by a dialog box
that says that there isn't enough room on the disk.

What can you do about this?

Good file-management habits can keep the number of
occurrences to an acceptable level. However, even the most
conscientious of file managers can't always avoid these

~messages. So, before looking at some of the ways to avoid

"Disk full" messages, lets take a quick look at some of their
causes.

Here are a few causes of "Disk full" messages:
» The disk contains unnecessary documents.

» The System file has more fonts or desk accessories than
necessary.

» The Scrapbook contains a lot of information.

» The disk has more than one application on it, and/or more
than one printing source (both ImageWriter and
LaserWriter).

» The disk has bad or damaged sectors that cause 1/O

messages (this may cause the entire disk or some of your
documents to be unusable).
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Fonts and Desk
Accessories

N
f

Scrapbook and Note Pad

Printing Resources
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Archive unused but necessary files on disks in
a safe place, and delete the others.

Setting up a library of files is one solution. No matter how
careful you may be, it's easy to begin collecting files that are no
longer useful. If this seems to be an issue, create an archive
file. Use a filing cabinet, or a series of disk holders or boxes
that can be labeled and organized. This file could include
copies of backup applications disks, old spreadsheets or
data-base files that are important for payroll accounting, or last
year's Christmas card cross-reference list.

Once you've archived your important documents, delete the
originals and other unused files. Also, check their creation and
modification dates. Delete the ones you know aren't going to
be used. Keeping files current is important to efficient file
maintenance, and reducing the number of "Disk full"
messages.

Maintain a minimum number of fonts and desk
accessories in your System file.

Keep the number of fonts stored in the System file to a
minimum. Use the Font/DA Mover to create a "For Fonts
Only" disk (see the Support Programs Library module
Supporting the Font/DA Mover for instructions). That way,
you can move them into the system when you need them, and
they can stay out of your way the rest of the time.

Limit the amount of information in your
Scrapbook and Note Pad.

Use the Scrapbook only for necessary or important
illustrations; for example, a corporate logo that can be used in
memos or letters. Remember to clear the Note Pad once
you've used the notes, or transferred them into another
document. These files take up a lot of disk space that could be
used for word-processing documents or spreadsheets.

Limit the number of printing resources that
share a disk with an application.

Keep only one application per disk for applications that have a
lot of files, or very large files. For example, spreadsheets and
data-base files can consume disk space very quickly. When
you limit the number of applications and printing resources on
a disk, you'll have more room for data, and you can minimize
disk swapping and "Disk full" messages.
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Other Causes

Room to Print

When you use an ImageWriter as your primary printer, there is
no need to have the LaserWriter print file on your application
startup disk. When you want to use the LaserWriter, copy the
document you want printed to an application disk that has the
LaserWriter print file installed.

One way to limit your printing resources on a disk is to keep
them on different disks. For example, keep the ImageWriter
file on your primary application disks, and the LaserWriter files
on your backup application disks. Be sure that the disks are
clearly labeled.

Damaged disks or disks with bad sectors can
cause "Disk full” messages.

To avoid some"Disk full" messages, all you have to do is to
maintain your disks properly. There are many causes of
damaged disks, such as heat, breakage, or just plain overuse.
Keep your disks in disk carriers in cool, safe places. This will
help prolong their life.

To protect yourself against bad disks, always back up your
documents daily, and when you're working on a document,
save your work every 10 minutes. If you back up your files,
and you get a "Disk full" error -- or a disk error that's more
serious -- you won't lose all that time or information. There
are several ways of reclaiming files that you may think have
been lost.

If you find that you continue to get "Disk full" messages, and
you know that you don't have many files on that disk, you may
have a bad disk. Often if you copy that disk to another disk,
the error will be "fixed" on the new disk. Initialize the old
disk, or erase it and try to use it again. This simple routine
may save your file, and your disk (and your sanity!).

"Not enough room to print"” may appear even
when you think there's enough room.

If this message appears when you begin to print a document,
and you know there's plenty of room on the data disk, it means
there isn't enough room on the startup disk. Your application
may need this room to create a print file.

One remedy is to move the application to your data disk. Your
first disk will remain the startup disk and will contain the
printing resources. It'll now have room for the print file. The
second disk will be your data disk and will contain your
application and the document you want to print.
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Another way to do this is to always keep the application and the
data on the same disk. Have two startup disks: one that
contains the ImageWriter software, and another that has the
LaserWriter software. This will free up more room on the
application disk, and on the startup disk for large documents.

For more information on "Disk full" messages and document
organization, see the Managing Macintosh Files module.

FUNDAMENTALS OF THE MACINTOSH OPERATING SYSTEM



28 How to Repair a Crashed Disk

Il How to Repair a Crashed Disk

Overview

Rule Number One

Repair a Disk

Some lost documents can be recovered.

One of the most common crises faced by technical support
people is recovering the information on a crashed disk. Here
are a few methods that have been successful in many cases.
Since there are many ways to blow up disk directories, though,
these methods are not always 100 percent effective.

The first rule for every computer user is
backup your work, and use Save often.

Now that the primary means of disk (or document) recovery
has been established, please continue reading.

Method 1: Repairing a startup disk.
1. If possible, make a backup copy of the bad disk.

2. With the Macintosh turned off, put the copy of the bad disk
into the internal drive.

3. Before you turn on the Macintosh, hold down the Option
and Command keys.

4. Turn on the Macintosh. Continue holding down the
Option and Command keys until the disk icon appears.

5. If this works with the copy of your original disk, you may
want to use it as your new disk. If not, follow the same
procedure with your original disk.

This method sometimes requires several attempts. It recreates
the desktop file and the disk directory. One of these files may
have been the cause of the problem.

This process restores your documents, but your folders (except
for the first level) are lost. This first level of folders is placed
on your desktop. The system names them "Unnamed #1,"
"Unnamed #2," and so forth. You must re-create your folders,
and put back the recovered documents and files manually.

This method is especially useful if your Macintosh ever

displays a bomb and the message, "A serious system error has
occurred.”
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Method 2: Recovering from Error: ID = 02.
To repair a data disk (or if Method 1 doesn't work):

1. Start up with a disk that you know is good. Then eject the
disk. Do not use Shut Down.

2. Hold down the Option and Command keys and insert the
problem disk.

3. You'll lose your folders, so replace them as described
above.

(Note: This method also works on a Macintosh XL. Start up
from the MacWorks™ program. Hold down the Option and
Command keys and insert the bad 3.5-inch disk.)

(Note: The repair function for the hard disk isn't available at
the time of this printing.)

Method 3: Recovering the information on a bad
startup disk by replacing the System file.

This method has been known to work with disks that fail to
start up, and exhibit a Sad Macintosh with the address OF0028,
or OF0064.

1. Attempt Method 1.

2. If that doesn't work, start up Macintosh using a good
startup disk and then insert the bad disk.

3. If the icon of the bad startup disk appears on the desktop,
replace the System file with a working copy of the System
file from the good disk.

(Note: This last method doesn't seem to work with disks that
exhibit a Sad Macintosh with the address 2F0064.)

Try this with a Macintosh XL.

If you're using a Macintosh XL, start with Step 2 above. Start
up with MacWorks from the internal disk drive. When the
system is ready, insert a startup disk. After the startup disk
icon and the hard-disk icon appear, replace the System file
and/or the Finder on the hard disk with the System file and/or
Finder on the internal disk.
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Back Up a Disk to
Recover Lost Files

Recover a Document

Method 4: Backing up the disk to a clean disk.

A method that often helps to recover a "lost" disk is to use a
backup utility to move the data, applications file(s) and the disk
directory to another disk (there might be a bad sector or other
problem with the disk that has rendered it unreadable). This
method might take several tries to work.

If you can, try to open the disk on a different Macintosh, or use
a different Macintosh to copy the disk. If you keep getting disk
messages, it might be evidence of difficulties with the
hardware.

Method 5: Recovering documents that won't
open.

1. Make a copy of the disk that contains the document(s) you
want to recover.

2. Turn on Macintosh with a good copy of the application
needed to read the document(s) you wish to recover.

3. Open the application.

4. Once the application is open, close the document called
"Untitled."

5. Choose Open from the File menu.

6. If you're using a two-drive system, insert the bad disk. If
you're using a one-drive system, click Eject and insert the
bad disk.

7. Select the disk by clicking Drive (if the disk isn't alfeady
selected), and open the desired document(s) from the
Document Directory dialog box.

8. If this works, save the document(s) to a good disk, back
up your work, and continue.
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Practice

Crashed Disk Practice

To practice any of these routines, you must
have a crashed disk.

Try each of the methods listed above. Use disks that you
previously thought were lost. If you don't have any of these
disks, ask a colleague, or just wait. The opportunity to practice
these techniques is bound to occur. Refer to this module when
you get a problem disk.

Rule number one should always be practiced.

You should be in the habit of backing up your documents
regularly, at least once a day. You may even want to keep
backups of your backups, and archive some of your work
away from your work area.

Method 1 can be practiced with any disk.
To practice method 1, be sure to use a disk that has a few

folders on it. You'll lose the folders, but you'll see what the
operation looks like and how much time it takes.
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Feedback
Crashed Disks and There are other methods available via third
Documents party products.

Your Apple support representative or authorized Apple dealer
can help you with any of the methods that were addressed.
Discuss other ideas you may have with your course manager,
or a colleague.

In addition to the recovery systems that were mentioned, there
are many third-party applications available through user's
groups. Check with your Apple support representative for
applications that might be available, or check the resources
listed at the end of this module.
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B Review

An Overview of
Macintosh ROM

Identify Macintosh Drivers

Macintosh Startup Icons

How to Handle "Disk Full"
Messages

Some Causes and
Some Solutions

Repair a Crashed Disk

Macintosh ROM has two levels: the operating
system and the user interface.

Device drivers are needed for each I/O device,
such as the mouse, printers, and digitizers.

Macintosh drivers work to support a wide variety of peripheral
devices. These devices work in conjunction with the drivers
contained in ROM, the drivers that are part of the software, and
information provided by the System file and the application.

There are four icons that can appear when you
start up Macintosh.

The Happy Macintosh, Question icon, X icon and the Sad
Macintosh.

Use good file-management techniques to
avoid frequent "Disk full” messages.

There are a number of causes for these
messages, and there is usually a solution.

Back up your files. Then when messages such
as Error = 02 appear, you have alternatives.

Five methods of error recovery (such as recovering bad disk
files by using the Option and Command key function) were
discussed. Of course, the best method of avoiding a lost-file
disaster, is to back up your files often, and save them to disk
every 10 minutes.
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B Resources

* AppleLink, Available to Apple support personnel, Apple
Computer, Inc.

o Inside Macintosh, Apple Computer, Inc., Addison-Wesley
Publishing Company, Inc., Reading, MA 01867, 1985

¢ Macintosh (the owner's manual), Apple Computer, Inc.

*  Macintosh 68000 Development System User's Manual, and
Inside Macintosh, Apple Computer, Inc.

¢ Macintosh Technical Training, available through Apple
Support Training, Apple Computer, Inc.

Apple, the Apple logo, and the Macintosh logo are registered trademarks of Apple Computer, Inc. AppleLink, AppleT alk,
ImageWriter, LaserWriter, MacDraw, MacPaint, MacWorks, and MacWrite are trademarks of Apple Computer, Inc.
Macintosh is a trademark of Mclntosh Laboratory, Inc. and is being used with the express permission of its owner.
MS-DOS is a trademark of Microsoft Corporation.
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2 Overview

Bl Overview

Read this module to learn how to use MacDraw™. The
module includes basic product training, information about
integrating MacDraw with other Macintosh™ computer
applications, and a collection of tips and techniques to make
MacDraw more useful and powerful.

If you have never used MacDraw, you should complete the
entire module. If you already know how to use MacDraw, you
may still benefit from the Useful Techniques, and Integrating
MacDraw with Other Applications sections.

Prerequisites

« The basic techniques for using Macintosh, including how

to use the mouse and menus, how to open and close
documents, and how to work with text. You can learn these
by completing the Learning to Use Macintosh module or the

- Guided Tour of Macintosh, or by reading Chapters 1 and 2
of Macintosh, the owner's manual.
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Il Objectives

Use all of the features of MacDraw as described in the
Guided Tour of MacDraw.

State the function of each of the menu commands.

Describe the specific information that can be moved between
MacDraw and other applications distributed by Apple® for
the Macintosh. Also describe, in general, the information
that can be moved between MacDraw and spreadsheets or
data bases.

B Materials

To complete this module, you will need:

Macintosh 128K or Macintosh 512K
MacDraw disk

MacDraw, the owner's manual

Guided Tour of MacDraw disk and cassette
Audiocassette player

A blank disk

If available, the following is recommended:

An external disk drive
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I Overview of MacDraw

What Is MacDraw?

MacDraw Benefits

MacDraw is a professional graphics solution
for presentations, drafting, and design.

MacDraw is a structured graphics editor. Components of your
drawings are stored as independent graphic elements, or
"objects,” which may be freely moved and changed. You
create your drawing by combining many of these basic graphic
elements, which include circles, rectangles, lines, curves, and
text.

MacDraw is different from MacPaint™, which is a
pixel-oriented graphics editor. MacPaint lets you manipulate
dots on the screen, while MacDraw lets you manipulate fully
formed graphics objects.

These are the key benefits of MacDraw.

More effective communication. Graphically represent
concepts that would be impossible to describe with words
alone.

Accurate. Its a precision tool that can be used by architects,
engineers, and others who draw to scale.

Integrated with other applications. Enhance other
Macintosh documents through the addition of graphics, and use
MacDraw to enhance graphics pasted in from other
applications.

High quality output. Use MacDraw with the Apple
LaserWriter™ printer to produce publication-quality graphics
output.

Easy to learn. Eliminate time spent learning to use
graphics-design tools.

Economical. Using MacDraw to produce high-quality

graphics is much less expensive than hiring a professional
graphics designer.

APPLE SUPPORT TRAINING LIBRARY
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Il Learning How to Use MacDraw

Overview Use existing materials to get started using
MacDraw.

The Guided Tour of MacDraw disk and cassette, and the
MacDraw manual, which are packaged with MacDraw, are an
excellent starting point for learning how to use the application.
You'll start with the Guided Tour, and then read key parts of
the manual.

(Note: Be sure you have a Macintosh 128K or a
Macintosh 512K because the Guided Tour of MacDraw
doesn't work on a Macintosh XL..)

After each Guided Tour session, complete the appropriate
practice exercise in this module. In each exercise, you'll
practice the techniques covered in the portion of the Guided
Tour that you just completed.

If you have questions that are not answered in this module or in
the Guided Tour, refer to MacDraw, the owner's manual, or
ask a colleague, your course manager, or your Apple support
representative.

Practice Exercises Use the actual MacDraw disk (not the Guided
Tour) to complete the practice exercises.

After each Guided Tour session, eject the Guided Tour disk
and start up from the MacDraw application disk to complete the
practice exercise. Don't use the Guided Tour disk for the
exercise because you can't save your work onto it.

In several of the practice exercises that follow the four Guided
Tour sessions, you'll work on the same drawing. Be sure to
save your work when instructed to do so.

The exercises include screen shots that reflect what your screen
should look like at various stages in the exercise. It's not
necessary to match these screen shots exactly.

Following each practice exercise, there's a Feedback section
you should read to confirm that you have completed the
exercise correctly. The Feedback section will also suggest
what to do if you have trouble.

USING MACDRAW



6 Learning How to Use MacDraw

If you want to finish the Learning How to Use MacDraw
section more quickly, you could go through the entire Guided
Tour without stopping and then complete the Practice Using
MacDraw section. However, you will learn—and retain—more
about MacDraw if you complete all of the practice exercises in
this module.

Guided Tour Complete the first session of the Guided Tour
of MacDraw, "What Is MacDraw?".
Continue with the following practice exercise when you have
finished the first session of the Guided Tour of MacDraw.
Practice

Fixing Mistakes

Start Up MacDraw

Use the Clear, Undo, or Revert commands.

As you work on this practice exercise, you'll probably make
some mistakes. Correcting them is easy with the help of the
Clear, Undo, and Revert commands.

Whenever you don't like the last thing you drew, just choose
Clear from the Edit menu while the object is still selected.
The object will be removed and you can try drawing it again.
Or choose Undo from the Edit menu to undo the last addition
or change to your drawing. For example, if you change the
size of a rectangle, choose Undo to change it back to its
original size. You can also choose Revert from the File
menu to undo all of your changes since you last saved the
document. (If you never saved your work, your document will
revert to a blank document.)

All of these options are explained in more detail in the Guided
Tour and the manual.

Use the MacDraw disk to complete the practice
exercise.

1. Click I'm Ready to Stop from the Guided Tour screen.
The Guided Tour disk will be ejected automatically.
Insert the MacDraw disk.

Open the MacDraw disk icon.

Open the MacDraw application icon, either by selecting it
and choosing Open, or by double-clicking on the icon.

Rl el
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( Draw a Macintosh

Learning How to Use MacDraw 7

Use the techniques introduced in the Guided
Tour to draw a picture of a Macintosh.

This section contains step-by-step instructions to complete your
drawing of a Macintosh, and screen shots showing
approximately what your screen should look like. Complete
each step as it is explained. It's not necessary to match the
screen shots exactly.

As you create the various parts of your drawing, the tool you
should use is identified on the screen shot with a hollow
arrow ( ). This arrow will not appear on your screen.

Draw the outine of the Macintosh.

1. Click on the rectangle tool in the palette.

2. Position the pointer where you want one corner of the
outline of the Macintosh to be.

3. Hold down the mouse button and move the pointer to the
opposite corner.

& File Edit Style Font Layout Arrange Fill Lines Pen
= =— Untitled = — =
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4. Release the mouse button. Notice that your rectangle now
has handles and the selection pointer (the arrow at the top
of the palette) is now selected. You'll always return to the
selection pointer after drawing something.

If necessary, move or resize the rectangle.

If you need to reposition the rectangle, point anywhere inside
it, and while holding the mouse button down, move it to the
desired location.

USING MACDRAW



8 Learning How to Use MacDraw

Practice (cont'd)

If you need to resize the rectangle, position the tip of the
pointer on one of the handles, and, while holding down the
mouse button, move the mouse to change the rectangle to the
desired size.

Or use the Clear command to remove the rectangle completely,
and then redraw it.

Draw the screen.

1.

While the rectangle, which is the outline of your
Macintosh, is still selected (the handles are showing),
choose Duplicate from the Edit menu.

To resize the duplicate, first point to the lower right handle.

1113I§III|I|4I|I||1
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Hold the mouse button down. The handle should
disappear. If it doesn't, release the mouse button and try
again. If all of the handles disappear, reselect the rectangle
by clicking anywhere within its borders.

Move the mouse to resize the rectangle. Make it smaller
than the original rectangle, as shown in the next screen
shot.

Release the mouse button when the rectangle is the desired
size.

While the small rectangle (the screen) is still selected,
choose an appropriate shading from the Fill menu.
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Add the disk drive.

1. Choose the perpendicular lines tool from the palette. This
enables you to draw horizontal and vertical lines.

2. Draw a line representing the disk drive.

3. While the line is still selected, choose a thicker line from
the Lines menu.
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Practice (cont'd)

Ro

und the corners of the cabinet and the

screen.

1.

bl

E
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Select the large rectangle (the outline of the Macintosh) by
pointing to it and clicking the mouse button.

Choose Round Corners from the Edit menu.

Click on 1/8" and click OK.

Use the same technique to round off the corners of the
screen (the small rectangle).

|11| ll'llllll|l2|IlIII|I3|I|IIlll‘llllllll—]l]l'll!slllm

[1]

Draw the mouse.

AP

Choose the rectangle tool from the palette and draw the
outline of the mouse. ,

Duplicate the outline to create the rectangle that will
become the mouse button.

Grab the lower right handle and shrink the duplicate to the
appropriate size.

PLE SUPPORT TRAINING LIBRARY
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Add the mouse cable.

1. Choose the freehand shape tool from the palette and draw a
line connecting the mouse to the back of the Macintosh.

2. While the line is still selected (there are handles in the
shape of a rectangle surrounding the line), choose a thicker
line width from the Lines menu.
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Practice (cont'd)

Quit MacDraw.

1. Choose Quit from the File menu to quit MacDraw and
return to the Finder.

2. You won't be saving your changes, so click No when
you're asked if you want to save changes before closing.

3. Choose Shut Down from the Special menu, which will
eject the MacDraw disk and restart your Macintosh.

4. Insert the Guided Tour of MacDraw disk.

If, after inserting the Guided Tour disk, you get the Macintosh
desktop with a disk icon instead of the Guided Tour screen,
tern the Macintosh off, and then on again.

Feedback

Draw a Macintosh

Be sure you understand the techniques
covered in this section before continuing.

When you have finished, your entire drawing should resemble
the last screen shot, shown on page 11. If it doesn't, and you
don't understand why, reread this section to be sure you
understand all of the techniques taught. '

If you don't understand a particular aspect of MacDraw, you
have several options:

+ Listen to the first Guided Tour session again.
Refer to MacDraw, the owner's manual.

» Ask acolleague, your course manager, or your Apple
support representative.

Continue when you are comfortable with all of the techniques
taught so far.
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Learning How to Use MacDraw (cont'd)

Guided Tour Complete the second session of the Guided
Tour of MacDraw, "More Drawing!".
Continue with the following practice exercise when you have
finished the second session of the Guided Tour of MacDraw.
Practice

Fixing Mistakes

Start Up MacDraw

Draw an Organization
Chart

Use Clear, Undo, or Revert.

If at any time you don't like the last thing you drew, just
choose Clear from the Edit menu while the object is still
selected. Or choose Undo to undo any addition or change to
your drawing (for example, move, resize, or fill). You can
also choose Revert from the File menu to undo all of your
changes since you last saved your document.

Use the MacDraw disk to complete the practice
exercise.

Be sure to use the MacDraw disk for this exercise. At the end
of the exercise, save your drawing, because in the next exercise
you'll add to it.

1. Click I'm Ready to Stop from the Guided Tour screen.
The Guided Tour disk will be ejected automatically.
Insert the MacDraw disk.

Open the MacDraw disk icon.

Open the MacDraw application icon.

bal

Use the techniques introduced in the Guided
Tour to draw an organization chart.

This section contains step-by-step instructions to complete your
drawing, and screen shots showing approximately what your
screen should look like. Complete each step as it's described.
It's not necessary to match the screen shots exactly.
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14 Learning How to Use ‘MacDraw

Practice (cont'd)

Draw the first box of the organization chart.

Draw a rectangle, similar to the one shown below, in
approximately the same location. If you aren't satisfied with it,
either resize it, move it, or choose Clear and start again.

& File Edit Style Font Layout Arrange Fill Lines Pen
= == Untitled =

Make it a round-corner rectangle.

1. While the box is still selected, choose Round Corners
from the Edit menu.
2. Click on 1/8" and click OK.

Make three duplicates, which you'll use to
make the rest of your organization chart.

1. Select the first box (if it's not already selected).

2. Hold down the Command key and press D. A duplicate of
the rectangle will be made.

3. Press Command-D twice more to make two more
duplicates.
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4. Move the boxes into the positions shown in the screen shot
below.

& File Edit Style Font Layout Arrange Fill Lines Pen
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Add text.

1. Choose the text tool from the palette.

2. Position the pointer in the top box and click the mouse
button to set an insertion point.
3. Type President.
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16 Learning How to Use MacDraw

Practice (cont'd)

4. In the next three boxes, starting with the one on the left,
type VP Sales, VP Distribution, and

VP Manufacturing.

Click on the selection pointer (the arrow).

Move the text to the center of the boxes.

Resize the boxes if the text doesn't fit.

Now

& File Edit Style Font

Layout Arrange Fill Lines Pen
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Add lines to show the structure of the
organization.

If you hold down the Command key, you can draw several of
the same type of object without having to return to the palette.
Use that technique, and follow the instructions below to draw
the lines to connect the boxes together.

Choose the perpendicular lines tool from the palette.
Draw one of the lines shown in the screen shot below.
Hold down the Command key to draw another line.
Continue to hold down the Command key as you draw all
of the lines shown below.

bl

If you have trouble lining up the boxes and the lines, don't
worry about it right now. Later, you'll learn about the grid and
how to align objects.
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Enhance your drawing
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Untitled

Change the type style of a word.

1.

2.
3.
4.

Choose the selection pointer and point to the word
"President." Click the mouse button to select it.

Choose 18 point from the Font menu.

Choose Bold from the Style menu.

Reposition the text to keep it in the center of the rectangle.

Make the boxes bolder.

bl e

Select one of the boxes.

Hold down the Shift key and click on the second box.
Both boxes should now be selected.

Use the Shift-click technique to select all four boxes.
Choose a slightly bolder line from the Lines menu.
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18 Learning How to Use MacDraw

Practice (cont'd)

Make room for a title.

Before you can add a title, you must make some room at the
top of your drawing.

1. Choose Select All from the Edit menu to select
everything in your drawing. (Select All selects
everything in the entire document. So when you use
Select All, be careful not to move objects that you don't
really want to move—for example, objects that aren't
currently visible in the window.)

2. Move any part of the drawing down the screen. The rest
will follow.

Add a title.

1. At the top of the screen, type Organization Chart.
2. Use the Font and Style menus to change the type style of
the title to New York, 18 point, and Shadow.

€ File Edit Style Font Layout Arrange Fill Lines Pen
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Highlight the title by drawing two polygons
around it, as shown below.

1.
2.
3.

¢

Choose the polygon tool from the palette.

Click where you want to start the polygon.

Move the mouse to the second vertex, or corner, and
click again. Each time you click the mouse button, you
will establish a new vertex.

Continue clicking the mouse button to set each vertex until
your polygon is finished.

Double-click on the last vertex of the polygon.

Either hoid down the Command key or click on the
polygon tool again to start the second polygon.
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Quit MacDraw and save your work.

1.

w

4.
5.
6

Choose Quit from the File menu. You will be asked if
you want to save the changes.

Click Yes.

Type a name for your document, such as "Org Chart."
(Henceforth, this document will be referred to as the Org
Chart document.)

Click Save.

Choose Shut Down from the Special menu.

Insert the Guided Tour disk.

If you don't see the Guided Tour screen, turn the Macintosh
off and then on again.
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20 Learning How to Use MacDraw

Feedback

Draw an Organization
Chart

Be sure you understand the techniques
covered in this section before continuing.

When you have finished, your drawing should resemble the
last screen shot. If it doesn't, and you don't understand why,
reread this section to be sure you understand all of the
techniques taught.

If you don't understand a particular aspect of MacDraw, you
have several options:

» Listen to the second Guided Tour session again.

* Refer to MacDraw, the owner's manual.

* Ask acolleague, your course manager, or your Apple
support representative.

Continue with this module when you are comfortable with all
of the techniques taught so far.

Learning How to Use MacDraw (cont'd)

Guided Tour Complete the third Guided Tour segment,
"What Can | Do with MacDraw?".
Continue with the following practice exercise when you have
finished the third session of the Guided Tour of MacDraw.
Practice

Fixing Mistakes Review

Use Clear, Undo, or Revert.

Remember, if you don't like the last object you drew, you can
use the Clear command to remove it. Or choose Undo to
undo any addition or change to your drawing. You can also
use the Revert command to undo all of your changes since
you last saved your document.
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Start Up MacDraw

Enhance the
Organization Chart

Learning How to Use MacDraw 21

Use the MacDraw disk to complete the practice
exercise.

1. Click I'm Ready to Stop from the Guided Tour screen.
2. Insert the MacDraw disk.
3. Open the Org Chart document.

Use the techniques introduced in the Guided
Tour to enhance your chart.

This section contains step-by-step instructions to complete your
drawing, and screen shots showing approximately what your
screen should look like. It's not necessary to match the screen
shots exactly.

Center the text in the boxes.

Upon choosing the Align Objects command from the
Arrange menu (don't do it yet), you will get several choices
for how you want to line up the selected objects. The Top,
Bottom, Left, and Right options are straightforward. The
L/R Centers (Left/Right) option relocates the objects left and
right until they are centered vertically. The T/B Centers
(Top/Bottom) option moves the objects up and down until they
are centered horizontally.

1. Use either the selection rectangle or the Shift-click
technique to select the top box and the text it contains.

2. Choose Align Objects from the Arrange menu.

3. Click L/R Centers and T/B Centers, and then click
OK. The text will now be centered in the box, both
horizontally and vertically.

4. Deselect the box and text by clicking on an empty part of
your drawing. The handles will all disappear.

5. Repeat the process for the other three boxes.
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Practice (cont'd)

Add shadows to the boxes.

[o—
o

Use the Shift-click technique to select all four boxes, but
not the text.

Choose Duplicate from the Edit menu.

Choose Send To Back from the Arrange menu.
Choose the black fill pattern from the Fill menu.

bl ol
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Draw a round-corner rectangle of a specific
size.

1. Choose Show Rulers from the Layout menu.

2. Choose the round-corner rectangle tool from the palette
(#1 in the following screen shot).

3. Just below the title, on the right side of your chart, draw a.
rectangle 1 1/2 inches long and 1/2 inch high. (See the next
screen shot.)
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Add text centered in the box.

1. Choose the text tool in the palette (#2 in the screen shot
below).

2. Choose Center from the Style menu.

3. Position the text-insertion point in the middle of the box.
4. Type Effective 1/86.
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Change the lines to arrows.

1. Select the three vertical lines that lead to the bottom boxes.

2. From the Lines menu, choose the first line that has a
single arrowhead.

3. If the arrows in your drawing are pointing up instead of
down, choose the other single-headed arrow from the
Lines menu while the lines are still selected.
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Practice (cont'd)

Quit MacDraw.

1. Choose Quit from the File menu.
2. When asked if you want to save changes, click Yes.

MacDraw will automatically save your changes under the same
name as you saved the document earlier, and on the same disk.
If you had wanted to keep both versions of your document,
you would have chosen Save As and then entered a new name
for the current version of your drawing. This would have left
the original untouched.

3. Choose Shut Down.

Feedback

Enhance Your
Organization Chart

Be sure you understand the techniques
covered in this section before continuing.

When you have finished, your entire drawing should resemble
the last screen shot, shown on page 23. If it doesn't, and you
don't understand why, reread this section to be sure you
understand all of the techniques taught.

If you don't understand a particular aspect of MacDraw, you
have several options:

« Listen to the third Guided Tour session again.

e Refer to MacDraw, the owner's manual.

»  Ask a colleague, your course manager, or your Apple
support representative.

Continue with this module when you are comfortable with all
of the techniques taught so far.

APPLE SUPPORT TRAINING LIBRARY



Learning How to Use MacDraw 25

Learning How to Use MacDraw (cont'd)
Guided Tour Complete the fourth Guided Tour session, "Big
Drawing!".

Continue with the following practice exercise when you have
finished the fourth session of the MacDraw Guided Tour.

Practice

Start Up MacDraw Use the MacDraw disk to complete the practice
exercise.
1. Click I'm Ready to Stop from the Guided Tour screen.
2. Insert the MacDraw disk.
3. Open the "Org Chart" document.

B Add to the Use the techniques introduced in the Guided
Organization Chart Tour to create a large chart.

This section contains step-by-step instructions to complete your
drawing and screen shots showing approximately what your
screen should look like. Complete each step as it's described.
It's not necessary to match the screen shots exactly.
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Practice (cont'd)

Give yourself more room to work.

1. Choose Reduce to Fit from the Layout menu. Notice
how large your drawing is, where it is on the paper, and
how many pages you have available (one).

Choose Drawing Size from the Layout menu.

Click in the box next to the black one to indicate that you
want the size of your drawing increased to two pages.

wN
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Drawing Size:
16.00 x 10.00

4. Click OK.
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Create a "building block" for making the chart-
larger.

Read this paragraph, and then follow the numbered
step-by-step instructions to actually make the changes to your
document. The next step is to select various parts of your chart
and group them so they will be treated as a single object.

You'll select only the boxes, their shadows, and the lines
connectimg them. Once these objects are grouped, you can
easily copy, paste, and move entire sections of your
organization chart.

1. Use the selection box or the Shift-click technique to select
the boxes, their shadows, and the lines (not the text,
heading, or the "Effective 1/86" box). If you use a
selection box, use the Shift-click technique to deselect all
of the text.
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2. Choose Group from the Arrange menu to group all the
boxes and lines.

3. If your text disappears, Choose Send to Back from the
Arrange menu.

4. Choose Copy.
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Practice (cont'd)

Add to the Organization Chart.

1. Move the pointer to the middle of the second page, and
click the mouse button (notice that a hand briefly appears
pointing to the spot where you just clicked).

2. Choose Paste. The "building block" will be pasted where
you clicked the mouse button.

3. Move it so that the top box is level with the three boxes on
the left page.
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4. Draw the two lines indicated below to connect the new part
of the chart to the existing part.
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Enlarge your chart some more.

Click the mouse button in the lower half of the first page.
Choose Paste to add another branch of your organization
chart below the original part.

Move the new addition to the desired location, centered
below the middle box.

Draw a straight line down from the "VP Distribution” box
to connect the new branch to the rest of the chart.

ol
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See what the chart will look like when it's
printed.

1. Choose Hide Rulers from the Layout menu.

2. Choose Hide Ruler Lines from the Layout menu
(this removes the reference lines from your drawing).

3. Choose Hide Page Breaks from the Layout menu.
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Practice (cont'd)

Get ready to add text to the new part of the
chart.

1. Select the right branch of the chart.
2. Choose Normal Size from the Layout menu. Notice
that the part you selected is now centered on your screen.
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You are now ready to add text to complete your organization
chart. Since you already know how to add text, this exercise
won't guide you through it. If you want the practice, add some
text on your own and center it in the boxes.

You may want to ungroup these objects so you can align text in

a box or so you can enlarge or shrink an individual box to fit
the text. ‘

Quit MacDraw.

1. Choose Quit from the File menu to return to the Guided
Tour menu screen.

2. When asked if you want to save changes, click No.
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Feedback

Add to the
Organization Chart

=N

Take a Break

Be sure you understand the techniques
covered in this section before continuing.

When you have finished, your entire drawing should resemble
the next-to-last screen shot, shown at the top of page 30. And
your screen should resemble the screen shot at the bottom of
page 30. If either isn't true, and you don't understand why,
reread this section to be sure you understand all of the
techniques taught.

If you don't understand a particular aspect of MacDraw, you
have several options:

+ Listen to the fourth Guided Tour session again.

*  Refer to MacDraw, the owner's manual.

« Ask a colleague, your course manager, or your Apple
support representative.

Continue with this module when you are comfortable with all
of the MacDraw techniques taught so far.

You've been doing great! It's time for a break.
Relax for 10 to 15 minutes before continuing.

Learning How to Use MacDraw (cont'd)

Learn All of the
Menu Commands

The function of each menu command is
explained in the manual.

Read the section of the manual that explains the function of
each of the menu commands, not only to learn the information,
but also to become familiar with the manual as a valuable
reference tool. Read the MacDraw Menus section in Chapter 3
of MacDraw, the owner's manual.

Continue with this module when you have finished reading
about the MacDraw menus.
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Il Practice Using MacDraw

Overview

Practice what you learned in the Guided Tours,
and learn a few more features.

This exercise is designed to give you an opportunity to practice
using many of the features you were introduced to in the
Guided Tour. You will also learn how to use additional
features that the Guided Tour didn't cover. You will not,
however, learn everything there is to know about using
MacDraw. The best way to learn everything is to thoroughly
read the manual and then simply use the product.

Draw a distribution diagram.

Let's say you've been asked to prepare a presentation
explaining how your company distributes its products, from
the factory all the way to the customer. A drawing showing the
overall picture is a great way to start the presentation—and
MacDraw is just the tool you need to create it.

In this final practice exercise, you'll draw the diagram shown
on the facing page. The exercise includes step-by-step
instructions and screen shots so you can check your work.
Perform each step as it is described. It's not necessary to
match the screen shots exactly. In this exercise, the screen shot
showing the effect of a particular change to your drawing is
placed before the instructions on how to make that change to
provide an example of what you're about to draw.

As with earlier practices, the drawing tools you will use are
identified in the screen shots by hollow arrows (:>), which
won't appear on your screen.

Remember, if you make a mistake, or you don't like the last
object you drew, use the Undo, Clear, and Revert
commands.

If you forget how to use a particular feature, or you don't
understand what to do, refer to MacDraw, the owner's manual,
or ask a colleague, your course manager, or your Apple
support representative.
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Practice

Draw Your Company's
Distribution System

Start up from the MacDraw disk.

Insert the actual MacDraw application disk (not the Guided
Tour disk) and open the MacDraw icon to start up the
application.

The open document covers most of the screen, but there's
about half an inch of desktop all the way around it. Move the
window to the top left corner of the screen and then expand it
to fill the entire screen.

Draw a factory, like the one shown below.

& File Edit Style Font Layout Arrange Fill Lines Pen
=——— Untitled %]
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1. Choose the polygon tool from the palette and draw the

outline of the factory.

Choose the rectangle and draw the first smokestack.

Hold down the Command key to draw the second

smokestack without having to click in the palette again.

Draw the first window and fill it with black.

Press Command-D to duplicate the window.

Position the duplicate next to the original, as shown above.

Press Command-D two more times to add two more

windows. The third and fourth windows will retain the
spacing you established between the first two.

Nk Wb
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Shrink the factory.

Choose Select All from the Edit menu.

Choose Group from the Arrange menu (or press
Command-G.

Grab the lower right handle and shrink the factory (see the
screen shot below for the approximate size).

Draw the first distribution center, like the one
shown below.
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Draw a rectangle for the outline.

Draw a small square for the first window in the top right
comer of the rectangle.

Press Command-D to duplicate the first window. Move it
next to (and adjoining) the original, and then press
Command-D three more times to line up five windows.
(Remember, each time you press Command-D, a duplicate
is created with the same spacing relative to the previous
object as that established between the first and second
objects.)

Draw a rectangle for the small door and then add a vertical
line to make it look like a double door.

Draw a large rectangle for the first shipping door, and fill it
with a pattern from the Fill menu.

Duplicate it to make the second shipping door.
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Practice (cont’'d)

Add two more distribution centers.
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Use the selection box to select the distribution center.

Group the objects together.

Duplicate the grouped objects and place the duplicated
distribution center next to the original.

Choose Duplicate again to create a third distribution
center.

Add labels to your drawing.
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1. Type FACTORY below the factory and move the text so
it's centered beneath the picture.

2. Type DISTRIBUTION CENTERS, and center it
above the three distribution centers.

3. Type the following below the three distribution centers:
Eastern Region, Central Region, and Pacific
Region.

Center the text below the distribution centers.

Select the first distribution center.

Use Shift-click to select the text beneath it.

Choose Align Objects from the Arrange menu.

Click on L/R Center and then click OK.

Do the same for the other two distribution centers. For the
Central Region, also select "DISTRIBUTION CENTERS"
so that it will be centered above the middle drawing, and
therefore above all three distribution centers.

NPp LN

Choose Save to save what you have done so far.

You should save your work regularly, every 10 to 15 minutes,
to minimize the loss of work should there be an accident, such
as someone tripping over your power cord.

1. Choose Save from the File menu.

2. If you have an external disk drive, insert your blank data
disk. If you don't have an external disk drive, click Eject
to eject the MacDraw disk and then insert the blank data
disk.

3. Enter a name for your document, such as Distr System.

4. Click Save.

5. Ifyou don't have an external disk drive, you need to
reinsert the MacDraw application disk. Press
Command-Shift-1 to eject the data disk. Then insert the
MacDraw application disk.
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Practice (cont'd)

Continue with Add arrows pointing to the distribution centers.
Your Drawing
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Choose the arc tool from the palette and draw three arcs as the
first part of the arrows. Stop the arcs short of the distribution
centers to save room for the arrowheads. You can't
automatically make arcs into arrows, so you'll have to add
short, straight-line arrows to each arc.

Add arrow heads.
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Practice Using MacDraw 39

Choose the perpendicular lines tool and add a short line to
the bottom of the first arc.

Choose the first line that has a single arrowhead from the
Lines menu. If an arrow doesn't appear, the line is too
short. The line must be at least 1/4 inch long for an arrow
to appear.

Duplicate the arrow and add it to the other two arcs.

Draw the large arrow pointing back to the
factory.

The Show Size command helps you draw objects of exact
sizes. When resizing arcs, it measures them in degrees. Use
arcs and the Show Size feature to draw a large arrow pointing
back to the factory. Screen shots are included to show you
what the arrow should look like at interim stages.

1.
2.
3.
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Choose the arc tool.

Choose Show Size from the Layout menu.

Start the arc to the left of the Eastern Regions distribution
center. Draw an arc whose size is 0.62 inches by 0.62
inches in the shape shown in the screen shot below.
While the arc is still selected, choose Reshape Arc from
the Edit menu.

Grab the top handle and move it around the circle until the
size reads 307 degrees.

Start another arc 1/4 inch above the first. Its size should be
0.50 inches by 0.50 inches.

Choose Reshape Arc.

Grab the top handle and move it around the circle until the
size reads 296 degrees.
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Practice (cont'd)

9. While the smaller arc is still selected, choose the white fill
pattern from the Fill menu.

10. Select the larger arc and choose the black fill pattern from
the Fill menu.

11. Choose Hide Size from the Layout menu.
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Add an arrowhead to the two arcs.
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Try drawing an arrowhead as shown. It will be difficult to get
it the right size and at the correct angle. This is because of the
grid. The grid is an invisible gravitational force that limits
mouse movements to the smallest increment of the ruler,
regardless of whether you are creating something or moving an
existing object. For example, if the smallest increment of the
ruler is 1/8 inch (as it is now), you can only move or change
the size of objects in 1/8-inch increments. (There is additional
information about the grid in the Useful Techniques section of
this module.)

1. Choose Turn Grid Off from the Layout menu.
2. Choose the polygon tool and draw a triangie for the
arrowhead (see the previous screen shot or the one below).

3. Choose the black fill pattern.

Add text to the arrows.
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1. Turn the grid back on by choosing Turn Grid On from
the Layout menu.

2. Next to the three arrows, type Product.

3. Next to the large arrow, type Orders.

Get in the habit of saving yovur changes
regularly.

Choose Save from the File menu to save your changes. If

you have an external disk drive, all of your changes will be
saved to the data disk (which should still be in the drive).
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Practice (cont'd)

Continue with
Your Work

If you don't have an external disk drive, when you choose
Save, you'll be asked to insert the data disk. When you've
finished saving your work, press Command-Shift-1 to eject the
data disk, and then insert the MacDraw application disk.

Either way, notice how quick and easy it is to save your
changes. It's strongly recommended that you do this often. A
good habit to get into is to save your work every 10 to 15
minutes as well as whenever you're not working on the
documents, for example, when you leave for lunch or when
you're interrupted by a visitor or a phone call.

Add six retail outlets.
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Scroll down the page.

Draw the outline of the first retail outlet.

Add a door and a picture window. Fill them.

Group the three objects together.

Press Command-D to duplicate the retail outlet.
Position the duplicate next to the original.

Press Command-D four more times to add four more
outlets.

Nownbkwhe
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Add arrows from the distribution centers to the
retail outlets.
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Choose the diagonal lines tool.

Choose the first line that has a single arrowhead from

the Lines menu.

3. Draw all six arrows starting at the distribution centers.
Hold down the Command key to draw the lines without
having to reselect the tool. If the arrows are pointing the
wrong way, choose the other line with a single arrowhead
from the Lines menu.

4. Type RETAIL OUTLETS below the six outlets you just
drew.

5. Position the text so it's centered under the retail outlets.

N =

Draw the large rectangle representing the
customers.
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Practice (cont'd)

oy
.

Scroll down the page until there's enough room to draw
the rectangle shown in the last screen shot.

Choose the round-corner rectangle tool from the palette.
Draw the white rectangle (shown above) below the retail
outlets.

Choose Round Corners from the Edit menu.

Click on 1/8" and click OK.

Duplicate the rectangle.

Grab the top left handle and stretch the rectangle until it's
slightly larger than the original all the way around.
Choose Send To Back from the Arrange menu.
Choose a pattern from the Fill menu.

W Nk wb

Add text to the new rectangle.
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1. Type CUSTOMERS in the rectangle.
2. Change the type style to 24 Point and Shadow.
3. To center the text in the rectangle, first select the text and
the two boxes.
4. Choose Align Objects from the Arrange menu.
5. Click on T/B Centers and L/R Centers and click OK.
Save Your Work Choose Save from the File menu. Insert your

data disk, if necessary.
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Add arrows from the retail outlets to the
customers.
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The last time you drew arrows, you changed the lines to
arrows before drawing the first line. This changes the palette
so all subsequent lines will also be arrows. Therefore, you
don't have to use the Lines menu to indicate that you want
arrows this time. Every straight line you draw will continue to
be an arrow until you change the palette again.

Choose the perpendicular lines tool.

Draw an arrow from the first retail outlet to the customers.
Duplicate the arrow and move it so that it's correctly
positioned under the second retail outlet.

4. Press Command-D four more times.

batt ali o

Notice that the middle two lines go right over "RETAIL
OUTLETS." With MacDraw, objects are drawn on top of
other objects, just as pieces of paper can overlap on your desk.
You can rearrange the objects using Bring to Front and
Send to Back commands in the Arrange menu. Follow the
instructions on the next page to rearrange the text and lines in
your drawing.
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Practice (cont'd)

5. Select the text, "RETAIL OUTLETS."
6. Choose the white fill pattern from the Fill menu.
7. Choose Bring to Front from the Arrange menu.
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Reposition the entire drawing on the page.

1. Choose Reduce to Fit from the Layout menu.

2. Choose Select All from the Edit menu (or press
Command-A).

3. Grab any part of your drawing and move it so it's centered
horizontally on the page and there's room at the top for a
title. If you accidentally grab a handle, your drawing may
change drastically. Just release the mouse button and
choose Undo. Then try again. (See the screen shot below.)
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Add a title.

1.

A

Click at the top of the page. This does two things: (1) it
deselects everything, and (2) it indicates where you want to
work when you return your drawing to normal size.
Choose Normal Size from the Layout menu.

At the top of the drawing, type North American
Distribution System.

Change the type style to 18 point, Bold, Underlined,
and New York font.

Move the title so that it's centered over your drawing.
To see what it will look like when printed, choose Hide
Ruler Lines from the Layout menu.
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Feedback

Draw Your Company's
Distribution System

Be sure you understand the techniques
covered in this section before continuing.

When you have finished, your entire drawing should resemble
the drawing on page 28 and your screen should look like the
screen shot above. If either isn't true, and you don't
understand why, reread this section to be sure you understand
all of the techniques taught.

If you don't understand a particular aspect of MacDraw, refer
to the MacDraw manual, or ask a colleague, your course
manager, or your Apple support representative for assistance.

Continue when you are comfortable with using all of the
MacDraw features that were covered.
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Il Integrating MacDraw with Other Applications

Overview

How to ...

What is possible, and how is it done?

One of the key benefits of the Macintosh is being able to copy
and paste information from one application to another. For
example, you can make a MacWrite™ document more
meaningful by including a drawing from MacDraw or
MacPaint.

This section begins with a reminder of how to move
information from one document to another. Then there is a
description of what integration is possible between MacDraw
and other Macintosh applications.

Use Copy and Paste.
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